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1. EasyBuilder Pro Installation

and Startup Guide

This chapter explains how to install EasyBuilder Pro.

1.1.  Installation REQUIFEMENTS.......cceeiiiiieee e e e e e e e s snrranneeeeeas 1-2
1.2.  Steps to Install EasyBUIlder Pro .......eeeee oottt e e e enrren e e 1-3
1.3.  Software Update REMINAET .....ccooiiiieeceee et e e e e e e e eaar e e e e 1-7
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1-1. Installation Requirements

Software:

Download EasyBuilder Pro from the CD or visit the Omniflex website at
http://www.omniflex.com/easyview.php. and download the installation package which
include the following languages: Simplified Chinese, Traditional Chinese, English,
Japanese, German, Italian, Korean, Spanish, Russian, French, Polish, and Turkish. The
latest updates can be downloaded too.

Operating System:

Windows® 7 SP1 (32bit / 64bit)
Windows® 8 (32bit / 64bit)
Windows® 8.1 (32bit / 64bit)
Windows® 10 (32bit / 64bit)
Windows® 11 (32bit / 64bit)

\» WE!NTEK EasyBuilder Pro V6.09.02
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1.2. Steps to Install EasyBuilder Pro

1. Click [Install] and select the language for the installation process, and then click [Next].

15! Setup - EasyBuilder Pro V6.05.02.200 o @

Welcome to the EasyBuilder Pro

@ V6.05.02.200 Setup Wizard

This will install EBpro V6.05.02.200 on your computer.

Itis recommended that you close all other applications before
continuing.

Click Next to continue, or Cancel to exit Setup.

{ Next > ‘ [ Cancel ]

2. Ifthereis a previous version of EasyBuilder Pro on the PC, please remove it before
installation.

3. Please read and accept the License Agreement before continuing.

15! Setup - EasyBuilder Pro V6.05.02.200

\=d

E=3Ec)

License Agreement
Please read the following important information before continuing. C

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

GENERAL TERMS ("The Terms”)

Version 2.0
March 2019

1. OWNERSHIP AND ABOUT THE TERMS

1.1 cMT Viewer, EasyBuilder Pro, EasyConverter, EasyDownload, EasyDiagnoser,
EasyLauncher, EasyPrinter, and Utility Manager software ("Weintek Software”) is
developed by Weintek Labs., Inc. ("Weintek™), and the authorized user will be
granted for license to operate it exdusively on Weintek's specific products Y

9 I accept the agreement

() I do not accept the agreement [ Third-party Licenses... ]

[ < Back ][ Next > ][ Cancel ]

4. Select a folder for EasyBuilder Pro installation, or use the default folder. Click [Next].
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5.

6.
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Select a

i

15! Setup - EasyBuilder Pro V6.05.02.200 =&

Select Destination Location H
Where should EasyBuilder Pro V6.05.02, 200 be installed? C

J Setup will install EasyBuilder Pro V6.05.02.200 into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

C:\EBpro Browse...

Atleast 1,685.8 MB of free disk space is required.

[ < Back ][ Next > ][ Cancel ]

start menu folder, or use the default folder. Click [Next].

r[fg’.‘ Setup - EasyBuilder Pro V6.05.02.200 =l

==
Select Start Menu Folder ‘
Where should Setup place the program's shortcuts? C

8

[v
L] Setup will create the program's shortcuts in the following Start Menu folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

EasyBuilder Pro Browse...

[ < Back ][ Next > J[ Cancel ]

Select additional tasks, for example: [Create a desktop icon]. Click [Next].

EasyBuilder Pro V6.09.02
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7. Confirm

8. Installat

I__| WE!NTEK

15! Setup - EasyBuilder Pro V6.05.02.200

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing EasyBuilder
Pro V6.05.02.200, then dick Next.

Additional icons:

[V] Create a desktop icon

[ < Back ][ Next > ][ Cancel ]

all setting. To change the setting, click [Back]. To start installation, click [Install].

15 Setup - EasyBuilder Pro V6.05.02.200 = B [

Ready to Install H
Setup is now ready to begin installing EasyBuilder Pro V6.05.02.200 on your C

computer.

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location: -
C:\EBpro

Start Menu folder:
EasyBuilder Pro

Additional tasks:
Additional icons:
Create a desktop icon

< Back ][ Install ] [ Cancel

ion in progress.
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LSS

1

15! Setup - EasyBuilder Pro V6.05.02.200 =

Installing
Please wait while Setup installs EasyBuilder Pro v6.05.02.200 on your computer.

Extracting files...
C:\EBpro\firmware\opcua.c30

| E | 3

Cancel

9. Click [Finish] to complete the installation.

_BJ Setup - EasyBuilder Pro V6.05.02.200 ol @ | &R

Welcome to the EasyBuilder Pro

C‘@ V6.05.02.200 Setup Wizard

Setup has finished installing EasyBuilder Pro v6.05.02,200 on
your computer. The application may be launched by selecting
the installed icons.

Click Finish to exit Setup.

| Finsh |

10. The EasyBuilder shortcut can be found in [Start] » [All Programs] » [EasyBuilder Pro].

The description of each item in EasyBuilder Pro menu:

Installed file Description

Administrator Tools Saves User Accounts, USB Security Key, e-Mail SMTP
Server Setting, e-Mail Contacts to an external device
(USB drive or SD card) so that the data become
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portable and can be imported to HMI.

cMT Viewer

Supports access to cMT / cMT X Series HMI via
network, for operating cMT / cMT X Series HMI on
PC.

Easy Access

Supports access to remote HMI by connecting

EasyAccess server over Internet.

EasyBuilder Pro

EasyBuilder Pro project editor.

EasyConverter

Conversion tool for Data Sampling and Event Log.

EasyDiagnoser

Monitoring and debugging tool operated on HMI.

EasyPrinter

Allows exporting data to a remote server on PC via

Ethernet, realizing remote printing / backup.

EasySimulator

Executes simulation.

EasySystemSetting

Allows updating hardware system settings by using
SD card or USB drive.

EasyWatch

An easy to use debugging and remote monitoring
tool running on PC that allows monitoring or setting

HMI and PLC addresses and executing macro.

Recipe Editor

Tool for setting the format of Recipe data. Users can
open Recipe data or the data in the External

Memory.

Release Note

Software release notes.

UtilityManagerEx

EasyBuilder Pro management tool.

‘@ Note

Certain HMI supports downloading/uploading projects via USB cable. After installing
EasyBuilder Pro, the USB driver will be automatically installed. A message saying
“Windows can’t verify the publisher of this driver” may show, please continue anyway.
After installing the USB driver, open [Computer Management] » [Device Manager] to

check if installation succeeded.

1.3. Software Update Reminder

After launching EasyBuilder Pro, the system will check whether the latest version has been

installed, and show a reminder dialog if there is a newer version.

L—| WE!NTEK
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Software Update >

EI A new version of EasyBuilder Pro is avaliable.

EasyBuilder Pro w6.05.02 200 is now avaliable. Would you like to
download it now?

Remind Me Later™ | |Download Mow

After clicking [Download Now], the latest version of EasyBuilder Pro will be downloaded to a
temporary folder, and a progress bar is shown as below. After download, please follow the
steps explained in the previous section to install EasyBuilder Pro.

b3 casyBuilder Pro Downloading — >

downloading. ..

[ 2%

Cancel

@ Note

B In [File] » [Preferences] » [Misc] an option can be selected to receive a notification when a
new version of EasyBuilder Pro is available.

Users can open File » About in EasyBuilder Pro to see current version and check for updates.

About EasyBuilder Pra x

EasyBuilder Pro V56.05.02. 180 Build 2021.01.18
| bl Copyright ¢ 2006 Weintek Lab. , Inc.

All rights reserved

Licenses 4 sreement. .
Third-paty Licenses... Check for updates... i 0K
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2. Utility Manager

This chapter explains how to use Utility Manager.

2.1, OVEIVIEW cciiieitettte e e e ettt e e e e e sttt e e e e e s e nb bttt eeeeeesaannrbeaeeeeeesasnnbrebeeeeeeeeanannnrreas 2-2
A 1 T I -{ o E TR 2-3
2 T N =Y A g <A 1= o oY - RS 2-4
2.4, PUDBIISN e e e e s e e s e e s araeeas 2-6
D TR |V, = Y1 01 (T o = [ < OSSO PP PP PPPPPPPPPPPRPN 2-11
2.6, Data CONVEISION....ciiiiiiiiieiietttee et ettt e e e e e e ettt et e e e e e s e saabbteeeeeeesesannnrbeeeeeeeesennns 2-13
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2.1. Overview

After installing EasyBuilder
start. Utility Manager is for

Pro, double click [UtilityManagerEx] shortcut on the desktop to

launching several utilities and it is a stand-alone program. Please

select a model first and note that certain features may not work as expected if an incorrect

model is selected.

Utility Manager
> lloT Gateway Series

[ select Model >

Design

Analysis &
Testing

Publish

Maintenance

BEIE]
Conversion

| Run ® l Edit®

@0

TK Series
S
@
E P Series ,, the HMI screen

projects.

=z | IE Series

; /iewer
» eMT Series svices (or related
S sponding operable PLC
nats.
:}'il XE Series
cMT Series )y On-line Simulation
- mulation (without PLC).
oMT X Series - Standard

= B cMT X Series - Advanced

2-2

Utilities

Description

Minimize Utility Manager window.

Close Utility Manager.

o

Add the frequently used utilities to the toolbar at the bottom of the
window.

Run

Run the selected utility on the toolbar.

Edit

Delete the selected utility on the toolbar.

[\& WE!NTEK
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2.2. Design

Run ® Edit®

Design

Analysis &

Testing

Publish

Maintenance

Data
Conversion

EasyBuilder Pro @

Launch EasyBuilder Pro, the HMI screen
composer/editor, to edit projects.

1

EasyAddressViewer @

Show supported PLC devices (or related
devices), and their corresponding operable
PLC address ranges and formats.

Simulation

Simulate a HMI on PC by On-line Simulation
(with PLC) or Off-line Simulation (without PLC).

2-3

Utilities

Description

EasyBuilder Pro

Launch EasyBuilder Pro to edit projects.

EasyAddressViewer

Review the address ranges and formats of supported PLCs.

Simulation

Simulate an HMI on PC by running On-line Simulation or Off-line
Simulation. Please select an .exob / .cxob file as source first.
Off-line simulation: Simulate project operation on PC without
connecting any devices.

On-line simulation: Simulate project operation on PC and PLCs are

directly connected with PC.

0 Note

B When using [On-line simulation] on PC, if the target device is a
local PLC (the PLC directly connected to PC), there is a

one-hour simulation limit.

[\& WEINTEK
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2.3. Analysis & Testing

Utility Manager
> lloT Gateway Series

[ select Model >

Analysis &
Testing

Publish

Maintenance

Data
Conversion

©0
|

cMT Diagnoser

On-line monitoring and debugging tool. Diagnose
the connection status between PC/HMI and PLC.

EasyWatch

A debug/monitor tool that monitors HMI/PLC
addresses, or execute macro on HML.

o

Reboot

Restart a HMI to its initial condition by Ethernet or
USB connection.

o

2-4

Utilities

Description

cMT Diagnoser

A diagnostic tool that can monitor data and status of all objects in
the current window when it is connected to a cMT Series HMI,
show the status of individual communication packet, show
communication status with MQTT server, and debug macros.

E25_T‘See “31 cMT Diagnoser”.

EasyDiagnoser

Diagnoses the connection status between eMT/iE/XE/mTV HMI and
PLC.

@See “33 EasyDiagnoser”.

EasyWatch

Allows users to monitor or configure HMI or PLC address values via
Ethernet on PC.

C?See “35 EasyWatch”.

Reboot HMI

Reboots the HMI without unplugging. After reboot, the system
returns to the initial state.

Serial Pass-Through

Opens a local serial port (virtual/physical) and allow other PC

[\& WEINTEK
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applications to connect to PLC via HMI.

The Serial Pass-Through feature provides two modes: Ethernet and
COM port.

Before using [Ethernet] mode, please check if virtual serial port

driver has been installed.

@See “29 Pass-through”.

Ethernet
Pass-Through

When PC and PLC are respectively connected to different Ethernet
ports of a Dual-port HMI, this feature allows running the
application on PC to control PLC through HMI. This feature is only
supported on ctMT / cMT X Series models.

Cf’See “29 Pass-through”.

Pass-through feature allows the PC application to connect PLC via HMI. In this case, the HMI

works like a converter.

[\& WEINTEK
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2.4. Publish

Utility Manager
> lloT Gateway Series

[ select Model >

Design

Analysis &
Testing

Publish

Maintenance

BEIE]
Conversion

o | e (I

@0

Download
Download given files from PC to HMI, such as |

firmwares, project, recipes, data log, or startup
screen.

Upload
Upload data from HMI to PC, such as project,

recipes, event logs, operation logs, data logs, or
extended memory (EM).

2-6

7|
Utilities Description

Download Downloads project file to HMI via Ethernet or USB cable.

Upload Uploads files on HMI to PC via Ethernet or USB cable.

Build Download Builds the data to be downloaded to HMI in an SD card / USB drive.
Data for SD/USB For cMT / cMT X Series, the data needs to be built in EasyBuilder
Disk Pro.

[\& WE!NTEK
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2.4.1. Download (PC->HMI)

Download files to HMI via Ethernet or USB cable.

eMT, iE, XE, mTV Series

cMT, cMT X Series

2-7

ey Download (PC->HMI)
[7]Runtime (frmware) [@ImQrT [] Diagnostic tool [7]usB audio driver Connection
(@) Ethernet
V] Project PLEASE INPUT EXOB FILE NAME ! Browse...
A 4] /1P | HMIName b
vIRW PLEASE INPUT RECIPE FILE NAME ! Browse...
VIRW_A PLEASE INPUT RECIPE_A FILE NAME ! P M
[7|Recipe database PLEASE INPUT RECIPE DATABASE FILE NAME !
[ ] Project
[¥] Startup screen PLEASE INPUT LOGO FILE NAME !
[] System settings PLEASE INPUT A SYSTEM SETTINGS NAME |
RW PLEASE INPUT RECIPE FILE NAME !
RW_A PLEASE INPUT RECIPE_A FILE NAME !

Recipe database PLEASE INPUT RECIPE DATABASE FILE NAME !

Startup screen PLEASE INPUT START-UP SCREEN FILE NAME !

[] Use system settings file

Connection

@ Ethernet USE cable

Kl P

HMI Name

[ | pelete existing user accounts
[ Delete existing e-Mail contacts and SMTP settings
["] Reset operation log

Reset recipe (RW, RW_A) Reset recipe database

HMI v 192.168.2.142 (HMI-0396)
192.168.2.223 (HMI-EDFA)

Search

Search All

192.168.2.231 (MT8090XE-FAE)

[ Reset data log [] Reset string table

|| Reset OPC UA history (HDA)

[ Reset event log
Reset startup screen

|| Reset PRW on HMI and all cMT Viewers

CODESYS

|| Delete existing user accounts, e-Mail contacts and SMTP settings

Port No. Setting...

Password : 111111 [T Mask

["IReboot HMI after download [~ synchronize HMI dock with PC [ Delete startup screen
[]Reset recipe (RW, RW_A) V| Reset data log [V|Reset event log
["JReset recipe database V] Reset operation log [V]Reset string table

[ Project

[] synchronize HMI clock with PC

Password : 111111

[ Mask

Port No. Setting...

Setting

Description

Project

Select an .exob or .cxob project file. For a cMT /
cMT X project, the Project Checksum will be
shown under the directory of the project for
users to check whether the project file has been

tempered with.

Runtime (firmware)

Update HMI kernel programs. The firmware
must be downloaded at the first time

downloading data to HMI.

MQTT

If MQTT is used in the project and HMl is the
broker, this checkbox must be selected before

download.

Diagnostic tool

Enable the diagnostic tool to send diagnostic
data to the developers when an error occurs for

quick troubleshooting.

USB Audio Driver

Enable audio output on HMI so it can
immediately emit a sound when a USB sound

card and a speaker are connected.

I__| WE!NTEK
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RW / RW_A

Select an .rcp recipe file.

Recipe database

Select a .db file of Recipe Database.

Startup screen

Download a .bmp file to the HMI, which will be
displayed after the HMlI is started, and then the
downloaded project is loaded. Please note that
when downloading a project to a cMT / cMT X
model, it is not possible to select both Project
and Startup Screen in the download window.

Use system settings file

Select a .conf system settings file.

Reboot HMI after
download

Automatically reboot after download.

Port No. Setting

Select the port by which to download the

project file via Ethernet.

Synchronize HMI clock
with PC

Synchronize HMI time with PC time when

downloading project file.

Reset recipe / recipe
database / event log /
data log / operation log
/ string table / OPC UA
history (HDA) / startup
screen / Delete existing
user accounts, e-Mail
contacts and SMTP
settings

Erase the selected files on HMI before

download.

CODESYS

Use Utility Manager to download CODESYS boot

project.

L—| WE!NTEK
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2.4.2. Upload (HMI->PC)

Upload files from HMI to PC via Ethernet or USB cable. Click [Browse] and assign the file path

before uploading.
eMT, iE, XE, mTV Series

cMT, cMT X Series

Upload (HMI->PC)

Port No. Setting.... Password : 111111 ] Mask Upload (HMI->PC) E]

\E’ Upload (HMI->PC) x
Connection

Project PLEASE INPUT EXOB FILE NAME !

@ Ethernet (OusE cable
RW PLEASE INPUT RECIPE FILE NAME |
RW_A PLEASE INPUT RECIPE_A FILE NAME | K| P HMI Name
Recpe detabase PLEASE INPUT RECIPE DATABASE FILE NAME | HMI - [cMT3090-FAE M) 2. 162.2.220 (cMT2000.FAE) -
Operation log PLEASE INPUT OPERATICN LOG FILE NAME |

Search
Data log PLEASE INPUT DATA LOG FOLDER NAME |
Eventlog PLEASE INPUT EVENT LOG FOLDER NAME ! Search All
Use CSV (Comma Seprated Values) format to save data/event log fies Search and Change [P
Extend Memory (EM)  PLEASE INPLT EM FOLDER NAME |
EM file location : () 5D card @) USB disk [Project
[ C:\sers\user \Desktop\MT3090. cxob =
History

Redpe Recipe database

Connect _ [#]Eventlog Data log [] Operation log
@ Ethernet () USB cable
C: kol
A P HMIName B ‘ \Usersiuser|Desktop 1 ‘
HMI -
Search All

Port No. Setting... Password : [ 111111 [IMask Upload Exit

Setting

Description

Event log

Upload the .evt file on HMI to PC.

Extended Memory
(EM)

Upload the .emi file saved in SD card or USB disk
to PC.

or For information about [Project], [RW / RW_A], [Recipe database] or [Data log], see “2.4.1

Download” in this chapter.

0 Note

B The file will be uploaded to PC in .exob / .cxob format. Please decompile it into

editable .emtp / .cmtp file first and open the .emtp / .cmtp file in EasyBuilder Pro.

B To upload the historical files saved in the external device, please use FTP. See “32 FTP

Server Application” for more information.
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2.4.3.

A W INR

Build Download Data for SD/USB Disk

Build Download Data for SD/USE Disk (==
Select the folder to save download data :
PLEASE INPUT DIRECTORY NAME !
Sources
Project
PLEASE INPUT EXOB FILE NAME !
Recpe (RW)
PLEASE INPUT RECIPE FILE NAME |
Redpe & (RW_A)
PLEASE INPUT RECIPE_A FILE NAME !
Data log
PLEASE INPUT DATA LOG FILE NAME !
User-defined startup screen
PLEASE INPUT START-UP SCREEN FILE NAME ! Browse...
S R—

Insert an external device (SD card or USB drive) to PC.
Designate the directory to save data.
Browse for the directory of the source files.

Click [Build] to create download file.

Files will then be saved to the inserted device for users to download to HMI without having to
use a USB cable or Ethernet.

2.4.4,

Steps to Download Project to HMI via USB Disk or SD Card

To download data in a folder (e.g. a folder named “123” (K:\123)) in a USB disk.

1.
2
3.
4
5.

6.
7.

Insert USB (in which the project is saved) to HMI.

In [Download / Upload] dialog box select [Download].

Enter Download Password.

In [Download Settings] dialog box, select [Download project files] and [Download history
files].

Press [OK].

In [Pick a Directory] dialog box, select directory: usbdisk\disk_a_1\123.

Press [OK].

Project will then be updated.

0 Note

If history data is downloaded but not the project file, please reboot HMI to update files.

I__| WE!NTEK EasyBuilder Pro V6.09.02
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2.5. Maintenance

Options in this tab may vary according to model.

Utility Manager
> cMT Series

@0

) select Model >

Design

Analysis &

Testing Cn-,T
N

[ &

Publish

Maintenance

Vieyver

Administrator Tools

Build user account and mail setting files in a USB
drive/SD card without modifying project file, and
then transfer them to HMI by USB/SD.

cMT Viewer
Connect to a cMT-SVR machine. PC acts as a
display terminal for cMT-SVR.

cMT-iV5/iV6 Firmware

|

BEIE]

Conversion

Update
Update firmware on cMT-iV5/iV6

2-11

Utilities

Description

Administrator Tools

Allows saving the data of [User Accounts], [USB Security Key],
[e-Mail SMTP Server Settings], and [e-Mail Contacts] to USB.

C?See “36 Administrator Tools”.

cMT Viewer

cMT Viewer can connect to a cMT / cMT X Series model. PC is the

display terminal for cMT / cMT X project.

cMT-iV5/cMT-iV6
Firmware Update

Updates cMT-iV5/iV6 runtime (firmware) or OS.

cMT-Server OS
Update

Updates cMT-SVR/SVR-200 OS.

cMT-Gateway/CTRL
OS Update

Updates cMT-Gateway/CTRL OS.

CODESYS Firmware
Upgrade

Updates CODESYS firmware on cMT / cMT X HMI.

SSL/TLS Certificate
Upgrade

Upgrades the built-in expired SSL/TLS certificate on HMI.
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FTP Server
Certificate Update

Update the certificate and private key for the FTP server on the
HMI.

HMI Information
Collector

Obtains a file with diagnostic information from HMI.

EasyPrinter /
Backup Server

Runs remote backup/printer server on PC.

Data/Event log

Information

Connects with HMI via USB cable or Ethernet to check the number
of history files on HMI. This feature is not supported on cMT / cMT
X Series.

Data/Event Log File Infermation @

[=- sample_HMI

- 1.20130826.d
- 2,20130825.dt
- 3.20130824.d
- 4,20130822,dY
. 5,20130821.dt

[#- GreenHouse

E| event log

-1, EL_20130830.evt
-2, EL_20130826.evt
-3, EL_20130809.evt

EasyAccess 1.0

Supports access to remote HMI by connecting EasyAccess server

over Internet. You can find more information at: www.ihmi.net

@ Note

B HMI Information Collector is available only on cMT / cMT X Series models, and the

applicable OS version is 20210705 or later.
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2.6. Data Conversion

Utility Manager
> iE Series

[ select Model >

Design

Analysis &
Testing

Publish

Maintenance

BEIE]
Conversion

@0

Recipe Database Editor @

Modify recipe database (without modifying the
project directly).

EasyConverter @

Convert HMI-generated data logs (.dtl), event
logs (.evt) into Excel-compatible .csv files.

Recipe Editor @

Create/modify recipes (RW, RW_A) or extended
memory (EM).

2-13

Utilities

Description

Recipe Database
Editor

Edits recipe data.
A

Click the icon to download the document about Recipe

Database.

Easy Converter

Reads HMI-generated data logs, event logs, and operation logs and

converts the files to Excel (.xlsx) format.

C?See “25 EasyConverter”.

Recipe Editor

Creates new recipe data to be used on HMI and modifies the
existing recipe data.

L/—?See “24 Recipe Editor”.
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Create an EasyBuilder Pro Project

3. Create an EasyBuilder Pro

Project

This chapter explains the basic steps to create an EasyBuilder Pro project.

3.1 OVBIVIEW ceieeeteteeee ettt et e e e ettt e e e e e s e b bbbttt e e e e e s e anbbe e e e e e e e s e nbbbteeeeeeeeaaannrreas 3-2
3.2, Create @ NeW ProjeCt FIle ...t e e e e e 3-2
3.3. Save and Compile the Project File ...t 3-4
3.4. Compile and QUICK COMPIIE c.eeveii e e e 3-5
3.5.  Run On-Line or Off-Line SimuUIation........cccoviiiiniiiiiieeceececsee e 3-6
3.6, CIMIT VIBWT ettt ettt ettt e e et e e ettt et e e e e e s e asb bttt e e e eesea s bbeeeeaeeeeesnannnreeas 3-6
3.7. Download the Project File to HMI .......ouviieiiiiieeee et 3-7
3.8. Upload the Project File from HMI...........oooiiiiiiieeeee e 3-14
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3.1. Overview

The following is the process of creating a project.

1.
2.
3.
4.

Create a new project file.
Save and compile the project file.
Run On-line or Off-line simulation.

Download the project file to HMI.

The following describes each process.

E| Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

3.2. Create a New Project File

1.
2.

3.

Launch EasyBuilder Pro and open a new project file.
Select a model and select [Use template] check box.

‘ O New  New Project

‘ i 7?“" | Model: | 4 @B iPSeries
MT6051iP (480 x 272)
MT8051iP (480 x 272)
MT6071iP/MT8071iP (800 x 480)
MT6103iP (1024 x 600)
MT8102iP (1024 x 600)
MT6102iQ (1024 x 600)

4 @ eMT Series
€MT3070 (800 x 480)

£eMT3105 (800 x 600)

eMT3120/eMT3150 (1024 x 768)
4 @ iE Series
MTB8050iE (480 x 272)
MT6070iE (800 x 480)
MT6071iE (800 x 480)
MT8070iE/MT8100iE (800 x 480)
MT8071iE/MT8101iE (800 x 480)
MT8073iE (800 x 480)

mn

[¥] Use template (template_800x600.emtp)

eMT3105

Orientation :

[ Portrait

[Uncompress Pche:t] I.L, Demo Prc}e(tJ

Click [New] button in the Device tab and select a device.
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.
System Parameter Settings 3
| PrinterBackupServer |  TimeSyne/DST | eMeil | Recipes |  Cellular Data Network
Device | Model | Gemeral | SystemSetting | Security | Non-ASCIIFonts | Extended Memory
Device list : What's my IP ?
Name Location  Device type Interface IIF Protocol

(3 Local HMI Local HMI lLocal  [em73105(800..[- |- |

< | m »

[ New... J [ Delete ] [ Security... ]

4. Configure parameters.

Device Properties

MName :  Mitsubishi FX0S/FXON/FX1S/FX1N/FX2

) HMI @ PLC
PLC type : | Mitsubishi FEOS/FEON/FE 1S/FE LN/FH2 |

IV.1.4U, MITSUBISHI_FXOM.e30

PLCIF : [R5485 4W -

* Support communications between HMI and PLC in pass-through mode
* Set LW-9903 to 2 to enhance the speed of download/upload PLC program in pass-through mode

COM : [COM1 (9600,E,7,1) Settings...

PLC default station no. : g

[] Default station no. use station no. variable

[7] Use broadcast command

Interval of block pack (words) :

Max. read-command size (words) @ |32

Max. write-command size (words) : |22

[ OK ] l Cancel
5. A new device is added to the [Device List].
“:System Parameter Settings ==
| Printe/Backup Server I Time Sync /DST I e-Mail I Recipes I Cellular Data Network
Device | Model | Genersl | SystemSetting | Security | Non-ASCIIFonts | Extended Memory

Device list : What's my IP ?

No. Name Location Device type Interface I/F Protocol
] Local HMI Local eMT3105 (800 -

s I o = T e

6. Create an object, for example, a Toggle Switch, and then set the address.
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 New Toggle Switch/Bit Lamp Object

General | Security | Shape | Label |

Comment :

~) Bit Lamp @ Toggle Switch

[V] ReadMWrite use different addresses

Read address
PLC: [Mimbi.shi FEOS/FEONFEISFELINFELZ v] Settings...
Address : [X v] 0 fi
[ Invert signal
Write address :
PLC: [Miwubishi FEOSFEONFEISFEINFLZ v] Settings...
Address [y ,J 0 [
[} Write when button is released
Attribute

7.  Place the object in the edit window. A project is now created.

EasyBuilder Pro : EBProjectl - [10 - WINDOW,_010]
File HE« »
"@’ B LR =R RORE - B=N—1-1

— — o0 =] v
System i 28=E S =
Parameters S OG|F
Editing Object

GEIGEM Project  Object  Data/History View  Tool

Paste

Clipboard Arrange

=

- 8 X &

AdobeDevanagari: ~ |5

Ao Z A= T

A L1 L2 13 L4(1

S1|S2 s3 s4|1

Font State/Language

Windows v X ( 10 - WINDOW_ 010 x

>

Object list -

I|I|I|I|I|I|x|I|I1MI|I|I|x|I|I|Ill|IlloﬁllllI|I|I|I|I|l|I;lxliIllllllll|l|l|l|ml|l|l

- T T

3 : Fast Selection
4 : Common Window @
5:PLC Response
6 : HMI Connection
- 7 : Password Restriction
- 8:Storage Space Insufficient
i 9:Backup
#10: WINDOW_010

P )

24 =
R ] P——— Y

m

-
o

[ poo poo |ioo |

bbb bbbt bbb b Db b b b b b b b D b b b b B b b bbb bbb

[Address | windows [Web [

3.3. Save and Compile the Project File

1. In EasyBuilder Pro toolbar click [File] » [Save] to save the .emtp file.

2. In EasyBuilder Pro toolbar click [Project] » [Compile] to compile .emtp file as .exob file,

which could be downloaded to HMI. This also checks if the project can run correctly.
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0 Note

B  For cMT / cMT X Series models, the project file e
extension is .cxob.

3. To use multiple languages, all languages must be

xtension is .cmtp, and the compiled file

configured in Label Tag Library first.

When downloading the project to HMI, select the needed languages only. A successful

compilation is shown in the following figure.

Compile
Projectname : C:Y\Jsers\Janecheng'Desktop\EBProjectl.cmtp

CXOB file name @ C:\Users\Janecheng\Desktop\EBProject1. cxob

CXOB password : Settings. .. (uzed in decompiler)

[ Decompilation is prahibitad [ Disable HMI upload function

Select the languages used on the HMI
Startup language after red

Language 1

Treat the use of unsupported tags as @ | Error -

X5

ownloading the project : Language 1 -

Double-didk a message to modify the attributes of the object in question

Font Management...

| [C]Build font files

Close

3.4. Compile and Quick Compile

The [Compile] and [Quick Compile] modes can be selected in the Compile window. To compile

a relatively large file in which only a few windows are
be used to save compilation time.

Compile:

Compile the whole project file.

Quick Compile:

modified, the Quick Compile mode can

Only compile the modified window or event log. When one of the records in the event log is

changed, the whole event log will be compiled.
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0 Note

B [f the project file is compiled for the first time, the Quick Compile mode is not supported.

B I|n a project file, when its system settings, picture library, sound library, or label library is
modified, then Quick Compile mode is not supported for the first compilation after
modification.

B The whole project file must be compiled before it is downloaded to HMI.

B Utility Manager does not support the project file compiled using Quick Compile mode. To

download a project file using Utility Manager, please compile the whole project file first.

3.5. Run On-Line or Off-Line Simulation
F!I!l!
pXx

— Off-line simulation: Simulate project operation on PC without the need for connecting
any device.

Fm

h— On-line simulation: Simulate project operation on PC without downloading the project
to HMI. The PLC is connected to PC, please set correct parameters.

0 Note

M (iE/XE/eMT Series) When using On-line Simulation on PC, if the target device is the PLC
directly connected to PC, there is a 10-minute simulation limit.
B (cMT/cMT X Series) When using On-line Simulation on PC, the monitoring time is limited

to one hour and a prompt window pops up every 15 minutes.

3.6. cMT Viewer

This program connects to cMT Series models via network. To run this program, execute
cMTViewer.exe under installation directory. Or, in EasyBuilder Pro toolbar, click [Tools] » [cMT
Viewer].

E| Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

I__| WE!NTEK EasyBuilder Pro V6.09.02
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%, <MT Viewer =B8] %

2017-02-09 19:21:24

3.7. Download the Project File to HMI

The following explains four ways to download the project file to HMI.

0 Note

B For cMT-SVR, only the way described in 3.6.1 is available.
B When download project file to HMI using mini USB cable, please do not connect PLC
simultaneously, in order to avoid noise from PLC interfering with HMI.

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
3.7.1. Configure in EasyBuilder Pro

1. In EasyBuilder Pro toolbar, click [Project] » [Download]. Make sure that all the settings are
correct.
2. Select [Ethernet], set password and HMI IP.
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eMT, iE, XE, mTV Series

Download (PC->HMI)

=

Fassword/Port no. of download/upload :

@) Ethernet

4 TP HMI Name 4
IP: 10.7.130.86 -
[V]Font files [/] use EasyAccess 2.0 What's my [P7

[/] Diagnostic tool

[V]Runtime  * Necessary if update runtime or execute download first time.

[ ]use user-defined startup screen

[ ] Use system settings file

Synchronize HMI clock with PC

[T] Delete user-defined startup screen

[C] Reset recipe (RW, RW_A) [C] Reseteventlog

[T] Reset recipe database [[] Reset operation log

[] Reset data sampling
[C] Reset string table

[]Reboot HMI after download

["] Automatically using current settings to download after compiling

cMT, cMT X Series

Download (PC->HMI)

@) Ethernet

4 7 IP HMI Name

IP: 1071

Froject Checksum : 9ee5836c3331ab235(69a5a011d7e5h7

[ Runtime = Necessary if update runtime or execute download first time.

[ Use system settings file

Synchronize HMI clock with PC
[C] Reset recipe (RW, RW_A)
[] Reset recipe database

[I"] Automatically using current settings to download after compiling

39.86 -

[] Reset event log
[C] Reset operation log
[C] Reset PRW on HMI

Password/Fort no. of download/upload :

'3

What's my [P7

Reset data samplin:
pling
Reset string table
9
and all cMT Viewers

Stop [T] Dowinload Stop
Setting Description

Font files

Download the font used in the project to HMI.

Runtime

Select the check box to update the HMI kernel

programs. If this is the first time downloading file or

EasyBuilder Pro version is updated, please download

the firmware before downloading files to HMI.

EasyAccess 2.0

Download EasyAccess 2.0 driver to HMI. (This option

is available only for MT8000iE models. For other

models, EasyAccess 2.0 will be automatically

downloaded.)

Use user-defined
startup screen

Download the specified .bmp image file to the HMI

as the startup screen. For cMT/cMT X HMI, please

see chapter 5.4 General Settings in this user manual

for more information on updating the startup screen
on the HMI.

Use system settings
file

hardware settings.

Download the system settings file to update

Synchronize HMI
clock with PC

downloading project file.

Synchronize HMI time with PC time when

Delete existing user
accounts, e-Mail
contacts and SMTP
settings

Select the check box to delete existing user
accounts, e-Mail contacts or SMTP settings before

downloading the project. This setting is only

effective when one of the following settings is
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enabled:

1. [System Parameters] » [Security] » [Enhanced
security mode] » [Use existing user accounts on
HMI first (if existed), Othrewise, use settings
below].

2. [System Parameter s] » [e-Mail] » [Use existing
user accounts on HMI first (if existed),

Othrewise, use settings below].

Reset recipe/

event log/

data sampling/ ' _

recipe database/ The selected files will be erased before
operation log/ downloading.

string table/
user-defined
startup screen

Reboot HMI after HMI will reboot after the downloading process is
download

done.

Automatically
using current
settings to to the latest target HMI. The way to enable this
download after
compiling

The system will compile the project and download it

function is described in the following part.

[Automatically using current settings to download after compiling]

If this check box is selected, EasyBuilder Pro will compile the project and download it to the
latest target HMI.

1. In EasyBuilder Pro toolbar, click [File] » [Preferences].

2. Select [Automatic save and compile when download and simulate] check box.
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Preference
Project
Dopiy [¥] Automatically save and compile the project when download and simulate
Grid [7] Generate backup of project file before save
Library [] Automatically make used pictures and shapes into the project library

[] save AutoRecover information

[ OK J [ Cancel

3. In EasyBuilder Pro toolbar, click [Save] and then [Download)].

4. In the dialog box, select [Automatically using current settings to download after compiling]
check box.

5. Click [Download].

6. When finished, next time when [Download] is clicked, EasyBuilder Pro will automatically

compile and download the project to the latest target HMI.
3.7.2, Use HMI Name

1. Go to [System settings] on HMI and then set HMI name first.

.Systern settings

Netwcrk‘ Time,fDate" Securit  HMI mame¥eﬁing\gg\

HMI namel

i Cancel | | Apply |iok <!
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2. OnPC, select the HMI name and start downloading. To use [Search], enter the HMI name

first to search for the HMI. [Search all] searches for all HMIs in the same subnet network.

[V|Runtime *Necessary if update runtime or execute download first time.

[ Use user-defined startup screen

[ Use system settings file

[¥] synchronize HMI clock with PC

[ Delete user-defined startup screen
[7|Reset recipe
[7] Reset recipe database

[V|Reset event log
[V Reset operation log

[¥]Reboot HMI after download
[] Automatically using current settings to download after compiling

Download (==
@ Ethernet Password/Port no. of download/upload :
4 /. IP/ HMIName 3
T v /
HMI: ie7 v
Search All
[Z]Font files [V] Use EasyAccess 2.0 What's sy IP?

[¥] Reset data sampling
[V]Reset string table
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3.7.3. Use USB cable

Download (==

@) USB cable Password : | Settings...

|7 Font files
[V|Runtime *Necessary if update runtime or execute download first time.

[ Use user-defined startup screen

[ Use system settings file

[ Delete user-defined startup screen
[7]Reset recipe [V|Reset event log (V] Reset data sampling
[] Reset recipe database [7|Reset operation log [V|Reset string table

[#]Reboot HMI after download

[~ Automatically using current settings to download after compiling

| Download Stop Exit

Select USB cable to download project to HMI. The way of setting is same as “3.6.1 Configure in

EasyBuilder Pro”. Before downloading via USB cable, please make sure the USB driver is

installed. Go to [Computer Management] » [Device Manager] to check if USB driver is installed.

If it is not installed, please refer to to install manually.

3.7.4. Use USB Drive or SD Card

The following explains how to download project file by using USB drive or SD card.
1.  On EasyBuilder Pro toolbar click [Project] » [Build for SD card / USB disk download].

Browse for the project file and then click [Build], the file for download will be generated in
the connected external device.

I__| WE!NTEK EasyBuilder Pro V6.09.02
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USB Disk/CF Card/SD Card Data ==

Select the folder to save download data :

)

Use system setting (OS5 version 20131106 or later supports only)
System setting file location =

’ Build ] l System Settings...
2. Insert an external device to HMI.
3. Select [Download] on HMI and enter password.
Download/Upload
— Pownioad settngs [
Upload Password: ||
Restart project and exit ‘
¥ Download project files
Load System Setting |7 Download history files
Cancel l_ Clear history files
Stop after download/upload . Cancel
Time remaining 4

4.  After password is confirmed, it will show the directories in the external device. (pccard: SD
Card; usbdisk: USB Drive)

pick abirectory P4
Directory: Jusbdisle/disk_a_1

=¥ pecard
usbdisk

oK /‘r Cancel

5. Select the directory that contains project, and then click [OK] to start downloading.
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@ Note

B Please select the parent directory of the generated files when downloading. For the
structure above, please select disk_a_1, not mt8000ie.

B You may click [System Settings] to save the hardware settings configured in EasyBuilder
Pro into SD card or USB disk, and then download the settings file to HMI. See “4 Hardware
Settings” for more information.

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
3.8. Upload the Project File from HMI

1. On EasyBuilder Pro toolbar click [File] » [Upload].
2. Set HMI IP, HMI model, project location and project name, and then click [Upload].
Upload @

@ Ethernet 71 USB cable Password/Port no. of download/upload :

4 P Name 2
IP: 192.168.1.100 -
What's oy [P 2
HMI model : | eMT3070 >
Project location : C:\EMTP1.exob

Upload

v
H
[
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Hardware Settings

4. Hardware Settings

This chapter explains HMI settings.

4.1, OVEIVIEW .eiiieieiiiiiiiieiteeee ettt e e e e e s ee e e e e e e s enreeeeeas
By B 1 L @ 1 >o Y o £ RO
4.3, LED INAICALOrS ..evveeiiiiieeeeiieee ettt
4.4, System ReSel.....uuuciieiiiiiiiiiiiiiieee et e e
4.5. System Toolbar.....ccoveeeeiiiecccec e
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4.1. Overview

4-2

This chapter discusses the HMI settings.

4.2.1/0 Ports

The I/0 ports may vary between models; please see the datasheet for more information.

The 1/0 Ports include:

® SD card slot: Allows downloading / uploading project file, including recipe data, event log,

data log...etc. and also allows recording history data and data backup.

® COM Port: Connects PLC or other peripheral devices. The type of serial port include:
RS-232, RS-485 2W, RS-485 4W, and CAN Bus.

® Ethernet: Allows downloading / uploading project file, including recipe data, event log,

data log...etc. Connects to Ethernet devices, such as PLC, laptop.

® USB Host: Supports USB devices, such as mouse, keyboard, USB disk, printer, or barcode

device.

® USB Client: Allows downloading / uploading project file, including recipe data, event log,

data log...etc. and also allows recording history data and data backup.

For the first time operating HMI, please complete the following system settings. When finished,

the project files designed using EasyBuilder Pro can be used on HMI.

4.3. LED Indicators

The LED indicators on the HMI indicate:
Models: MT8121XE, MT8150XE, MT8121iE, MT8150iE

LED

Description

PWR (Orange)

Indicates power status.

CPU (Green)

Blinks when read/write Flash Memory.

COM (Blue)

Indicates COM port communication status, blinks
during communication. When communication is
good, it may stay on. (Not including network

communication)

Other Models:

LED

Description

PWR (Orange)

Indicates power status.

CPU (Green)

Indicates CPU status. If it blinks or goes out, there
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may be a CPU error.
COM (Blue/Red) Indicates communication status, blinks during
communication. When communication is good, it

may stay on.
4.4. System Reset

Certain HMI models are equipped with a reset button and a set of DIP switches. When using
the DIP switches to change modes, the corresponding functions will be triggered. If system
password is lost or forgotten, see the following steps to restore factory default.

1. Flip DIP Switch 1 to ON and the rest to OFF, and then reboot HMI. HMI will switch to touch
screen calibration mode.

2. A “+” sign appears on the screen, touch the center of the sign, after all 5 signs are touched,

+” disappears and the touch screen parameters will be stored in HMI system.

3. After calibration, confirm to restore the default password, select [Yes].

4. Confirm to restore the default password again by typing [yes] and clicking [OK]. The
project files and history records stored in HMI will all be removed. (The default Local
Password is 111111. However, other passwords, such as Download/Upload passwords
have to be reset.)

The following lists the DIP switch settings of different models. Please see the relevant

installation instruction.

cMT / cMT X / eMT / i

Dip Switch OFF Touch Screen Calibration Mode
AN OFF ON OFF OFF Hide HMI System Setting Bar
HHHH OFF OFF ON OFF  UpdateOS
: OFF OFF OFF ON Reserved

OFF OFF OFF OFF Normal

@ Note

B The state of DIP Switch 4 on each unit may be different. If it should be ON when out from
factory, the Dip Switch 4 would be set ON and cut off. If it should be OFF, the Dip Switch 4
would be set OFF but the switch is not cut.

ON ON Restore factory default
ON  OFF Hide system setting bar
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mTV OFF ON Update OS
Dip Switch OFF OFF Normal mode

i}

cMT-SVR

Dip Switch ON ON Restore factory default
H B ON  OFF Restore Ethernet IP Settings
T 5 OFF ON Update OS
OnN

OFF OFF Normal mode

4.5. System Toolbar

After rebooting HMI, you can set the system with [System Toolbar] at the bottom of the screen.
Normally, this bar is hidden automatically. Only by touching the arrow icon at the bottom-right
corner of the screen will the System Toolbar pop up. From left to right the icons are: System

Settings, System Information, Text Keyboard, and Number Keyboard.

How to hide HMI System Setting Toolbar:

® When [DIP Switch 2] is set ON, the system setting toolbar is disabled. When set OFF; the
system setting toolbar is enabled. Please restart HMI to enable/disable the toolbar.

® For mTV Series, flip DIP Switch 1 to ON to hide system setting toolbar.

® System register [LB-9020] can also enable/disable system setting toolbar. When [LB-9020]
is set ON, the toolbar is displayed, and set OFF to hide the toolbar.

4,5.1. System Setting
cMT/cMT X Series

Starting from OS version 20231201, the system settings interface of the cMT X Series has been
revamped. This section demonstrates the different interfaces before and after this OS version.
Password is required for configuration and modification of system parameters for security. The
default password is 111111.

OS versions after 20231201:

Setting @3 BEGeR Themes

Light and dark themes available for choice

I__| WE'NTEK EasyBuilder Pro V6.09.02
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Setting @ ear@

System Properties

Model / HMI Name / O...

o CODESYS
Activate CODESYS / Re...

Project
Clear History / Restart ...

Network

Ethernet / Configure /1...

0 Security
Admin / Update Projec...

L—| WE!NTEK

System Properties

Model cMT2078X
HMI Name cMT2078X-FAE-4892
0S Version 20240328
Hardware Key  SJECK|/QM-AAZFQ-|JGBQ-AAA

LAN1T MAC Address

LAN2 MAC Address

Date

Time

based on its intended surrounding.
System Properties

[Model]

The HMI model.

[HMI Name]

Set the HMI name for easy identification

when downloading/uploading project files.

[OS Version]

The current OS version.

[Hardware Key]

The hardware key of the HMI.

[LAN1 MAC Address]

The MAC address for LAN 1.

[LAN2 MAC Address]

The MAC address for LAN 2.

[Date]

Set the local date on the HMI.

[Time]

Set the local time on the HMI.
[Brightness]

Adjust the screen brightness.

[Sound]

Adjust the system volume.

[Language]

Select the system interface language.
[Input Method]

Select the input method for the system
keyboard, multiple selections allowed.
[Show Start Button]

Enable to display the Start button. If not
enabled, the button's position can be set,
and it will appear by long-pressing for 1.5
seconds.

[Show Download Popup Window]
Enable or disable the download popup
window.

[Show Mouse Cursor]

Enable or disable the mouse cursor.

EasyBuilder Pro V6.09.02
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Setting @ e

System Properties
Model / HMI Name / O...

° CODESYS
Activate CODESYS / Re...

Project
Clear History / Restart ...

Network
Ethernet / Configure /1...

e Security
Admin / Update Projec...

L—| WE!NTEK

Activation Status
CODESYS Status
Application Status
Login Status

Version

Configure

IP Address

CODESYS

Activated (QA0000500)

[System Keyboard Sound]

Enable or disable the system keyboard
sound.

[Direction]

Select the display orientation, options
include 0 degrees, 90 degrees, 180
degrees, or 270 degrees.

[System Metrics]

View CPU, memory, eMMC, and network
usage.

[Reset HMI to Default]

Reset the HMI to factory settings.

[OS Upgrade]

Select the OS file from SD card or USB drive
to begin upgrading system firmware.
During the upgrade, do not turn off the
power. For detailed upgrade steps and
precautions, please refer to the OS upgrade
instructions for each model.

[Third-party Licenses]

View and manage third-party licenses.
CODESYS

[Activation Status]

View the activation status of CODESYS.
[CODESYS Status]

View the status of CODESYS.

[Application Status]

View the running status of the application.
[Login Status]

View the login status.

[Version]

View the version number of CODESYS.
[Ethernet (LAN1)]

Set the IP Address, Subnet Mask, and
Gateway.

EasyBuilder Pro V6.09.02
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Setting @ Bare

Clear Hi

System Properties

Model / HMI Name / O... Restart

o CODESYS
Activate CODESYS / Re...

. Project
Clear History / Restart ..

Network

Ethernet / Configure /1...

0 Security
Admin / Update Projec...
Setting @ ear@

System Properties
Model / HMI Name / O...

istory

EB Project

Configure

IP Address

o CODESYS
Activate CODESYS / Re... Subnet

Mask

Gateway

Project
Clear History / Restart ... DNS

Project

Network

Network .
® Ethernet / Configure /1. Enable CODESYS Login

e Security
Admin / Update Projec...

Setting @ sar@
@
Admin
System Properties Manage everything on this HMI
Model / HMI Name / O...
Update Project
0 ‘CODESYS
Activate CODESYS / Re... For updating project via external devices
X History
Project
Clear History / Restart ... For history backup via external devices and web
Network r
Usel

Ethernet / Configure /1...

. Security
Admin / Update Projec...

For cMT

L—| WE!NTEK

Viewer/Diagnoser

Security

or web

Project

[Clear History]

Clear the historical data related to project
files, such as recipes, event logs, data
sampling, etc.

[Restart EB Project]

Restart the EasyBuilder Pro project file.
Network

To download project files to the HMI via
Ethernet, the HMI's IP address needs to be
correctly configured. Choose to
automatically assign an IP address or enter
it manually.

[Ethernet LAN1]

Typically used for external network
connections, requiring the configuration of
a gateway and Domain Name System
(DNS).

[Ethernet LAN2]

Typically used for internal network
connections, such as connecting to a PLC.
To avoid network conflicts, LAN1 and LAN2
should be set in different subnets.
[Network Bridge]

For dual Ethernet port models, bridge
mode can be enabled to allow LAN1 and
LAN2 to be in the same network segment,
achieving the function of a switch.
Security

Manage passwords for different users.
[Admin]

Highest level of access, capable of
operating all functions and settings,
including file upload and download,
historical data backup, and password
modification for all permission levels.
[Update Project]

This password is used for file upload and

EasyBuilder Pro V6.09.02
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Setting @

& Eihernet / Configure /1..

o Security

Admin / Update Projec..

a EasyAccess 2.0
Version / Activation Sta...
VNC
Enable / Multiple Conn...

Q FTP
Enable / FTP Port (defa...

O Printer

Printer Name / Printer ...

Setting &»
e Security

EITE

EXT@

Admin / Update Project / ..

o EasyAccess 2.0
Version / Activation Statu

o CODESYS
Activate CODESYS / Resto..

. VNC
Enable / Multiple Cannec...

Q FTP
Enable / FTP Port (defaul...

0 Printer
Printer Name / Printer Dr.

L—| WE!NTEK

EasyAccess 2.0

Version
Activation Status

Region

Connect
State
Error Code
Domain

Session ID

VNC

Enable
Multiple Connection
Require Password

VNC Password

Enable
Timeout

Status Bar Style

Activated

Global >

2 (Connected)
0
WEINTEK_FAE

0

download and historical data backup.
[History]

This password is used for FTP Server login
and historical data backup.

[User]

Used for logging into cMT
Viewer/Diagnoser. The passwords for the
above three permission levels can also be
used in cMT Viewer.

EasyAccess 2.0

Information page for EasyAccess 2.0.

= Click the icon to download the demo
project. Please confirm your internet
connection before downloading the demo
project.

VNC

[Enable]

When VNC function is enabled, VNC client
devices can connect to the HMI. This allows
remote users to view and operate the HMI.
[Multiple Connection]

Allows multiple VNC client devices to
connect. Please note that the more VNC
client devices connected simultaneously,
the more it may impact the communication
speed of the HMI.

[Require Password]

To protect system security, a password can
be set so that only VNC clients entering the
correct password can connect to the HMI.

VNC Interlock:

[Enable]

Enable VNC interlock function to enhance
system security and management.
[Timeout]

Set the timeout period for VNC interlock. If
there is no operation within the set time,

EasyBuilder Pro V6.09.02
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Setting €@» BaT@

& cthernet s configure /1.
O Security
Admin / Update Projec...

B EasyAccess 2.0
Version / Activation Sta...

VNC
Enable / Multiple Conn...

m BB
Enable / FTP Port (defa...

a Printer

Printer Name / Printer ...

Setting &» BaT

9 Security
Admin / Update Project / ..

B EasyAccess 2.0
Version / Activation Statu

0 CODESYS
Activate CODESYS / Resto...

VNC
Enable / Multiple Connec..

0 FTP
Enable / FTP Port (defaul

Printer
L

Printer Name / Printer Dr..

L—| WE!NTEK

Enable
FTP Port (default:21)

FTP Client Can Modify USB/SD Data

Printer

Name

Version

URI ) |
Print a Test Page

Backup PPD File

Install Printer

the session will be automatically
disconnected.

[Status Bar Style]

Choose the display mode of the status bar,
which can be adjusted as needed.

FTP

[Enable]

Enabling FTP service allows users to access
files on the HMI via FTP clients over the
network.

[FTP Port (default:21)]

Set the port number for FTP service. The
default port number is 21.

[FTP Client Can Modify USB/SD Data]

This option allows FTP clients to modify
files on the USB drive or SD card connected
to the HMI. When enabling this feature,
ensure appropriate security measures are
in place to prevent unauthorized access.
Printer

[Name]

The name of the printer connected to the
HMI.

[Version]

The current version of the printer driver.
[URI]

The URI of the printer, used for locating the
printer.

[Print a Test Page]

Clicking this option will print a test page to
check if the printer is functioning properly.
[Backup PPD File]

Back up the PPD (PostScript Printer
Description) file, which describes the
printer's capabilities.

[Install Printer]

Configure the settings for the printer
installation.See Chapter 23.3 in this user
manual for more information on printer
installation.
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OS versions before 20231201:

S ABLAEEY LSRR E LR R LA R LR LR D R )

"1 Setting CODESYS Active

System settin|
yst 2 CODESYS Activation Code:

@ Information
—| Restore CODESYS License Restore

—i‘ covssrs

2 General
® Network
® Time/Date

&£ HMIName

AN Yarw L5 N S ST

h?J Setﬁng

System setting

TE S S S SR SR RSSO
General

Direction J )

Brightness

@ Information

lii CODESYS
Popup download window

R p——— 2
® Network
FTP client can modify USB/SD data G
@® Time/Date
Show Start button ()
&£ HMIName
AT  ARALAL T %%
Setting 4« Cancel Ethernet1

System setting

MAC address 00:0c:26:14:47:3e

()

@ Information
Obtain an IP address automatically
i CODESYS
IP address
& General

0 ot

@® Time/Date

Subnet mask

Gateway

DNS
&£ HMIName

[\& WEINTEK

CODESYS
Enter the activation code to activate
CODESYS.

General

General settings including FTP settings.
[Direction]

Select the display orientation, options
include 0 degrees, 90 degrees, 180
degrees, or 270 degrees.

[Brightness]

Adjust screen brightness.

[Popup download window]

When enabled, the download window can
pop up.

[Show Start button]

When enabled, the Start button is
displayed.

[Show mouse cursor]

When enabled, the mouse cursor is
displayed.

Network

To download project files to the HMI via
Ethernet, the HMI's IP address needs to be
correctly configured. Choose to
automatically assign an IP address or enter
it manually.

To use Email or EasyAccess 2.0, the DNS
needs to be set correctly. For models with
two Ethernet ports, associate two IP
addresses with different domains to avoid
network conflict.
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; Setting

System setting

@ Information
lii CODESYS
22 General

® Network

£ HMIName

Time/Date

Date

2020-05-18 )

13:49:45 )

Setting
System setting

@ Information
i CODESYS
22 General

® Network

@ Time/Date

HMI Name

HMI name

CMT-473E )

sering

System setting

[ Project Management

A System Password
&2 Enhanced Security
© VNC Setting

4 EasyAccess 2.0

élea; Histl)ry !
Clean Recipe

Clean Recipe Database

Clean Event Log

Clean Data Log

Clean Operation Log

[\& WE!NTEK

[Enable Bridge Mode]

For dual Ethernet port models, bridge
mode can be enabled to allow LAN1 and
LAN2 to be in the same network segment,

achieving the function of a switch.

Time/Date
Set the local date and time on the HMI.

HMI name

Set the HMI name for easy identification

when downloading/uploading project files.

Clear History

Clear historical data stored on HMI.

EasyBuilder Pro V6.09.02
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@ Setting

Project Management

System settin,
i 5 Restart EB Project ( Restart

® Clear History

A System Password

&R Enhanced Security
@ VNC Setting

W3 EasyAccess 2.0

Setting System Password

System settin;
4 5 System setting >

® Clear History

Update project >
[ Project Management

History >

User >

&R Enhanced Security

@ VNC Setting

T4 EasyAccess 2.0

® Setting

Enhanced Security

Systemn setting

Start edit user account Start

® Clear History
[ Project Management
A System Password

@ VNC Setting

W3 EasyAccess 2.0

Setting VNC Setting

System setting
Start VNC
[y Project Management

f System Password

VNC multi connection i)
b

VNC login password
&9 Enhanced Security

Rz EasyAccess 2.0

@W» Language

wm InDut Method

[\& WE!NTEK

Project Management
HMI can be rebooted by clicking the
Restart button.

System Password

By default the password is 111111.
User-defined passwords can be used after
verification.

Enhanced Security
Add or delete user accounts and manage
user privileges.

VNC Setting

When enabled, VNC can be used to
monitor a remote HMI over an Ethernet
network.

[Start VNC]

Allows connections from VNC client
devices.

[VNC multi connection]

Allows multiple VNC client devices to
connect. Note that the more VNC client
devices connected simultaneously, the
more it may impact the communication

EasyBuilder Pro V6.09.02
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= setting

System setting

® Clear History

[ Project Management
A System Password
&R Enhanced Security

© VNC Setting

EasyAccess 2.0

EasyAccess 2.0 Connection >

Proxy >

; Setting

System setting
W EasyAccess 2.0
@ Language

8 [nput Method

&

X 0S Upgrade

O Reset options

Printer
Printer name Not installed

URI

Install network printer »

@ Setting

System‘semng
T4 EasyAccess 2.0
©® Language

B8 [nput Method

a Printer

O Reset options

0OS Upgrade

Image path :

Setting

System setting

T4 EasyAccess 2.0
©® Language
B8 [nput Method

é Printer

X 0S Upgrade

EE—|

Reset options

Reset HMI to default Start

[\& WE!NTEK

speed of the HMI.

EasyAccess 2.0

Activate EasyAccess 2.0 service.

i Click the icon to download the demo
project. Please confirm your internet
connection before downloading the demo

project.

Printer
See Chapter 23.3 in this user manual for
more information on printer installation.

OS Upgrade

Select the OS file from SD card or USB drive
to begin upgrading system firmware.
During the upgrade, do not turn off the
power. For detailed upgrade steps and
precautions, please refer to the OS upgrade

instructions for each model.

Reset options
Restore HMI to factory settings.

EasyBuilder Pro V6.09.02
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eMT/iE/XE/mTV Series

Network
Netwcrk\Time/’Date\ Secur\tv\v\me\\r sett\ng‘\O

When downloading project file to HMI via Ethernet,

( Obtain an 1P Address Automatically set the correct IP of the target HMI. You can obtain
P address get from below an IP address automatically or enter the IP address
Paddressi  [102 | [1ea[[1 [[es | manually. To use Email and EasyAccess2.0, please set
Subnet Mask:  [5ee | [oee | [oms | o | .
Gl Sl correct DNS address. For models with two Ethernet
Gratizllfa: 192 ||188 L[t ||254
DNSaddress: [ [ s [ | ports, please associate two IP addresses with

different domains to avoid network conflict.

Prev | Next | Cancell Apply | OK e |

Time / Date

Metwork' Time/Date\ Securitv\[v“ame\semnq\nq\

8 ﬂDav:B ::j

[
==

12§i Sec:

Set HMI local time and date.

2013 % Men:

Year:

Week: |4

loii Min:

Hour:

282

! Prey | Next | Cancel | Apply | oK /Jl
Security

Metwork' Time/Date\ Securitv\[v“ame\semnq\nq\

Password protection, the default is 111111. Please
[P — | click the buttons to set the passwords, and finish

PvE—— password confirmation.

[Password for entering system]

Download Password |

[Password for uploading project]

Upload (History) Password

[Password for downloading project]

[Password for uploading history data]

! Prey | Next | Cancel | Apply | oK /Jl
History

Network' Time/’Date‘ Se H\stcrv\me‘\\r sett\ng‘\O

Clears history data in HMI.

|_ Clear Recipe

| Clear Operationlog

|_ Clear Eventlog

;'_ Clear Data Log

Clear |

Prev | MNext | Cancell App\vl oK /Il
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[Systemsetings P HMI name
Ewor\ ime ae\ ec name ‘settin \n \
eRor TIme/Dete See I pame st Set HMI name to be used when download/upload
project.
HMI name: | Default HMI
" Prev | Next | Cancel | " Apply | ‘oK /Jl
Frsemesttings P4 OS setting
Network' Tlme/Date‘ Se OS settin \r settin \O
Upgrade : : [Upgrade OS]
Unarade 0 Upgrade firmware. Please do not turn off or unplug
HMI during OS upgrade process. For more details,
Portrait Mode see the instruction about OS upgrade of the model
0 C o0 |C 180 270 used.
(It will take effect at next reboot) [PO rt ra |t |V|Od e]
e ven ] [t [ ] 661 Set screen orientation mode. After changing the
{ Prev | Next | ;Cancel;l i Apply | 10K |
mode, reconnect HMI to power supply, for the
setting to take effect. That is, disconnect all power
from HMI, and then connect again. If portrait mode
is used (90 or 270 degree), the project must be
designed for portrait mode, otherwise it cannot be
correctly displayed.
R | VNC server setting

Network Time/’Date\ Sec  WNC server setting\

Remote HMI monitoring and controlling via
Ethernet.

Start VNC single-connection

[Start VNC single-connection]

Start VNC multi-connection

Allows connection with one VNC client.

Stop/NE ‘

[Start VNC multi-connection]

VMNC login password |

Allows connection with multiple VNC clients.

Connecting more VNC clients may slow down the

Prev | Next | Cancel | Apply | OK ”l

communication speed.

Please see the settings steps in the later part.
E Click the icon to watch the demonstration film.
Please confirm your internet connection before

playing the film.
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System settings =

Network' Tlme/'Date\ Sec  VNC Miscellaneous
Backlight

Brightness

Download setting

V¥ Popup download window

¥ Restart after download/upload

| Prev | Next | Cancel | i Apply | 10K /Il

Network' Time/Date' Secur’ _ VNr Misc Z\IESS ;.D\

" Hide mouse cursor

Enable [Reset HMI to default] button
in calibration mode

FTP client can modify USB/SD data

Prev | Next | Cancell Applyl oK /Il
Systemsettings P4

Network' Tlme/Date‘ Se VN EasyAccess 2.0

EasyAccess 2.0 Is activated

ACCOWRE ¢ |

password |

HWlkey =YCTSE500-S5BN-JOWE
-VSH7-42A4-NVBMEWHH

i Proxy | IEEEE | PACHVERS |

Prev | Next | Cancell Apply | OK e |

Misc 1

Rotary switch for adjusting LCD brightness.
[Popup download window]

If selected, after inserting USB disk or SD card to
HMI, the Upload / Download dialog box shows.
[Restart after download/upload]

If selected, restarts HMI automatically after
uploading / downloading project.

Misc 2

[Hide mouse cursor]

If selected, the mouse cursor will be hidden.
[Enable [Reset HMI to default] button in calibration
mode]

If selected, when the operator presses and holds
anywhere on the screen for more than 2 seconds
during HMI startup, the touch screen calibration
mode will start. After calibration, [Reset HMI to
default] option shows.

[FTP client can modify USB/SD data]

If selected, USB/SD data can be modified using FTP.
[Modify HMI ports]

Change the port number for Upload/Download and
FTP.

EasyAccess 2.0

Activate EasyAccess 2.0 service.

i. Click the icon to download the demo project.
Please confirm your internet connection before

downloading the demo project.

The following steps explain how to set VNC server.

1.

2.
3.

Enable HMI VNC server, set password.

Install Java IE or VNC Viewer on PC.

Enter remote HMI IP in Internet Browser. Or, in VNC Viewer enter remote HMI IP and

password.

L—| WE!NTEK
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SR WM SR ARARGS TR Nex

Orx-O HNEAG Pue Jramez @ 3- 58 o -
P01 8] My 192160 3

REAL

Ve

VNG Viewer Free Eolon 41
Copyright (C) 2002- 2008 ReaMNC LY.
Sae 105 S reabnc COM or MISMABEN 6N VNG

lox= @ et

4.5.2, System Information

Network: Displays network information & HMI IP address.

(Default HMI)

Version: Displays HMI firmware version and model type.

[\& WE!NTEK
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5. System Parameter Settings

This chapter introduces the system parameter settings.

5.1.
5.2.
5.3.
5.4.
5.5.
5.6.
5.7.
5.8.
5.9.

5.10.
5.11.
5.12.
5.13.

OVBIVIBW ...ttt ee ettt e e e e ettt et e e e e e sttt e e e e e e s e anbe et eeeeeesesanssseeeeeeeeessannnrnenaeaeens 5-2
DIBVICE .eeeeeee ettt ettt e ettt et e e e e e s b bt e e e e e e e s e rr e et e e e e e e s e nnrreeeeeeeeaeaann 5-2
1Yo e 1] DO PP PRSP PPRTPPPRRRO 5-12
(CT=T Y] - | AP PP OPPPPRRUPPPPPRI 5-16
SYSEEM SELHING oo 5-23
REMOTE ...ttt ettt aaeeeeeesbebebeseeesnsessnsnnsnnnnnnnnnnes 5-26
L =To{ U1 g1 AV 5-27
[ T=T Yo [=Te Y/ =T ' o] VU RUPRR 5-30
PriNter / BaCKUP SEIVEN........uviieeieecee ettt ettt re e e e e e eare e eeaaeeeneeas 5-34
THMIE SYNC./DST ottt ettt e et e e et e e e te e e e be e e e beeesabeeesaseeeeaseeenaseesnseeenrens 5-35
L1V T DU PPPTRRUPUPPPRN 5-37
Cellular Data NETWOIK ...cooeiieeeeieeee et s siee e e 5-39
o I PP PR PP PP 5-41
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5.1. Overview

Launch EasyBuilder Pro, in the main menu select [Home] » [System Parameters] to open the
[System Parameter Settings] dialog box. System Parameter Settings are divided into several

tabs, these tabs will be introduced respectively in this chapter.

5.2. Device

Parameters in this tab determine the attributes of each device connected with HMI. The device
can be a Local / Remote HMI / PLC. A default device "Local HMI" exists when creating a new

project. This device is the HMI that will be updated and programmed.

5.2.1. Local HMI Configuration

Device Settings @

Name : Local HMI
(@) HMI
Location : | Local - Settings.
Enable secure communication

LW protection
Prohibit remote-write operation of remote HMI or MODBUS client

LW range : g ~ 1000

RW protection
Prohibit remote-write operation of remote HMI or MODBUS client

RW range : 0 ~ 1000
Setting Description
Enable secure With this option selected, the HMI encrypts the
communication communication to ensure the security of data

transmission. This feature is supported only on cMT X

Series HMlIs, and it can only communicate with other

I__| WE!NTEK EasyBuilder Pro V6.09.02
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devices that also support secure communication.

LW protection, o ) ) )

. For specific instructions on data protection settings, see
RW protection, | e

. Chapter 39 Data Security" in this manual.
Data Security

5.2.2. How to Control a Local PLC

i, | PLC Device

HMI
“Local Device” is a device connected to the local HMI. To control/connect a Local Device, add
this type of device first. Click [System Parameters] » [New] to open [Device Properties] dialog
box. For example, when connecting MODBUS RTU as a Local Device:

Device Settings @
Name : MODBUS RTU

(0 HMI ©) Device

* Select Local for a device connected to this HMI, or Remote for a device connected through another HMI.

Device type : [ MODBUS RT1, RTU over TCP | » ]
Device ID : 4, V.5.00, MODBUS_RTU.e30

IF: [RS*BZ v} Open Device Connection Guide...

* Support off-ine simulation on HMI (use LB-12358).
* Support communications between HMI and device in pass-through mode.

*Set LW-9903 to 2 to enhance the speed of download/upload device program in pass-through mode.

COM: [COM1 (9600,E,8,1)
Open HMI pin ent suide...
Device default stationno. : 1
["]use broadcast command
[~] Default station no. use station no. variable

How to designate the station no. in object's address?..

Interval of block pack (words) : [5 v] [ Address Range Limit... ]

Max. read-command size (words) : [ 120 v] [ Data Conversion... ]

Max. write-command size (words) :

o]
Setting Description
Name The name of the device.
HMI / Device In this example a device is used, so select [Device].
Location Select [Local] or [Remote]. In this example the device is

connected to the Local HMI, so select [Local].

Device type Select the type of the device.

I/F The available interface: [RS-232], [RS-485 2W], [RS-485
4\W], [Ethernet], [USB], and [CAN Bus].
® |[f the interface used is [RS-232], [RS-485 2W], or
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[RS-485 4W)], configure communication parameters
by clicking [Device Properties] » [Settings] and then
[Com Port Settings] dialog box opens.

Device Settings @

COM Port Settings

COM: |COM1 = Data bits : |8 Bits =
Baud rate : | 9600 -~ @ Parity :
Stop bits: |1Bit =

g
A

Communication Settings
Timeout (sec) : [3.0 -

Turn arcund delay (ms) : 0

Resneding commands : |0 -

(2]

K I I Cancel

Timeout

If the communication has been disconnected for more

than preset time limit configured in [Timeout] (in sec),

Window No. 5 will pop up and show “Device No

Response” message.

Turn around delay

While sending the next command to the device, HMI will

delay the sending according to the time interval set in

[Turn around delay]. This may influence the efficiency of

the communication between HMI and the device. Default

value is “0”.

Note: If the device used is SIEMENS S7-200 Series, it is

recommended to assign “5” to [Turn around delay] and

“30” to [Send ACK delay].

® |[f the interface used is [Ethernet], click [Device
Properties] » [Settings] and the [IP Address Settings]
dialog box opens. Please set correct device IP address
and port number.
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Device Settings
IP Address Settings
Paddress: | 192 . 168 . 1 . 100 |
Portno.: 502

Communication Settings

Timeout (sec) : |1.0 v

Turn around delay (ms) : 0

Resneding commands : |0 v

[ OK H Cancel ]

® |f the interface is [USB], no further setting is
required. Please check the settings in [Device
Properties].

® |If the interface is [CAN (Controller Area Network)
Bus], please see “Device Connection Guide” for

“CANopen” and import the .eds device file.

Device
default

station no.

Set the default station number for device address if the
device station number is not included in the address.
Device station no. can be set in its address. The address
format: ABCH#Addr

ABC stands for device station number and ranges from 0 to
255. Addr stands for device address. And the “#” sign
separates the station number and the address. As shown
in the following figure, the data is read from device station
number 1, and address 0x-20.

Device : {MODBUS RTU v]
Address type : [Ox v]

Address : 120 | |User-defined tag

Address format : DDDDD [range : 1 ~ 65535]
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New Bit Lamp/Toggle Switch Object @
| General [Security | Shape | Label |
Comment :
© BitLamp ) Toggle Switch
Read
Device : (MODBUS RTU 4| e e
Address: [0x v| 1#20 [
[ Invert signal
Default Use the station number variables as the default device
station I:IO. station number. Select one from LW-10000 to LW-10015
use station _ '
no. variable (var0 to varl5) as the station number variables. If the
station no. is not specified in device address, the station
number will be determined by the station no. variable.
For example, if var3 is set for default station no:
PLC defaul station no. : [LW—lEIEIEB (16bit) : var3 v]
Default station no. use station no. variable
[ use broadcast command
The followings demonstrate some examples:
® The device station number is “5”.
Read address
PLC name i[MODBUS RTU v] Setting...
Address :[4,( v] 5#111
® The device station number is determined by var7
(LW-10007)
Read address
PLC name i[MODBUS RTU v] Setting...
Address :’4,( v] vard#111
® Device address is set to “111”, since device station
no. is not specified, and the default station no. is
var3, the device station no. is determined by var3
(LW-10003).
Read address
PLC name i[MODBUS RTU v] Setting...
Address :[4,( v] 111
!.- Click the icon to download the demo project. Please
confirm your internet connection before downloading the
demo project.
Use When [Use broadcast command] check box is selected,
broadcast please fill in [Broadcast station no.] according to the
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command

broadcast station number defined by the device. When
HMI sends a broadcast command to the station number
set here, the device will only receive the command and

not reply to HMI.

PLC default station no.: @

[T Defautt station no. use station no. variable

[¥] Use broadcast command Broadcast station no. : [255 -

As shown in the following figure:

Read address

PLC name :[MODBUS RTU vJ Setting...

Address :[4,( v‘ 255%200

When HMI sends a command to address 255#200, all the
devices will receive this command and will not reply.
Only devices that support broadcast command can use

this feature.

Interval of
block pack
(words)

If the interval between read addresses of different
commands is less than this value, the commands can be
combined to one. The combining function is disabled if
this value is set to “0”.

For example, the interval value is set to “5”, to read 1 word
from LW-3 and 2 words from LW-6 respectively (read from
LW-6 to LW-7), since the interval of addresses between
LW-3 and LW-6 is less than 5, these two commands can be
combined to one. The result is to read 5 consecutive words
from LW-3 to LW-7.

Note: The maximum size of command combination data

must be less than [Max. read-command size].

Max. read -
command
size (words)

The maximum data size to read from the device at one

time. Unit: word

Max. write -
command
size (words)

The maximum data size to write to the device at one time.

Unit: word.

After all settings are completed, a new device named “Local Device 1” is added to the [Device

list].
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System Parameter Settings @
Cellular DataNetwork | Prnte/BackupServer | TimeSmeDST | eMad
Device | Model | General | Sysem | Remot | Secwrity | Extended Memory
Device list: What's my IP?
Name Location Device Type Interface I/F Protocol  Stat il
LocslHMI  Local HMI  Local  MTSD73E (800 x 480) < d o
‘Local Device 1; MODBUS RTU Local  MODBUS RTU, RTU over TCE COM 1 9600,E,8,1) RS232  vad

@ Note

B When using a cMT / cMT X Series model, select “Local HMI” in [System Parameter Settings]

dialog box and then click [New Device] to add a “Local Device 1” under “Local HMI”".

System Parameter Settings
| Extended Memory |  CellulwDataNetvork |  TimeSyneDST | e-Mal | FIP
Device \ Model General I System ] Remote | Security
Device list: What's my [P?
Name Location Device Type Interface I{F Protoc
Local HMI | Local HMI Local  cMT3072XHAMT3072XH2IMT> - -
\Local Device 1. MODBUS RTU Local  MODEUS RTU, RTU over TCP (COM 1 (9600E,8,1) {R8232

El Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.

How to Control a Remote Device

m Ethernet e Ethernet
-\-al-¢ ﬂ

Desktop HMI

5.2.3.

HMI

Bod WOD
bod NGD

PLC Device IPLC Device
“Remote Device” is a device being connected to a remote HMI. To control a remote device, add
this type of device first. Please click [System Parameters] » [New] to open [Device Properties]

dialog box. For example, use MODBUS RTU as the Remote Device:
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Mame @ MODBUS RTU
) HMI @ Device

Location : |Remote ~ || settings... | IP:0.0.0.0 (Port = 8000)

= Select Local for a device connected to this HMI, or Remote for a device connected through another
HML,

Device type : [ MODEI: BT, RTU ovex TCP | » ]

PLCID : 4, V.3.30, MODEUS_RTU.e30

IfF: [RSJISS W w | Open Device Connection Guide. .

com: feomi

Device default station no. @ 1

| Default station no. use station no. variable

How to desizmate the station no. in object's address?.

Interval of block pack (words) : E]
Max. read-command size (words) :
Max. write-command size (words) :

Setting Description
HMI or
Device In this example, a device is used, so select [Device].
Location Select [Local] or [Remote]. In this example the device is
connected to Remote HMI, so select [Remote]. Set the IP
address and port number of the Remote HMI by clicking
[Settings] next to [Remote].
IP Address Settings
@ Ethernet () COM port (use master-slave protocol)
IP address: 192 . 168 . 1 . 10
Port no. : 8000
| oK | | cancel
Device Type Select the type of the device.
I/F The interface used for Remote Device. If the remote device
uses a COM port, select [RS-232], [RS-485 2W], or [RS485
4W].
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CcCoOM Set the correct COM port used by the Remote Device.
Device

default Set the station number of Remote Device.

station no.

After all settings are completed, a new device named “Remote Device 1” is added to the

[Device list].
System Parameter Settings @
[ Cellular Data Network | Printer/Backup Server | Time SyncDST | e-Mail
Device Model | Generl | Sysem | Remote | Seewsity |  Extended Memory

Dievice list: W het's wer [E?

JUEI:] Location  Dewice Type Interfare I/F Protoco 2

Local HMI Local HMI Local MTE0724E (200 x480) - 0

RR34852W 1

0 Note

B When using a cMT / cMT X Series model, select the defined “Remote HMI 1” in [System
Parameters] dialog box and then click [New Device] to add a “Remote PLC 1” under
“Remote HMI 1”.

System Parameter Settings @
| Extended Memory |  CellulrDataNetvork |  TimeSyneDST | eMsil | FIP
Device 1 Model General I System I Remote ] Security
Device list: What's my [P?
Name Location  Device Type Intexface I/F Protocol
Local HMI Local HMI Local cMT3072XHicM T2072HH2/c - -
Remote HMI 1 HMI Remote+ HMI  Ethernet TCPAP
Remote *** i MODBUS RTU Remotes= MODEUS RTU, RTU over TCP COM 1 (9600,E,7,1) R8485 2W

El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

5.2.4, How to Control a Remote HMI

: —
HMI HMI HMI

Desktop
“Remote HMI” is the HMI other than “Local HMI”, and PC is also a “Remote HMI”. To control a
Remote HMI, add this type of device first. Click [System Parameters] » [New] to open [Device

Properties] dialog box as shown in the following figure:
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System Parameter Settings

Device Settings

Name :

Location :

* Select Local for a device connected to this HMI, or Remote for a device connected through another HMI.

Remote HMI 1
@ Device

1P : 192.168.1.100 (Port = 8000)

emote

o
it

Setting Description
HMI or . ) .
. In this example, the device used is a HMI, so select [HMI].
Device
Location Select [Local] or [Remote]. In this example Remote HMI is

used, select [Remote]. Set the IP address and port number
of the Remote HMI by clicking [Device Properties] »
[Location] » [Settings].

IP Address Settings
@ Ethernet

IPaddress: 192 . 188 . 1 . 10

Port no. : 8000

[ oK ] [ Cancel

After all settings are completed, a new device named “Remote HMI 1” is added to the [Device

list].

0 Note

System Parameter Settings
| Cellular Data Network | PrintrBackup Server | Time Sync.DST | eMail
Device Model | Genersl | Sysem | Remote | Secusity | Extended Memory
What's my [P?
Location  Device Type Interface I/F Protocol Station No.
Local MT8073E (800 x 480) - - 0
Remoters* eMT/EEAEAP/MTY === Ethemet TCPIP Ni&

B When using a cMT / cMT X Series model, in [Device list] click [New HMI] to add a “Remote

HMI 1”.

System Parameter Settings @
| Extended Memory |  CellularDataNetvork |  TimeSyne/DST | e-Mail |  FIP |
Device [ Model General I System I Remote ] Security |
Device list: What's my IP?
Name Location Device Type Interface  I/F Protocol
LoclHMI Local HMI Locel  cMT3072KH/icMT3072KH2MT307- - 2
Remots HMIT | HMI Remoter HMI Ethernet  TCPAP |
I

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

I__| WE!NTEK

EasyBuilder Pro V6.09.02

5-11


https://www.youtube.com/watch?v=pdsgKOlBmew

System Parameter Settings

5.3. Model

Configure the [HMI model], [Timer], [Printer] and [Scroll bar] settings, and more.

eMT, iE, XE, mTV Series

System Parameter Settings

_ Cellular Data Network ]

-

Printer/Backup Server l

Time $ync/DST | e-Mail |

| Deviee Model | Genersl

[ System | Remote ‘ Security | Extended Memory |

HMI model : [

iE Series - MT8073iE (800 x 480)

o) [Land -

HMI station no. :

Portno. : 8000

Portno.: 8010

Printer

[V] Support cM T/eM T X communication protocol

Type : |None

Scroll bar

Width
@) Small

Pass through (Virtual COM port)
Portno.: 2000

ewiive <] [«]

) Middle

() Large

(2000-2100) [ Enable RSLin brosdesst response

][ Cancel H Help J
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cMT, cMT X Series
System Parameter Settings
| Extended Memo CelllarDataNetvork | TimeSmne/DST | eMal |  FIP |
| Device Model | Gememl | System | Remot | Secwity |
HMI model : [ cMT X Series - Advanced - cMT3072XH/cMT3072XH2... o] | Landscape
HMI station no. :
Portno. : 8000
[V] Support TKAPAE/KE/eM TAnTV communication protocol and EasyWatch
Portno.: 8010 (used as MODBUS server's port no.)
Printer
Type : | HP Business Inkjet 2230... Ilw ][ StatusiControl... )
[V] Use printer on HMI first (if existed). Otherwise, install the printer with the settings.
Interface
) Ethemet ©USB @
Pass through (Virtual COM port)
Portno. : 2000 (2000~2100) [] Enable RSLinx broadcast response
OK ] [ Cancel ] | Help ]
Setting Description
HMI model Select an HMI model.

The [Resize pop-up windows / objects] dialog box will pop
up when changing to a model with a different resolution.

Select required adjustment and click [OK]. In most cases,

select all options.

Resize pop-up windows/objects
General windows
Resize pop-up windows
Resize objects

Keyboard windows
Resize keyboard windows
Resize function key objects

==l

[ OK | ’ Cancel

Landscape/Portrait

Change the orientation of the project.
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HMI station no. Set the station number of current HMI. The default value is
“0”.

Port no. Set the port number of current HMI. The default value is
“8000".

Egﬂ:ﬁﬂtnﬂ:\gaon Supports communication with cMT / cMT X Series models.

protocol cMT / cMT X Series project file should use the same
communication port.

Printer (eMT, Type

iE, XE, mTV A printer can be connected with the HMI. The HP PCL Series

Series) printer is connected through USB interface while other

printers through a COM port.

& For more information, see “23 HMI Supported
Printers”.

If the printer is connected through [COM], configure the
parameters correctly. If the printer type is [SP-M, D, E, F],
the [pixels of width] has to be set accurately, i.e. the set
pixel(s) cannot exceed printer’s default setting, or the HMI

will fail to print data.

Printer (cMT, The printer driver can be installed on HMI.
cMT X Series) Type

Select printer type.

Status address

Shows printer status.

LW-n Status

0 Printer driver is not installed yet.
1 Installing printer driver.

2 Printer is ready.
3

4

Printer is printing.
Print job is canceled.
LW-n+1 Error

0 None
1 Printer is not found.
2 Unknown error.

Control address

Updates printer connection parameters.

LW-n Command

0 None

1 Update connection parameters.
2 Restart printer driver.
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LW-n+1 /O
0 Ethernet
1 USB

LW-n+2 IP address (Total: 4 words)

LW-n+6 Port (Default port number: 9100)

Please note that using only the ppd file for a printer may
not be able to run the printer since the corresponding
driver is absent. Using tested models is recommended.

Scroll bar Set the width of Scroll Bar, when the size of the object is too
small to display the contents, a scroll bar is displayed in the
object. This feature can be applied to objects that allow
scrolling, such as Alarm Display, Event Display, History Data
Display, and Option List.

Pass through

(Virtual COM Set the port number for Pass-through communication.

port)
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5.4. General

Configure the properties related to screen display.

eMT, iE, XE, mTV Series

[7] Enable window layers (This can be used to oxganize/show/hide objects)

Screen saver

Back light saver :

Screen saver :

Saver window no. :

Fast selection button

Attribute :

Position :

Event

Keyboard

51. Keypad 2 - Integer
52. Keypad 3 - Integer
53. Keypad 4 - Integer
54 Keyped 5 - Integer

* |BCD v

0. Keypad 1 - Integer

System Parameter Settings

Cellular DataNetwork | PrintrBackupServer | TimeSyneDST | eMail |
Device l Model General | System l Remote | Security | Extended Memory ‘
Options

[ Enable fast display mode when change window RW_A enabled
Windows

Startup window no. : (10, WINDOW_D10 -
Common window :

T T —
[ ]

—

[V Ensble back light when alarm occurs

25 v | minute(s)

[BCI. Screen Saver v ]
[Emb]z v] [ Settings.. |

[ Hide button when HMI starts

[V] Use LW9450-09455 as time tags of event logs

External keyboard layout (L W-9199)

Project key
Enable

E Type : |QWERTY (D) -
. - ¥

Projectkey: 000000
(range : 0 ~4294901750)

[\& WEINTEK
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cMT, cMT X Series

System Parameter Settings ‘ f,l
Cellular Data Network | 802.1X (WiFi) | WiFiHotspot | TimeSync/DST | eMal [ FTP |
Device I Model General | System ] Remote I Security I Extended Memory ‘

Options =
[VIRW_A enabled Fast display mode...

(V] Trigger release actions anyway if touch moves out of the button

[T]5et value when leaving focus

CSV delimiter : (Conma ) ¥] @

Windowrs

Startup window no, : [10, WINDOW_010 ']

Common window ’Above base window 'J

["|Enable window layers (This can be used to organize/show/hide objects) (i ]

Screen saver
Back light saver : |30 ¥ | minute(s)

V| Enable back light when alarm occurs

Screen saver : |25 v | minute(s)

Saver window no. : [80, Screen Saver el

1

Monitor mode

__|Enable @

Event
| Use LW9450~9455 as time tags of event logs

Keyboard
KR e A (sl External keyboard layout (LW-9199)
66. ASCII Middle(translucent) Type : [QWERTY(0) v @
156. Keypad 7 - HEX

57. Keypad 8 - Floating
3. Sytem Sundad ASCIL

m| »

1

[ ad. | [ Deete |
Project key —
[oc J[ cancel |[ hep
Setting Description
Options Fast display mode

In this mode, selected objects will cache the most recently
read data and display it quickly after window is changed,
achieving a faster display speed.

Controllable objects: Objects that allow variable input, such
as Toggle Switch, Numeric Input.

Uncontrollable objects: Objects that only display states,
such as Bit Lamp, Word Lamp.

The objects that support the fast display mode include: Bit
Lamp, Word Lamp, ASCII, Numeric, Function Key, Option
List, Direct / Indirect Window, Bar Graph, Meter Display,
Animation, Moving / Rotating Shape, PDF Reader, Picture
View, Energy Demand Display.

RW_A enabled

Enable or disable recipe data RW_A. Enable this, the
objects can then control RW_A The size of RW_A is 64K.
Trigger release action anyway if touch moves out of the
button. (cMT / cMT X Series)

With this option selected, releasing the finger after

I__| WE!NTEK EasyBuilder Pro V6.09.02
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touching the button and then sliding the finger out of the
button area is still considered as button release; its release
action(s) will be triggered.

Set value when leaving focus (cMT / cMT X Series)

With this option selected, values will be written upon
leaving the input mode of an object (e.g. Numeric object),
even if not by pressing the ENTER key. For example, data
entry for the current numerical object is considered
completed and value is written when one selects another
object to enter value. An alert message shows when an
invalid value is entered.

0 Note

1. Values will not be retained after pressing the ESC key to
leave.

2. When the system keyboard is used, values will be
directly written after closing the keyboard.

3. With [Input order] enabled, the sequential input is
performed after leaving the object by pressing the
ENTER key. The sequential input will be stopped if
another object is touched during the input process.

CSV delimiter (cMT / cMT X Series)

Save the CSV file generated from Backup or Import/Export

with Comma (,) or Semicolon (;) delimiter.

Windows

Startup window no.

Designate the window shown when start up HMI.
Common window

The objects in the common window (Window No. 4) will be
shown in each base window. This determines that the
objects in common window are placed above or below the
objects in the base window.

Object layout

If [Control] mode is selected, when operating HMI,
[Animation] and [Moving Shape] objects will be displayed
above other kinds of objects neglecting the sequence that
the objects are created. If [Nature] mode is selected, the
display will follow the sequence that the objects are
created, the first created will be displayed first.

Enable window layers (This can be used to
organize/show/hide objects)

With this option selected, layers within a window can be
created in the window tree.

L—| WE!NTEK
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At most 10 layers can be added to a window.
As shown in the following figure, right-click on a window
number and then select [Add layer].

i~ 3 : Monitor Mode

i 4 : Common Window [
i~ 5:Device Response

= 6 :HMI Connection

\~ 7 : Password Restriction

: Storage Space Insufficient

: Backup

Windows Tree v X
-

=]y

New
Open
Close
Delete

Settings

Add layer

The following is an example of creating a layered window:
Place a Bit Lamp object in Layer 1 and a Numeric object in
layer 2.

L0 WINDOW 010
Layer 1 (Bottom)
BL_O (LE-0) (Bottom)
 [# Layer 2
ME_O (LW-0)

Selecting Layer 1 shows only the Bit Lamp object in the

editing window.

Selecting Layer 2 shows only the Numeric object in the
editing window.

F*10 - WINDOW_ 010
Layer 1 (Bottom)
BL_0 (LB-0) (Bottom)
A Layer 2
ME_D (LWW-0)

[\& WEINTEK
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Selecting window 10 shows all objects.

*10 - WINDOW 010
[# Layer 1 (Bottom)
BL_0 (LB-0) (Bottom)
[# Layer2
NE_0 (LW-0)

Screen saver Back light saver
If the screen is left untouched and reaches the time limit
set here, the back light will be turned off. The setting unit is
minute. Back light will be on again once the screen is
touched. If [none] is set, the back light will always be on.
Screen saver
If the screen is left untouched and reaches the time limit
set here, the current screen will automatically switch to a
window assigned in [Saver window no.]. The setting unit is
minute. If [none] is set, this feature is disabled.
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Saver window no.

Specify a window to be displayed when HMI goes to screen
saver mode.

Note: In a saver window, the [Return to previous window]
option of a Function Key can be used to wake up HMI from
screen saver mode; therefore, please avoid editing the
project in the way shown as the example below, to prevent
the HMI from going to screen saver mode repeatedly.
Example: A Function Key used to “Return to previous
window” is placed in Window no. 11, and the HMI goes
into screen saver mode when Window no. 11 is displayed.
In this case, the HMI can wake up from screen saver mode
when any point on its screen is touched, and Window no.
11 will be displayed again. At this moment, if the Function
Key in Window no. 11 is touched, the HMI goes into screen
saver mode again.

Solution: 1. When a Function Key with “Return to previous
window” selected is placed in the saver window, please use
“Change full-screen window” for all other windows.

2. When “Change full-screen window” is used for the saver
window to change to a specific window (e.g., home page),
please make sure that “Return to previous window” is not
used in this destination window. The “Return to previous
window” option can still be used for other windows.

Fast
selection

buttons

This setting is applicable for eMT, iE, XE, mTV, and iP Series.
Setting the attributes for fast selection button for Window
No. 3. To use the fast selection button, create Window No.
3 first.

Attribute

Enable or disable fast selection window. Select [Enable] and
click [Settings] to set the attributes, including color and text
of the button.

Position

Select the button position on the screen. If [Left] is chosen,
the button will show at bottom left side of the screen; if
[Right] is chosen, the button will show at the bottom right
side of the screen.

Settings

Set the shape and label font of the Fast Selection Button.
Hide button when HMI starts

The Fast Selection Button will be hidden, calling it out
requires system registers LB-9013~LB-9015.
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Monitor
Mode

This setting is applicable for cMT / cMT X Series.
Window no. 3 in the project is monitored in this mode in
cMT Viewer. The user can select up to 50 cMT / cMT X
Series HMlIs to monitor in cMT Viewer, and in 3x3 or 5x4
tile view.

Event

Use LW9450~9455 as time tags of event logs

When this option is selected, Event Log will use the
following time tags to show the time that the event is
triggered.

LW-9450: time tag of event log — second (range: 0~59)
LW-9451: time tag of event log — minute (range: 0~59)
LW-9452: time tag of event log — hour (range: 0~23)
LW-9453: time tag of event log — day (range: 1~31)
LW-9454: time tag of event log — month (range: 1~12)
LW-9455: time tag of event log — year (range: 1970~2037)
Please note that the system will not be able to use these
time tags when one of them exceeds acceptable range.
= Click the icon to download the demo project. Please
confirm your internet connection before downloading the

demo project.

Keyboard

The window number in which the keyboard is placed.
When using Numeric Input or ASCII Input objects, the type
of keyboards can be selected. Up to 32 keyboards can be
added. To design a keyboard, a window should be
designated for creating it. Press [add] after creating and
add the window to the list.

Ii?See “12 Keyboard Design and Usage”.

External keyboard layout

The available USB keyboard layouts are QWERTY, AZERTY,
and Cyrillic. System register LW-9199 allows switching
keyboard layouts on HMI.

Caret color / Select color

This setting is applicable for eMT, iE, XE, mTV, and iP Series.
Set the color of caret that appears when entering data in
Numeric Input and ASCII Input objects or change the
selection color.

Project
protection

Projects can be restricted to be executed by a specific HMI.
&r See “30 Project Protection”.

Update
startup
screen on
HMI

This setting is only available on cMT / cMT X Series.
Default

If an image is already used as startup screen on the HMI,
the image will be cleared when this mode is selected.
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Customized
A .bmp file can be selected as startup screen.

5.5. System Setting

[System Setting] is used to configure different features of EasyBuilder Pro.

System Parameter Settings @
Extended Memory | CelllsrDataNetwork | TimeSyne/DST | e-Msil |  FIP |
Device | Model | Geneml | System | Remots | Secwity |
Startup language after redownloading the project : [Language 1 v]

Delay time of device communication after HMI starts : second (s)

* Use this option to prevent communication exrors when HMI starts faster than PLC.

Execute init. macro when power on
Avuto logout

[V] Enable 1 v | minute(s)

* When a vser does not operate the HMI for longer than the setting time, the system will automatically logout,

[V] Hide mouse cursor Mouse cursor size © | Default v

[T Hide start button
*Use LB-9062 to open hardware setting dialog
Sound control
_) With each touch on a button, a sound is emitted.
@ With each operation from a button, a sound is emitted..

[¥] Disable sound output {or use LE-9019 to disable/enable sound output)
[V] Play next sound after stopping previous. ;]

[V] Disable upload function (effective after rebooting HMI) (or set LBI033 on)
[V Display discomnection icon on already shown objects after communication fails

[7] Enable watch dog (LB-9049) Reboot HMI v|  Timeout (LW-11456) : second (s)

[¥] Display timer for min. press time Timer location :

[¥] Adaptive DPI scaling i)

[ oK H Cancel H Help ]

Some features are duplicated from system registers, such as, [Hide system setting bar
(LB-9020)], [Hide mouse cursor (LB-9018)], [Disable buzzer (LB-9019)], and [Disable upload
function (LB-9033)]. Users can also set these features via system tag.

To select a system tag, select [Address] » [System tag] check box when adding a new object and
then select the [Address Type].

To browse all the system tags, Select [Project] » [Tag] » [System] from the main menu of

EasyBuilder Pro.
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Setting

Description

Startup language after
redownloading the
project

Set the language to use when HMI starts after
the project is re-downloaded.

Delay time of device
communication after
HMI starts

Certain PLC models need relatively longer
startup time. In order to prevent
communication error that occurs when HMI
attempts to communicate with a PLC that has
not yet started, a delay time can be set.
Include delaying the execution of all init.
Macros when HMI starts.

With this option selected, the macros that
have [Execute one time when HMI starts]
enabled will also be delayed.

Execute init. MACRO

when power on

Designate the macro to be executed when HMI
power on.

Auto logout

If leaving HMI untouched for longer than the
set time, the objects protected by security
classes will not be able to operate. The user ID
and password must be entered again to unlock
it.

Hide system setting bar /
Start Button

Hide the system setting bar from HMI screen.

Hide mouse cursor

Hide the mouse cursor in HMI screen.

Mouse cursor size

Set mouse cursor size.

Sound control

With each touch on a button, a sound is
emitted: With sound enabled in object
settings, a sound is emitted when the object is
touched.

With Each operation from a button, a sound is
emitted: When sound is enabled in object
settings and the [Min. press time] is specified,
there may be a time gap between touching the
object and the action of the object. With this
option selected, the sound is emitted when
the object actions.

Disable sound output: Mute HMI. (Not
including the sound played when tapping
system setting button on HMI.)

Play next sound after stopping previous:
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(cMT / cMT X Series only) When the next
sound is triggered at the time the current
sound is playing, the current sound will stop,
and the next sound will start.

Disable upload function

(effective after rebooting
HMI) (or set LB9033 ON)

Disable HMI to upload project.

Use a disconnection icon

or relative objects when
device communication

fails

If selected, a disconnection icon is

displayed on relevant objects %"
when failing to communicate with ﬁ

the device.

This icon will be shown in the /\ﬂ
Iovyer right corner of the .\\:3;’
object.

This icon will only show for
disconnection after successful connection.

Enable watch dog
(LB-9049)

Watchdog automatically reboots the system
after the HMI stops functioning for a specified
period of time.

Enable font preloading
(optimize performance
but HMI may start

slower)

(cMT / cMT X Series only)

With this option selected, the speed of
changing windows that contain more texts is
optimized. Please note that using this feature
may slow down HMI boot time.

Display timer for min.

press time

(cMT / cMT X Series only)

With this option selected, a countdown timer
is shown when an object with min. press time
set is being pressed.

Adaptive DPI scaling

With this option selected, the system will
automatically adjust text size, position, and the
spacing between Y axes based on the screen
DPI of the connected device.

This setting is applicable to Trend Display,
Circular Trend Display, Mail Contact Editor,
Option List, Media Player, Alarm Display, and
Event Display.

If this option is disabled, certain length-based
configurations may not accurately reflect on
different screens.
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5.6. Remote

Parameters in this tab configure remote connections. Certain functions can be carried out

using system registers.

System Parameter Settings @
Extended Memory | CellulsrDataNetwork |  TimeSye/DST |  e-Masil |  FIP
Device | Model I (General I System I Remote Security |
[¥] Prohibit remote HMI connecting to this machine
[¥] Prohibit password remote-read operation {or sst LB053 on)
[¥] Prohibit password remote-write operation {or set LB054 on)
VNC server
[ Passwond free
[] Password from project
[} Monitor mode
Easylccess server
Location of EasyAccess 2.0 sexver : |Global .
[7] Start EasyAccess 2.0 after updating project.
Diagnoser
[¥] Enable
[ Password free
Password : - @
cMT Viewer
Max comnectcownt: 3 5 {count: 1~ 10}
Waming : too many connect count will affect performance.
[ OK ] [ Cancel ] [ Help
Setting Description

Prohibit remote HMI
connecting to this
machine

Prohibit the connection with a remote HMI or
cMT Viewer. The remote HMI will not be able
to control the local HMI.

Prohibit password
remote-read operation
(or set LB9053 ON)

Prohibit Remote HMI to read Local HMlI’s

project password and user password.
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Prohibit password
remote-write operation
(or set LB9054 ON)

Prohibit Remote HMI to write to Local HMI’s
project password and user password.

VNC Server

If [Password free] check box is selected, the
client can connect with HMI via VNC without
entering the password.

If [Monitor mode] check box is selected, the
HMI connected via VNC can only be monitored
but not controlled.

If [Password from project] check box is
selected, set the password for VNC login.

Easy Access server

Location of EasyAccess 2.0 server:

Current location includes Global and China.
Click the icon to watch the demonstration

film. Please confirm your internet connection

before playing the film.

Diagnoser

Enable

When selected, cMT Viewer will allow
diagnostic operations when connecting to a
cMT / cMT X model. System register LB-12656
can also be used to control Diagnoser.
Password free

Enabling Disgnoser will not require password
login. System Register LB-12657 can also be
used to set whether a password is required.
Password

Enter the password for logging in Diagnoser.
System register LW-11756 (4 words) can also
be used to set this password.

cMT Viewer

Max connect count

Allows specifying the allowable number of cMT
Viewer connections for a local cMT / cMT X
HMI.

5.7. Security

Parameters in this tab configure the user passwords and security classes. There are two

authentication modes: General Mode and Enhanced Security Mode.

& For more information, see “10 Security”.
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5.7.1. General Mode

System Parameter Settings @
CelllarDataNetwork | PrinewBackupServer | TimeSyne/DST | e-Mail
Device Model | General l System I Remote ] Security Extended Memory
@ General mode Enhanced security mode External Sexver. Editable...

* Password range : 0 ~ 4294967295
Enable Password ClassA ClassB ClassC ClassD ClassE Clas *

1 [ e ® M ] Wl vl I 2

2 @ eee °® B [ 1 | B | B | B

3 [V eee ® M ] ] ] [ ]

o)
]

©
<]
|
=
L

S
®
{ © © €
E’ 1
a

Up to 12 sets of user and password are available. Password should be one non-negative integer.
Once the password is entered, the objects that the user can operate are classified.

There are six security classes available: Ato F.

If [None] is selected for an object, every user can access this object.

For example, when the security class of User No. 3 is set as the preceding figure, User No. 3

could only access objects of classes A, B, C and “none”.

5.7.2. Enhanced Security Mode

At most 11 users can be set here. An [Administrator] user is provided in this mode. An
[Administrator] has all privileges and can operate all object classes. User passwords must be

alphanumeric, and each user can have up to 12 classes: A to L.

I__| WE!NTEK EasyBuilder Pro V6.09.02



System Parameter Settings

System Parameter Settings
| CelllarDstaNetwork |  Printe/BackwpServer |  Time Sync/DST e-Mail j
Device Model | Gemersl | Sysem | Remote Security Extended Memory |
() General mode @ Enhanced security mode External Sexver. Editable...

[7] Use existing user sccounts and sdministrator settings on HMI first (if existed). Otherwise, vse settings below.

Enable Secretuser User name Password ClassA Cl »
1 ] | userl L . ® M
2 @ ] user2 e - @ M@ E
3 | ] user3 ° - ® [
4 = | userd L . ® ™
5 = | userS L] - @ @
6 [ B userb ® . @ I
< | 1 — »

Class Comment

Class 4 E
ClassB
ClassC -
Administrator
[ Secret user User name : |admin
Password: 000000 B
Control
Device : |Local HMI
Address: (LW 8950 16-bit Unsigned g
Execute auto logindogout when insert an USE key into HMI
@ st 0
EMTP file password
[#] Check password when open EMTP file
o) o ) o)

Setting

Description

Editable

Determines whether other users can change the

password settings or see passwords.

Read-only Settings
[V]Enable read-only

Password: 000000
(1 ~4294967295)

medium @

[¥] Mask password

Enable read-only

Under this mode, the settings can be viewed but not
changed.

Mask password

Passwords are masked by asterisks (*).

Select operable
classes for each

user

When [Use existing user accounts on HMI] check box
is selected, the user accounts existing on HMI will not
be erased after downloading the project file to HMI.
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Administrator

Default administrator account, cannot be deleted, has
all privileges, and cannot be changed. Enhanced
Security Mode can be used with Option List object. It
displays the account names and privileges. If [Secret
user] is checked, the account names and privileges
will be hidden in Option List.

Control address

An address for users to manage the accounts directly
on HMI.

Project password

When this password is enabled, it has to be entered
before editing the project file.

Select [Enable] and then click [Settings] to set the
password.

Execute auto.
Login/logout
when insert an
USB key into HMI

This feature allows automatic login / logout using an
USB security key. The login / logout status will be
written into a designated address. Insert the USB disk
to HMI to log in, and remove the USB disk to log out.
The result codes of login / logout: 0x00: No action,
0x01: Login succeeds, 0x04: Login fails, 0x08: Logout
succeeds, 0x10: Logout fails.

5.8. Extended Memory

Parameters in this tab determine the location of the extended memory.
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System Parameter Settings

| Device |  Model Genersl
Extended Memory | Cellular Data Network
EMO
File name :  emf) emi
EM1
File name : eml i
EM2
File name : gm2 emi
EM3
File name : gm3 emi
EM4
File name : emd emi
EMS
File name :  gm5 emi
EMB
File name : emf emd
EM?7
File name :  gm7 emi
EM8
File name ©  gm8 emi
EM9
File name : em9 emi
EM10
File name : eml10 i
EM11
File name : emll i
EM12
File name : eml2 emi
EM13
File name : eml3 i
EM14
File name : eml4 i
EM15
File name : eml5 emi

|| Enable dynamic file name (not including filename extension)

System

[

=5
Remote I Security |
Time Syne./DST [ e-Mail |
© USBdisk 1 (O USBdisk 2
© USBdisk 1 D USBdisk 2
O USBdiskl ) USBdisk2
@ USBdisk 1 () USBdisk2
© USBdisk 1 T USBdisk2
@ USBdiskl (O USBdisk2
@ USBdikl () USBdisk2
© USB disk 1 (O USBdisk2
O USBdiskl () USBdisk2
@ USB disk 1 () USBdisk2
© USBdisk 1 () USBdisk2
© USB disk 1 USE disk 2
© USB disk 1 (O USBdisk2
O UsBdiskl () USBdisk2
© USE disk 1 (O USBdisk2
© USBdisk 1 () USBdisk2
Usage...
OK J [ Cancel ] [7 Help ]

Extended Memory is numbered from EMO to EM15. It works in a way similar to other device
types (i.e. LW or RW address). Users can simply select from EMO to EM15 in the [Address]

setting while creating a new object. Maximum allowable data size for each Extended Memory

is 2G words.
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LW
PLVW
RW
RVW_A
RWI
EMO
EML
EM2
EM3
EM4
EMS
EME
EMT
EMS
EM3
EM10
EM11
EM12
EM13
EM14
EM15

JPE

Data in the extended memory is saved as a file into [SD card] or [USB disk]. By default, the files
in [EMO] to [EM15] are with the file names “em0.emi” to “em15.emi” respectively, although
users are free to change the file names. To open these files and edit the data in the extended
memory, RecipeEditor.exe may be used.

Data in the extended memory will not be erased when HMI power is cut, which means data in
the extended memory remains the same as before power off when HMl is started again. This is
a behavior similar to recipe data (RW, RW_A).

When the device used as extended memory does not exist, reading the data in the extended
memory will get “0”, and writing data to the extended memory will display "Device no
response" message on HMI.

Cutting HMI power is not necessary for inserting or removing the external device to or from

HMI, making it easy for users to immediately update or obtain data in the extended memory.

Setting Description
Enable dynamic With this option selected, the file names of
file name EMO~EM15 can be changed dynamically. Select “EM

file name index (0~15)”, enter “EM file name”, set
“Control” to 1, and then see the “Result”. After
successfully changing the file name, the new file name
will immediately be the data source of EM address.
Please note that after changing the EM file name
dynamically, the new file name is retained after
rebooting HMI, which may be different from the file
name specified in the project file.
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Address Usage...

Control :
EM file name index (0~15):
EM file name:

Result:

LW-12650
Liw-12651
LW-12652~12701 (50 words)
Lw-12702
0:
1:

2

- fail (invalid file name index)
- fail (the same file name)

- fail (invalid file name)

SUCCESE

fail (not support)

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
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5.9. Printer / Backup Server

Configure remote printer / backup server. This feature is not supported on cMT / cMT X Series

HMI.
System Parameter Settings @
Device Model l General System Remote I Security I Extended Memory
Cellulsr DataNetwork | PrintrBackup Server | TimeSyne/DST | e-Mail
[¥] Use Remote Printer/Backup Server
* Use EasyPrinter to configure PC for printing screen hardcopy and storing backup data.
Output settings
Orientation : @) Horizontsl Vertical
Printer size © @ Original size () Fit to printer margins
Margin : 0 & mm
0 & mm 1] 2| mm
0 S mm
Communication settings
IPaddress : 192 - 168 -1 - 100 |
Portno.: 8005
User name :  admin Password : 000000 ®
Setting Description
Output Orientation
settings Set how will words or pictures be printed out, [horizontal]

or [vertical].

Printer size

Set to print out in [Original size] or to [Fit to printer
margins].

Margin

Set the top, bottom, right and left margin width.

Communication

settings

IP address

Assign the IP address of the printer via network.
[Port], [User name], [Password]

Specify the data to log in server.

Port can be set from 1 to 65535.
Maximum length of user name or password is 12
characters.

r For more information, see “26 EasyPrinter”.

&

4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the dem
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5.10. Time Sync./DST

Configure HMI time synchronization and daylight saving time.

System Parameter Settings @
Device l Model I General [ Systemn ] Remote l Security ] Extended Memory
Cellular Data Network I Printer/Backup Server | Time Syne /DST e-Mail |
HMI time zone © (UTC+08:00) =
* [HMI time zone] setting will also be used for timestamps of OPC U4 and MQTT.
[7] Enable time symchronization with the external device when HMI starts
Device : |Local HMI & ]
Address: [LW v|0 [16-bit Unsigned
[¥] Enable time symchronization via NTP (Network Time Protocol) server
[V] Execute time synchronization when HMI starts
[ Sexver response time has been adjusted in accordance with DST
Server response time :  (UTC+00:00) GMT Standard Time v
Network time server 1 : 0.poolntp.org {e.g. wwv nist gov or 24.56.178.140 )
Network time sexver 2 : 1 poolntp.org
Network time server 3 © 2 poolntp.org
Network time server 4 3 poolntp.org
Update interval {10 ~86400) : 1800 seconds
*Use LW-11273 ~ 11294 to modify settings on HMI.
*1f failed to execute time symchronization, the status of LB-12055 is st to ON.
[V] Automatically set daylight saving time (DST)
Start : | Mach v | [Second | [Sunday v| lbzoo b 3
End : [November - [First v | [Sunday | D200 £ 3
Daylight bias: 01:00 + | (00:30 ~12:00)
* HMI enters into DST period when LB-12355 (read only) is ON.
*Use LW-11260 ~ 11272 to modify settings on HMI.
*DST is not supported in on-line simulation.
[ OK ] [ Cancel ] I Help ]

Setting

Description

HMI time zone

Select HMI time zone.

Enable time
synchronization
with the external
device when HMI
starts

Automatically synchronizes HMI time with the designated
source address when HMI starts. As shown in the settings
above, the time source is set to D address of the device
Mitsubishi FX5U, so 6 consecutive word addresses starting
from D-0 will be the source addresses and each of them

should contain time information as follows:
D-0 - Second (range: 0~59)
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D-1 - Minute (range: 0~59)
D-2 - Hour (range: 0~23)

D-3 - Day (range: 1~31)

D-4 - Month (range: 1~12)
D-5 - Year (range: 1970~2037)

Enable time
synchronization
via NTP (Network
Time Protocol)

server

Execute time synchronization when HMI starts
Automatically synchronizes HMI time with the designated
NTP server when HMI starts.

Server response time

Select NTP server time zone.

Network time server

Provides four fields to fill in Network Time Servers for user’s
device. If the synchronization with server 1 fails, the system
will try to synchronize with server 2, and so on. If HMI time
cannot synchronize with any of the Network Time Servers,
the system register LB-12055 will change to ON status.
Update interval

The frequency of synchronization, the range is from 10 to
86400 seconds.

Automatically set
daylight saving
time (DST)

Start / End

Set the start/end of Daylight Saving Time.

The option [Last] may refer to the 5% or 6! week depending
on the selected month.

Daylight bias

Set the time zone's offset during DST.

0 Note

B When the Network Time Server is configured with a static IP address, write/control

operations can be performed using addresses LW-11278 to LW-11293. However, if the
Network Time Server is configured with a domain name, modifying the IP address of the

Network Time Server via addresses LW-11278 to LW-11293 is not supported.

B When DST ends, and the time falls back, the Trend Display object in Real-time mode will

stop refreshing for the overlapping hour(s) when it just going back to standard time.
However, historical data will not be affected.

B When DST ends, adjusting HMI time (manually or by network) back to the DST period will

not be effective to the system. The system register LB-12355 stays OFF.

B When DST ends, and the time falls back, the system will not start DST for the overlapping

hour(s). The system register LB-12355 stays OFF.

B Before DST starts, adjusting HMI time (manually or by network) into the DST period will
start DST. The system register LB-12355 will be set ON. The HMI time will be the specified
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time without adding the offset.

B During DST, adjusting HMI time (manually or by network) to a time that is not within DST
period will end DST. The system Register LB-12355 will be set OFF. The HMI time will be
the specified time without subtracting the offset.

B This feature does not yet support the DST in Southern Hemisphere.

C?For more information on system registers relevant to DST, see “22 System Registers”.

5.11. e-Mail

Select [Enable e-Mail function] check box to configure the parameters.

When [Use existing contact settings on HMI] check box is selected, the system will use the
contact settings in HMI after downloading the project to HMI, or use the following settings
when no contact is found in HMI.

System Parameter Settings @
~ Device I Model I General [ System | Remote l Security ] Extended Memory 7\
CellularDataNetvork | Printe/BackupServer | TimeSyneDST | e-Mail

[V] Enable e-Mail function
[ Use existing contact settings on HMI first {if existed). Otherwise, use settings below.
* Set the right [HMI time zone] to have correct email sending time.

SMTP settings
Server : Portno.: 0
User name :
Password : @
Confirm Password : @
[T]SMTP server requires authentication
[ Use the following type of encrypted connection
TLS
Sender information
Name : |Use local HMI name in "Device list" v
Local HMI
Mail address :
Error message
[7]Enable

* Failed step and error code are stored to LW-11444-11445.
Error notification

*LB-12053 or LB-12054 is ON when failed to send an e-Mail.

[™] Turn OFF LB-12053 or LB-12054 before sending an e-Mail.

Recipient... Test SMTP Settings...

[ oK j{ Cancel H Help ]
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Setting

Description

SMTP Settings

Server: Set SMTP Server.

Port: Set communication port.

User name: Set e-mail address.

Password: Set e-mail password.

Confirm Password: Confirm e-mail password.

SMTP server requires authentication:

Decide whether Secure Password Authentication is needed
when log in e-mail.

Use the following type of encrypted connection:

Decide whether an encrypted connection (TLS, SSL) is
required when sending e-mails. Please note that TLS
support is limited to TLS 1.0.

Sender

Information

Name:

Enter the sender name or use the local HMI name in the
device list, or the name specified using system register
LW-10884 (HMI name).

Mail Address:

Setting e-mail address.

Error message

When an error occurs in email delivery, the error message
sent from SMTP server can be shown in the designated

address.
C?For more information on system registers relevant to

mail delivery, see “22 System Registers”.

Error Turn OFF LB-12053 or LB-12054 before send an e-Mail

notification When enabled, system registers LB-12053 or LB-12054 will
be turned off before sending e-mail, otherwise, when an
error occurs in email delivery, the register remains ON.

Test SMTP Verify SMTP settings in advance by sending a test email to

Settings the specified e-mail address.

Click [Recipients] to open the following dialog to edit contacts:
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Contacts @
Mo. of groups : 1 Z
Contacts list Group information
Contact Haime Madl Address Contact Haime Mail Address
p NewContact MewContart@d omain com NewContact NewContact@d omain.com
Current group : IGroup A ']
Add I I Remove Comment :
Import... “ Export... ‘ ’ OK ” Cancel ‘
Setting Description
Contact list Add or remove contacts from the list.
Group Group up contacts.
Information No. of groups:

Set no. of contact groups, according to the number, the
groups are named from A to P and up to 16 groups can be
set.

Current group:

Displays the group that includes the contacts above.
Comment:

Enter a description for the current group.

o For more information on sending Event Log, see “7 Event Log”.

& For more information on e-mail related system registers, see “22.3.40 e-Mail”.

E Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.

i. Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
5.12. Cellular Data Network

This tab is for setting cellular data. Cellular data network settings may differ from one model to
another.

Applicable models:

cMT X Series models

cMT-SVR (OS ver. 20151127 or later)

cMT3071/cMT3072/cMT3090/cMT3103/cMT3151 (OS ver. 20180723 or later)
cMT-HDM/cMT-FHD/cMT-FHDX (OS ver. 20190130 or later)
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MT8051iP/MT8071iP/MT8102iP (OS ver. 20201007 or later)
iE Series models (OS ver. 20231215 or later)
Attaching a 3G/4G USB dongle to the USB port enables the cMT-SVR to connect to 3G/4G

networks.
System Parameter Settings
\7 Device Model l General l Systern I Remote I Security \
| Extended Memory |  CellarDatalNetvork | TimeSyneDST | eMel | FIP
3G/4G Dongle
3G/4G Dongle
[T Use existing settings on HMI
PlNcode: 000® e APN @ internet
Userame ©  username Password :  password (@)
Dial number :  #09%
Setting Description

Use existing contact
settings on HMI

If this check box is selected, the cellular data currently
in HMI will be used. When no specific settings are
required, generally, [PIN code] is “0000”, [APN] is
“internet”, and [Username], [Password], [Dial number]

are optional.
The relevant registers:

LW-11297: (16 words) : PIN code of SIM card (cellular network)

LW-11313: (16 words) : Access Point Name (cellular network)

LW-11329: (16 words) : username (cellular network)

LW-11345: (16 words) : password (cellular network)

LW-11361: (16 words) : dial number (cellular network)

LW-11377: (16bit) : stop (set 0)/start (set 1) connection (cellular
network)

LW-11378: (16bit) : last error code (0:success, 1:incorrect PIN code,
2:no SIM, 3:no device, 4:puk locked, 5:other) (cellular
network)

LW-11379: (16bit) : connection status (0:no device, 1:disconnect,
2:connecting, 3:connected) (cellular network)

USB Tethering

By connecting an Android® mobile phone with HMI using a micro USB cable, or any USB data

cable that is compatible with the phone, the internet connection of the phone can be shared

with HMI. On the Android mobile phone please enable USB Tethering.

L—| WE!NTEK
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5-41

Tethering or hotspot active

(== Tethering & portable hotspot

USB tethering
Te ed

Portable Wi-Fi hotspot

Set up Wi-Fi hotspot

AndroidAP WPA2 PSK portable Wi-Fi hotspot

Bluetooth tethering

ng this phone's Internet

When successfully connected, the following registers can be used to monitor and control the

connection status.
LW-11380:

LW-11381:

(16bit) : stop (set 0)/start (set 1) connection (USB
tethering)

(16bit) : connection status (0:no device, 1:disconnect,
2:connected, 3:fail, 4:0S not support, 5:HMI not
support) (USB tethering)

i Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.

5.13. FTP

Device

Server

Client

System Parameter Settings @

Model General System Remote Security
Cellular Data Network

Feep HMI settings Default certificate (@) Custom certificate
Certificate: None
[mport |
Private key: None
Tmport. |
* 08 20240308 or later support explicit FTF over SSL/TLS and can update cnstom certificate.

| Enable FTF function for screen hardeopy and historical data backnp)

Extended Memory
Time Syne. /DST -Mail FTF

FTF connection

FTP comnection : | 1. FTP comnsction : 0.0.0.0:31

MNaming convention for HMI folder
@ Use IP address
Use HMI name (LW-10834-LW-10899)

Frefix: IP_
(Ex : [P_192.168.1.25)

L—| WE!NTEK
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5.13.1. FTP Server

Starting from OS version 20240308, the cMT/cMT X series HMlIs support explicit FTPS. Users

can configure the HMI FTP server certificate with the following options:

1. Keep HMI settings: Continue using the current certificate settings on the HMI.

2. Default certificate: Use the system-provided default certificate.

3. Custom certificate: Users can import their own certificate and private key to meet specific
security requirements.

5.13.2. FTP Client

The FTP client function enables users to back up screen hardcopies and historical data. Once
enabled, users can backup files from the HMI to the FTP server. This feature is similar to the
eMT/iE/XE/mTV series, which uses EasyPrinter for historical data backup.
Please note that this feature is only supported on the cMT/cMT X series.

Setting Description

Enable FTP With this option selected, backup files (screen hardcopy or
Function historical data) can be transferred to FTP server.

FTP Connection FTP server’s information.

Naming Use IP address, backup folder name, or HMI name to name
Convention for the HMI folder.

HMI Folder Prefix: Add a prefix to the beginning of the folder name.

@ Note

B When the FTP function is enabled without any configured FTP connections, the system
will direct users to the [Data/History] » [FTP Connection] settings to configure FTP server
connection parameters.

-

# | EasyBuilder Pro @

Mo FTP server exists. Do you want to create one?

oK Cancel
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6. Window Operations

This chapter describes different types of windows and how to create, set and delete a window.

6.1.
6.2.
6.3.
6.4.
6.5.

OVBIVIBW ...ttt ee ettt e e e ettt et e e e e e s e et e e e e e e sa s anb e et eeeeeesesnsssbeeeeeeeessannnrneneaaeens 6-2
WINAOW TYPES .vvveeieeieeieiiieieeee e e e eesetrrre e e s e e e s ettt e e e e e e sesseasaeaeeeaeesesesnssanneeeeeesessanssnnns 6-2
Create, Set, and Delete @ WINAOW.......coiiiiiiiiiiiiieeee ettt 6-4
WiINAOW TranSPArENCY ....uuereiiieieeeeeicetiiiteeeeeeesesitrrreeeeeeeessssssseseeeeeesessssenseesesesessnssssens 6-8
oo T oY= T o L3S UUPRR 6-10
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6.1. Overview

A window is a basic element in a project. With a window, all kinds of information like objects,
pictures, and texts can be displayed on HMI screen. In total, 1997 windows numbered from 3 ~
1999 in EasyBuilder Pro can be built and edited.

6.2. Window Types

There are 4 types of windows, each with different functions and usages:
® Base Window

® Fast Selection Window

® Common Window

® System Message Window

6.2.1. Base Window

The most frequently used window, except for main screen, it can also be:
® A background of other windows.

A keyboard window.

A pop-up window of Function Key object.

A pop-up window of Direct Window and Indirect Window objects.
A screen saver.

0 Note

B Base Window should be in same size as the HMI screen. Therefore, the resolution of the
base window should be set to the resolution of HMI.

6.2.2. Fast Selection Window

Window no. 3 is the default Fast Selection Window. This window can co-exist with base
window. Generally, it is used to place the frequently-used buttons on the lower-left side or the
lower-right side on the screen. Please create window no. 3 first, and set the relevant properties
in [System Parameter Settings] » [General] tab. Apart from showing or hiding fast selection
window with the button on the screen, there are system registers to do so:

[LB-9013] hide (set ON)/show (set OFF) Fast Selection window

[LB-9014] hide (set ON)/show (set OFF) Fast Selection button

[LB-9015] hide (set ON)/show (set OFF) Fast Selection window/button

0 Note

B cMT/cMT X Series does not support Fast Selection Window.
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6.2.3. Common Window

Window no. 4 is the default Common Window. Objects in this window will be displayed in

other base windows, not including pop-up windows. Therefore, the common objects in

different windows are often placed in common window.

When operating HMI, select [Function Key] » [Change common window] to change the source

of common window.

In menu [File] » [Preferences] » [Display] select whether or not to [Display Common Window

objects on Base Windows] when editing a project. This can avoid overlapping objects in base

window with objects in common window.

Preferences &J
Display Object 1D Display Object Address
Font size : Text color : I ~
[¥] Background Background color : ﬂ

The number of displayed addressas :

Display Common Window objects on Base Windows

[] Display Underlay Window objects on Base Windows
|| using function key to make shape library object

Autormaticaly save and compile the project when download and simulate
[T] Generate backup of project file before save
[ Automatically rmake used pictures and shapes into the project library

Save AutoRecover information

Every minutes

6.2.4. System Message Window

Windows No. 5, 6, 7, 8 are the default System Message Windows:

Eﬁao Device No Response

Window No. 5: Device No Response
When the communication between device and HMI is

disconnected, this message window will pop up

automatically right on the base window currently opened.

This window can be disabled by system registers.

& railed Connection to
D Remote HMI

Window No. 6: HMI Connection
When failing to connect HMI with a remote HMI, this

message window will pop up automatically.

€ Password Protected!
Access Denied!!

Window No. 7: Password Restriction
When attempting to control an object without

authorization, this window may pop up as a warning

depending on the settings of the object.

L—| WE!NTEK

EasyBuilder Pro V6.09.02

6-3



Window Operations 6-4

Window No.8: Storage Space Insufficient
» When HMI flash memory, USB disk or SD card run out of
Storage Space Insufficient !f . . .

storage space, this message window will pop up

@ automatically. (When the memory space is under 4 MB)

The following system registers can be used to check the free memory space in HMI, USB disk,
or SD card:

[LW-9072] HMI current free space (K bytes)

[LW-9074] SD current free space (K bytes)

[LW-9076] USB disk current free space (K bytes)

To check if there is sufficient storage in the devices, the following system registers can be used.

These addresses will set ON when the space is under 4 MB.
[LB-9035] HMI free space insufficiency alarm (when ON)
[LB-9036] SD card free space insufficiency alarm (when ON)
[LB-9037] USB disk free space insufficiency alarm (when ON)

C:’?For more information, see “22 System Registers”.

The text shown in windows no. 5 ~ 8 can be edited for easier reference.

0 Note

B For eMT/iE/XE/mTV models, a screen can display up to 24 pop-up windows simultaneous
including System Message Window, Direct Window and Indirect Window. For cMT/cMT X
Series, the number of pop-up windows is not limited.

B The system does not allow opening the same window (including overlay windows) with
two Direct / Indirect Windows in one base window.

B  Windows no. 3 to 9 are used by the system only, and windows no. 10 to 1999 can be
edited based on actual usage.

6.3. Create, Set, and Delete a Window

Check the existing windows in [Windows Tree].

[Windows Tree] displays window numbers and window names. Opened windows are marked
with T icon. Press the (+) sign to see the object ID, address and description of the objects
used in this window.

[Window preview] displays the thumbnails of windows.
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Windows Tree

™ 3: Monitor Mode

™ 4 : Common Window
[ 5: Device Response
[ 6: HMI Connection

[ 7 : Password Restriction

[T 8: Storage Space Insuffici...
] 9:Backup
[ 10: WINDOW_010

I FK_O (Back)
- FK_1
- FK 2
L FK3
11
12
13
14
15
16
17
18
19
20
21
22
23

6.3.1.

In windows tree right click on a window number then select [New].

Creating and Setting a Window

[\& WEINTEK

Windows Preview
0003

Monitor Mode

0004-

Common Window

Password Rastriction
0008

Lo

Storage Space Insufficient
0009

Backup
0010

WINDOW_010

m
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Window Settings

Name @ WINDOW_010

Window no. : 10

Size
Width : 800

Background

Color : v

[T Filled

Height : 480

Color : GG ~

Frame

Underlay window

Bottom : [11. Window_011 ']

Middle : [None hé ]

Top: [None - ]

Popup window

Start position

¥: 0 v. 0 [¥] Monopaly [¥] Title bar

Macro

Open : [[ID:UUO] macro_0 v]

Cyde : |Disable -

Close : [Disable T ]

Setting

Description

Name

The name appears on the title bar and also in windows tree.

Window no.

Can be 3 to 1999.

Size

Set the window size in accordance with the HMI resolution.

Underlay
window

Underlay Window can be seen as an extra Common
Window. When designing the project, some commonly
used objects are used in some windows but not all. These
objects can be placed in underlay window.

Each base window can set three underlay windows as
background, from [Bottom] to [Top]. The objects in underlay
windows are displayed in this order in base window.

Pop-up
window

Base window can also be used as a pop-up window. Use [X]
and [Y] to set the coordinates indicating where in the screen
will this base window pop up. The origin of the coordinates
is the upper-left corner of the window.

Monopoly

If the option is selected, when the base window pops up, no
operations of other pop-up windows and background
windows are allowed until the monopoly window is closed.
If a base window is used as a keyboard window, “Monopoly"
is automatically enabled.

Title bar

If the option is selected, a title bar appears on a system
message window. This feature is only available for system

I__| WE!NTEK
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message windows no. 5 to no. 8.

Macro Select the macro to be executed when the window opens or
closes, or the macro to be executed periodically (each 500
ms).

Please build the macro in advance.

@ Note

B The objects in underlay window cannot be edited from the base window that displays
them. To edit those objects, please open the underlay window where they are located.

B When the window number of the underlay window used by the base window is identical
to the pop-up window, the pop-up window is disabled.

B When base window and pop-up window use the same underlay window, the objects in
the underlay window cannot be displayed in pop-up window.

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

Or, from the main menu click [View] » [Open Window] and then click [New] and select the type

of the window and click [OK].

Open Window
Nao. Window name Size
3 Fast Selection 100,450
4 Common Window 800,480
5 PLC Response 320,100
6 HMI Connection 320,100 Seitiigs:
7 Password Restriction 320,100
8 Storage Space Insufficient 320,100
*10 WINDOW_010 800,480
50 Keypad 11 - Integer 275,280
51 Keypad 12 - Integer 275,280
52 Keypad 3 - Integer 200,170
53 Keypad 4 - Integer 304,213
54 Keypad 5 - Integer 160,230
55 Keypad 6 - Integer 241,331
56 Keypad 7 - HEX 306,223
57 Keypad 8 - Floating 198,220
58 Keypad 9 - Numeric 248,248
60 ASCII Middle 576,240
61 ASCII Srrall 480,200
62 ASCII Upper M 576,240
63 ASCII Lower M 576,240
64 ASCII Upper § 480,200
63 ASCII Lower S 480,200
Exit

Ways to call up [Window Settings] dialog:

® Right click on the window number in the windows tree and select [Settings].
® In[View] » [Open Window] select the window then click [Settings].
® Inthe window, right click when no object is selected, and select [Attribute].

6.3.2. Open, Close, and Delete a Window

The ways to open an existing window:
® Double click on the window number in the windows tree.
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® Inthe windows tree, select the window number, right click, and then select [Open].
® |n[View] » [Open Window] select the window number and then click [Open].

The ways to close or delete an existing window:

® |nthe windows tree, select the window number; right click, and then select [Close] or
[Delete].
® |n[View] » [Open Window] select the window number and then click [Delete].

6.4. Window Transparency

The Opacity setting in the View tab is used to adjust transparency effect of the common
window, overlay windows, and window layers.

EasyBuilder Pro @

[View] > [Layer Opacity] is set to 50% by default for window layers,
! % common window and underlay windows to enhance object
visibility in current window during editing.

Lo ]

As shown in the following screenshots, greater Opacity makes the object in the relevant

window more visible.

\ () Zoomin . @ Zoomin
) -_ o
. (2) ZoomOut o @ ZoomOut
Opacity Zoom Center Opacity Zoom Center
30% »  75%. (i FittoWindow | View + 70% -~  75%. tiy FittoWindow  View .
T 0% 0%
10% o) 10% = F— e
1 JJJL[H,{[!J,L!Jfﬂjjl,l,l,l,,l,l| Jl,llr?:1|||,||,|,|,|5?‘1|||||
20% 20%
v 30% 30%
40% 409
50% 50%
60% 60%
70% v 70%
80% 80%
90% 80%
100% 100

Additionally, the cMT / cMT X Series models support setting window transparency. This setting
is applicable for popup windows, Direct / Indirect Windows, and keyboard windows. The

settings dialog box and the effect are shown in the following screenshots. Greater transparency
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can make the object on the base window more visible when it is covered by the popup

window.
Wiﬁowﬁeﬂings
Name : WINDOW_010
oo, [0
Size
Width : 1024 Height: 748
Backaground
Color : I:IIV|
Transparency : D 20%s
* [Transparency] is used only on popup, directfindirect and keyboard windows.
Underlay window
Bottom : [None -
Middle : [Nane -
Top:lm vl
Popup window
[¥] Monopoly
Macro
Open l vl
Cycle l vl
Close l vl
ok || cancel |
Example

Setting transparency to 40%:

Setting transparency to 90%:
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6.5. Editing Tips

EasyBuilder Pro provides a user-friendly interface with which users can easily edit projects. The

following are some editing tips.
6.5.1. Non-display Area, Select Tool, and Hand Tool

As shown in the following screenshot, two areas can be found in the editing window: editing
area and non-display area. The non-display area refers to the area outside the editing area (the
one in the middle). Objects placed in the non-display area will not be visible on HMI, and
communication with devices continues. The invisible objects such as Meter, Time-based Data
Transfer, or Text objects used for comments can be placed in this area to avoid overlapping
with other objects in the editing area, which adds difficulty to project editing. The objects
placed in the non-display area remain effective.
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4 10 - WINDOW_010 %

| T OE VTSI, - VTORTIRTIOONE . FVCTONTROTOTCY, . MVCPTYSPRITIICY, . FCTPISRINIIGY: . FOYPOSTPINTOOCY: - AT

h‘ Select Tool
Clicking this icon in the toolbar changes the cursor to the Select Tool. Select a

single object by clicking it, or select multiple objects by clicking on an empty

part of the editing screen and then drag a box around the objects.

4‘"}2 Hand Tool
Clicking this icon in the toolbar changes the cursor to the Hand Tool. The Hand

Tool allows moving through the project screen by simply left clicking the mouse

and dragging anywhere.

6.5.2. Ruler

| :1|I|I|I|I|I|Illllllpﬂllllll|I|I|I|I|I|:F|:1|I|I|I|I|I|I|I|I|_:P|:1|I|I|I|I|I|I|I|I|4F|:4|I|I|I|I|I|I|I|I|59|:1|I|I|I|I|I|I|I|IlfPﬂlI|I|I|I|I|I|I|I|-P|:4|I|I|I|I|I|I|I|I|I|
Selecting [View] » [Ruler] adds rulers to the top and left of the editing screen. Guides can be
added from the ruler by right click on the ruler. Objects will automatically snap to the guides

when moved or resized.
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q 10 - WINDOW 010 x|

Setting Description
Delete Delete the guide.
Edit

Settings

o]
Add or delete multiple guides.

Selecting [File] » [Preferences] » [Grid] opens the following window for setting the color or style
of the Guides.
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Project

Display

Grid
Library

B
Grid
Spacing
X(4-60): 20 = Y (4-60) : 20 =
[ Display [ snap [ Fix all objects
Guides
soie (=)

6.5.3. Quick Copy

Quick copy can be carried out by pressing and holding Ctrl key on the keyboard while an object

is selected, and then drag the cursor to a new location where the object will be created.

[\& WEINTEK
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/. Event Log

This chapter explains how to set and use Event Log.

7.0, OVEIVIEW ittt ettt e e e e e sttt e e e e e s e bbbttt e e e e e e s e nnnrbeeeeeeeesasnnsrnbeeeeeeeessannnrees 7-2
N A=Y o) oY=V - T o T=0=T0 01T o) T 7-2
7.3, Creating a NeW EVENT LOZ ...cccoviiiiiiiiic ettt e e e e e e 7-10
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7.1. Overview

The following are the basic steps to use Event Log:

1.
2.
3.
4.

Define event content and trigger condition.
Trigger event according to the condition.
Save the event log to the specified device.

View the process of event by using the relevant objects.

This chapter will explain how to set and use Event Log.

El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

7.2. Event Log Management

Firstly, define the event content then use Alarm Bar ?, Alarm Display !', Event Display

objects to view the process of the whole event from triggering—waiting to be processed—

return to normal. The upper limit for the number of event logs is 10000.
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7.2.1. eMT, iE, XE, mTV,

Category :

Al = ]

iP Series

1 Jo

<

No.| Category| Text

Mode | Condition| Read address
|Event 0|WORD| < 0.00 |Local HMI: LW-0|Disable | Disable| Disable | Ena

Notification address | Buzzer | e-Mail |Sa\

n b

History files

[7] Enable back light when alarm occurs

[] save to HMI memory []save to USB disk

Print

Preservation limit Days of preservation: 7 day(s)

[¥] Sequence no. Trigger time :  HH:MM v Trigger date : DDMMfYY =

[ New...

][ nsert.. ][ Delete ][ settings... [ Export.. |[ import..

[ cony

] [ Paste ] [ Paste (Add Mode) ] | Exit |

Setting

Description

Category

Classifies events by dividing them into 0 ~ 255 categories.
Select one category to add or view event log. In the bracket
“[1”, it shows the number of events are in this category.

History
files

Saves event log files to the specified location. Once an event
occurs, the HMI immediately saves the history file. When
executing On-line or Off-line Simulation on PC, the files will
be saved in the HMI_memory / SD_card / USB folder under
the installation directory.

Preservation limit

This setting determines the maximum number of Event Log
files to be preserved in HMI memory. This does not include
the file generated today. That is, if [Days of preservation] is
set to 2; the two latest files excluding the file generated today
will be kept. The files that are not within the range will be
deleted automatically for saving the storage space.

[\& WE!NTEK
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Print In [System Parameter Settings] » [Model], select a printer and
set the printing format.
Copy Copy the selected item.
Paste Overwrites the selected item with the new items. A message
window will pop up to confirm this operation.
Paste
Appends as a new entry.
(Add Mode)
7.2.2. cMT, cMT X Series
Event | History/Control
Category : All[1] +  Edit category name mapping. .. 1x]
No. | Category| Text Mode |Condition| Read address | Notification address | Buzzer | e-Mail New...
0 Event0|WORD|< 0.00 |Local HMI: LW-0|Disable Disable | Disable
[ Paste
[ Paste
Enable back light when alarm occurs Number of event (alarm) log : 1 /10000
Setting Description
Category Classifies events by dividing them into 0 ~ 255 categories.

Select one category to add or view event log. The number of
events in this category is shown in the bracket “[ ]”.

Edit category name mapping... Opens a category name table
which allows editing corresponding category names.
Subcategories can also be added in this table in addition to
the exiting categories. The maximum allowable number of
entries in each subcategory is 256 (0~255) entries.

[\& WE!NTEK
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Category
Category | Subcategory 1

Category ~ Mame

B s teoon0

subcategory 2

Delete

* Font from [Language & Fent] settings

o) oo |

Copy

Copies the selected item.

Paste

Overwrites the selected items with the clipboard contents.
A message window will pop up to confirm this operation.

Paste +

Appends the clipboard contents to the end of the list.

Event (Alarm) Log

Histervw#Contrel

Address :

History

Enable

Save to
(CJHMI memory (10000 limited) () HMI memory Guntil space Tull)
@ USE disk 1 (JUSE disk 2
| Statos : LW-0 + 1 Exver : LW-0 + 2

Syne to database
[¥]Enable Database : |1, 192.168.1.0 hd
| Statns : LW-0 + 3 Error : LW-0 + 4

History sonice for display
(@ USSR disk 1 () Databaze
[¥]Preservation limit Days of preservation : 7 dayls)
[V]Limit write frequency to HMI flash drive
[¥]hen starting up, mark events triggered prior to shutdown as recovered
[¥] Anto sync. periedically 30 mins)

Centrol
Enable Enable status ontout
Device : [Local HMI iG]

Lw |0 16-bit Unsigned

Control command @ 1 [clear], 2 [svnc.], 3 [svne, and clear]
[clear and restore log index]
11 [update messages according to imported string tables]

i)
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Setting

Description

History

Saves the Event Log data to HMI memory (10000 limited or
until space full), SD card, USB disk, or database (by
synchronizing Event Log file to database server).

The rules of saving the data are:

B When [HMI memory (10000 limited)] is selected, and
the number of events reaches 10000, the system will
delete the earliest 1000 events on HMI and keep on
saving the data to HMI memory. .

B When [HMI memory (until space full)] is selected, the
system will keep on saving data to HMI memory, in this
case, the data may not be synchronized to database
server. When the cMT / cMT X HMI memory storage is
full, the system will delete the earliest 1000 records and
keep on saving data to HMI memory.

B When USB disk or SD card is selected, and the number of
events reaches 10000, the system will automatically save
the data to the external device and delete the earliest
1000 events on HMII.

B To synchronize the data to database server, select a
database that has been configured before.

B If the external device already contains some events, the
new data is appended without overwriting the original
data each time in synchronization.

B When the external device is removed from HMI, or HMI
is disconnected from database server, if the connection
is recovered before the number of events exceeds 9000,
the events occur during disconnection will be saved to
HMLI. If the number of events exceeds 9000 during
disconnection, the earlier data will be deleted, and

cannot be synchronized by recovering connection.

History
source for
display

Event Log displays the history data read from the designated

source.

Preservation
limit

This setting determines the maximum number of Event Log
files to be preserved in HMI memory. This does not include
the file generated today. That is, if [Days of preservation] is

set to 2; the two latest files excluding the file generated today
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will be kept. The files that are not within the range will be
deleted automatically. The system checks the time of the files

and deletes earlier files only during synchronization.

Limit write When enabled, the system will store operation logs on the

frequency HMI at intervals of 10 seconds. To prevent the loss of

to HMI flash operation log data between two storage actions caused by

drive power-off, EasyBuilder Pro provides the system register
LB-9034. By sending an ON signal to this register, the system
will initiate a data storage process.

When

starting up,
mark events

When enabled, the system will automatically recover events

triggered )
) triggered before shutdown.
prior to .
Range: The last 10,000 events stored in the HMI memory.
shutdown
as
recovered
Auto sync. Data will be automatically synchronized to the designated
periodically external device in the specified time interval, regardless of
the rules explained above.
Unit: Minute(s)
Range: 1~1440
Control If select [Enable] check boxes under both [Control address]
address and [History files], entering a specific value in the control
address sends the corresponding command.
Value | Command
1 Clear the event log on HMI
2 Synchronize event log to the external device
3 Synchronize event log to the external device and then
clear the event log on HMI
4 Use the history data stored in USB disk / SD card /
database after changing HMI
6 Free unused storage space reserved for event logs
(*.db). This command can be used when historical data
is saved to HMI memory (until space full).
11 Update event log message contents by reading a new
String Table
If none of these values is entered, the system will synchronize
data in the same rules as [History] setting.
Status When LW-n is used as the control address, the four
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Error consecutive addresses following LW-n (LW-n+1~LW-n+4) will

show status and error, please see the prompt in the settings

dialog box.
Control address
[¥|Enable
PLC: [Local HMI v][ Settings... |
Address : [LW v o 16-bit Unsigned
Control command : 1 [clear], 2 [sync.], 3 [sync. and clear]
History files
[¥| Enable || Enable status address
[7] sync. to SD card [¥] sync. to USB disk
| Status : LW-0 + 1 Error : LW-0 + 2 |
[¥] Auto sync. periodically 10 min(s)
[¥] Preservation limit Days of preservation : 3 day(s)
Sync to database
[¥] Enable [ pisplay history from database
| Status : LW-0 +3 Error : LW-0 + 4 |
Database : (1. 192.168.1.0 v

Value | Status address: LW-n+1 and LW-n+3

0 Disconnected from external device or database

1 Connecting with external device or database

2 Connected with external device or database

3 Storing records into the archive. When this is done, the

value returns to 2.

Error address: LW-n+2 and LW-n+4

&
[
(0]

None

Unknown error

Failed to connect with external device or database

Access denied

Wrong database name

Inconsistent data format

Failed to open table

Failed to create table

Failed to write table

O NOUn|A|WIN|FL|O

Failed to open database

=
o

Database is corrupted

0 Note

B Before removing SD card / USB disk, or disconnecting from database server, please

synchronize event log data by using control address.

B When monitoring multiple HMls by using cMT Viewer, the Start Button on the current

HMI screen may flash to indicate that an error has occurred on another HMI that is also

being monitored, reminding the user to switch HMI and check the event.

B The [When starting up, mark events triggered prior to shutdown as recovered] option

does not apply to events stored in the HMI memory exceeding 10,000 entries.
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7.2.3. Excel Editing

Click on the Excel icon in Event Log setting dialog box to open the Excel template for a

reference of editing. This template is under the installation directory, the file name is

EventLogExample.xls. This template includes the ready-made dropdown lists and validation

mechanism.
A E C D E F G H 1 ] K
1 Category |Priorty level | Address type|PLC name Device type System tag |User-defined tag |Address  |Index Data Format Enable
2 0[Middle Word Local HiI LW False False 100|null 32-bit Signed Tine
3 1|Low Bit Local HMI LE-9009 True False 9009|IDX 5 16-bit BCD: v [se
4 33-bit BCD
g 16-bit Unsigned
16-bit Singed
6 33-it nsigned
32-bit Signed
7 32-bit Float

@ Note

B [System tag] and [User-defined tag] cannot be set to true simultaneously, otherwise, the

system will view the User-defined tag to be a System tag, and [User-defined tag] to be

false. If setting [Device type] to [User-defined tag], please set [System tag] to false.

B When setting [User-defined tag] to true, if the system compares the [Device type] with

the user-defined tag in the system, and no suitable tag is found, the system will set the

[User-defined tag] in event log to false

B [Color] format is R:G:B, each should be an integer form 0 to 255.

B Before importing Label Library / Sound Library, please make sure the library names exist in
the system.

7.2.4, Quick View of Errors

When compiling the project, the errors in Event Log will be displayed in the Compile window.

To open Event Log and view the errors, double click on the item in the Compile window.
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Compile

Project name :

CAEMTP1.emtp

EX08B file name :

C:\EMTP1.exob

EXOB password = (used in decompiler)

Select the languages used on the HMI

Startup language after redownloading the project : | Language 1 -

|| Decompilation is prohibited
[~ Disable HMI upload function

[¥] Language 1 [¥] Language 2

R

mrorie
Event (Alarm) Log 1 (Category 1)
Event (Alarm) Log 1 (Category 1)
Event (Alrm) Log 2 (Category 1)
Event (Alarm) Log 2 (Category 1)
Event (Alarm) Log 3 (Category 1)
Event (Alrm) Log 3 (Category 1)
Event (Alarm) Log 4 (Category 1)
Event (Alarm) Log 4 (Category 1)

: PLC name undefined (Rockwell DF1}
: incorrect device type
: PLC name undefined (Rockwell DF1}
: incorrect device type
: PLC name undefined (Rockwel DF1)
: incorrect device type
: PLC name undefined (Rockwel DF1)
: incorrect device type

[

Double click error massages to modify the attributes of relative objects!

Compile ] [ Font Management... ] Build font files

7.3. Creating a New Event Log

General Tab

Click [New] in the [Event (Alarm) Log] dialog box.
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Event (Alarm) Log @
General | Message | Statistios
Category : [U:Categoryﬂ v] Subcategory
Priority level : [Low v
Delay time for event monitoring when HMI resets :
[¥] Save to history
[¥] Push notification (Easyhccess 2.0)
Type
) Bit @ Word
Read
Device : (Local HMI vJ.<d
Address: [LW v|0 [  [16-bit Unsigned.
Notification
[¥] Enable () SetON @ Set OFF
[ Follow (set ON when event recovered)
Device : [LocalHMI v][ eI«
Address: [LB v 0 [ '
Condition
Enable if value is :
[V] Dymamic condition value
[V Read/Condition vse different sddresses
Condition value
Device : (Local HMI B e
Address: [LW =) ' [6-bit Unsigned
[ oK ] { Cancel ] [ Help ]
Setting Description
Category Select event category, the range is from 0 to 255.
Subcategory Add this Event Log into the subcategories in the category
name mapping table.
Subcategory ==
Subcategory 1
Enable [0: Subcategory 0 ']
Subcategory 2
e [o:subcatgoryo -]
Priority Events in Alarm Bar / Alarm Display are ordered by priority
level level first and then by time.
Save to In Event Log main settings, if [Save to HMI memory] check
history box under [History files] group box is selected, selecting [Save
to history] here determines whether each separate event
should be saved as historical file.
Push When an event occurs, EasyAccess 2.0 push notifications can

be sent to i0S®/Android® devices.

I__| WE!NTEK

EasyBuilder Pro V6.09.02

7-11



7-12

Event Log

notification

(EasyAccess

2.0)

Delay time This feature is used to set the delay time of Event Log after

for e}fce“f‘ HMI reboot, in order to avoid false alarm that occurs upon

:;ﬁ:r'\ glrch‘Ig HMI repoot due tq uniniti_a!ized values. This featu_re is often

resets used with [Dynamic condition value]. The delay time only
occurs once upon HMI reboot.

Read The system reads data from this address to check if the event

address matches the trigger condition.

Notification When enabled, the system will set the specified address ON
or OFF when the event is triggered.
Follow
The notification bit will reset to its original state once the
alarm condition returns to normal. For example, when the
alarm is triggered, the state of the notification bit turns ON.
When the alarm condition returns to normal, and [Follow]
check box is selected, the state of the notification bit turns
OFF.

Condition When [Bit] is selected, Event Log will detect the state of a Bit

address.

When [Word] is selected, Event Log will detect the value of a
Word address to check if it is greater than, less than, or
equals to a specified value. See Example 1 and Example 2.
Dynamic condition value

Allows online change of the comparison value for trigger
condition when the condition is a Word address type. If
[Read/Condition use different addresses] is not selected, the
source of condition value will be the next consecutive address
from [Read address].

Read/Condition use different addresses

Allows selecting the Word address type to be the source of
condition value.
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Example 1
Condition
Ensble ff walveis: [— .| 20

Drynamide condition value

In tolerance © | Ot tolerance © 2

The setting above indicates:
When [Read address] value is greater than or equals to 29 (=30 - 1)
Or less than or equals to 31 (= 30 + 1), the event will be triggered. The trigger condition:
29 < [Read address] value < 31
After the event is triggered, when [Read address] value is greater than 32 (= 30 + 2) or less than
28 (=30 - 2) the system will return to normal condition:
[Read address] value < 28 or [Read address] value > 32

Example 2
Condition
Enableifvalveis: [o  +] 20

Drynamide condition value

In tolerance © | Ot tolerance © 2

The setting above indicates:
When [Read address] value is less than 29 (=30 - 1)
or greater than 31 (= 30 + 1), the event will be triggered. The trigger condition:
[Read address] value < 29 or [Read address] value > 31
After the event is triggered, when [Read address] value is greater than or equals to 28 (=30 - 2)
or less than or equals to 32 (= 30 + 2) the system will return to normal condition:
28 < [Read address] value < 32
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Message Tab

Event (Alarm) Log

[ General | Message | Statistos |

Text
Content :

Use label libraxy
[V] Use string table

String ID
[V] Dymamic

I Label Library...

String Table...

)

Section : [[1[);000]

z)

[¥] Record string ID

Device : [Local HMI

|

jcey

Address: LW v |0

cob . ()
Font : | Arial [Arial] [Droid Sans]
* Font from [Language & Font] settings
Acknowled ge valve for Event/filarm Display object
Acknowledge valve : 11

Sound
[ Ensble

Sound Library

Addresses of WATCHI ~ WATCHS

[I6-bit Unsigned

Swntax...

Bk Colr:

] I Cancel

J|

Help

Setting

Description

Content

The text content displayed in [Alarm Bar], [Alarm Display],

and [Event Display] objects. Use the formats in the

following two examples of WATCH addresses to use

register data in content. The content in Label Tag Library

and String Table can be used in the Event Log message.

String ID

[Event Display] and [Alarm Display] objects display

messages according to the String ID in the designated

register.
Record String ID

With this option selected, when an event occurs, the

string’s ID number will be recorded. Message of the event
triggered before can be retained.

Font / Color /
Background

The font / color / background color can be set respectively
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color

for each event. The font and color settings determine how
[Alarm Bar] shows the text, while The font, color, and
background color settings determine how [Alarm Display]
and [Event Display] show the text. These settings are not

available in the [Event Display] under History mode.

Write value for
Event/Alarm
Display object

When an event in the [Event Display] or [Alarm Display]
object is acknowledged, the acknowledge value is written
to the specified [Acknowledge] address. This feature can
be used with an Indirect Window object’s read address so
that when the acknowledge value is written, a window
pops up as a prompt about how to handle the alarm. As
illustrated below, when an event is selected and the
acknowledge value is set to 11, window 11 will pop up,
displaying the alarm handling prompt.

7 11:Window_011

SRR T
|Trigger time Message D s - Ty ve———
{ { Dascription
13:12:36 WARNING ‘ =4 [—4 N
————
VO ——

¥

= Click the icon to download the demo project. Please
confirm your internet connection before downloading the

demo project.

Sound

Sound

[V] Ensble Sound Library... | Beep

Continuous beep : | Disable continuous beep . ’
Disable continuous beep
Enable continuous beep until recovered

Enable continuous beep mntil acknowled ged
Enable continuous beep until acknowled ged or recovered

If enabled, the selected sound will be played when an
event is triggered. Continuous beep can also be enabled,
which only stops when the event is acknowledged or
recovered.
For continuous beep, a delay time can be set between
triggering the alarm and the start of beeping.

[aomomesged

[evn] _| L]

User defined |

Sound I I I |

e
10 seconds| |The time interval for beep sound
is once in each second
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¥

= Click the icon to download the demo project. Please
confirm your internet connection before downloading the
demo project.

Address of
WATCH1~8

Users can set how the value is displayed in the designated
watch address when an event occurs. Up to 8 watch
addresses can be used simultaneously. Click [Syntax] to
see how to use the syntax to embed device data in the
content of an event log displayed in the watch address.
ni'.- Click the icon to download the demo project. Please
confirm your internet connection before downloading the

demo project.

e-Mail Tab

Please enable this function in [System Parameter Settings] » [e-Mail] first.

Event (Alarm) Log

| General I Message | e-Mail |Oocurrenoe|

(=]

Enable Condition
Send when event triggered
» Send when event cleared

Recipients

Group A

Subject

]

Message

Opening :

]

Ending :

]

Use label librar

Use label librar

Recipients

Giroup &

Use event content as subject

v

v

[ As recipients of triggered mail settings

Subject : | Tank level low. level=":(WATCH1)d.0

3

Label Library...

] [Language 1

] [ Cancel

Setting

Description

Recipients

Select the [To], [Cc], and [Bcc] recipients.

Subject

Enter the subject of the e-mail.

Message

Enter the [Opening] and [Ending] content of an e-mail.

I__| WE!NTEK

EasyBuilder Pro V6.09.02

7-16


https://dl.weintek.com/public/MT8000/Project/Part_Sample/Continue_Beep.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Alarm_Event_Display_Watch.zip

Event Log

Attach If the [Contains a screenshot of window] check box is
selected, the screenshot of the selected window will be
attached.

0 Note

B The priority level of an event determines its importance in e-mail delivery.

Event Priority Level Email Importance
Emergency High
High / Normal Normal
Low Low
Statistics Tab
Event (Alarm) Log \#33 ‘

| General l Message | Statistics ‘

Occurrence read and reset address

[7] Enable
PLC : Local HMI v |[ Settings..
Lddress : [LW +|0 i 16-bit Unsigned

Elapsed time read and reset address

(7] Enable
PLC : [Local HMI v | Settings...
Address: (L v|0 [16-bit Unsigned
Unit of elapsed time : second
Setting Description
Occurrence If enabled, the number of occurrence of the event after
read and reset HMI startup will be written to the designated word
address address. The word address can be read / written.
Elapsed time If enabled, from an event occurs to its recovery, the

elapsed time (in seconds) will be written to the
designated word address. The word address can be read /
written.

read and reset
address

!.a Click the icon to download the demo project. Please confirm your internet

connection before downloading the demo project.
Security Tab

With security settings enabled, an address and a condition can be set so that an event is

recorded only when the state of the specified address meets the preset condition.
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Event (Alarm) Log IEI

| eneral I Message | Statis‘lics| Security |

Enable/Disable
sz register statusivalue

Divice  (Local HMI | e )
Address : M 101
Enable if bitis :

Setting Description

Use register With this option enabled, an event will be recorded only
when the state of the specified address meets the preset
condition.

status/value

0 Note

B When an event is triggered with the security settings enabled, the event can be

acknowledged on Event Display or Alarm Display even when the security settings are
disabled after the event is triggered.
B With security settings enabled, the event’s address will not communicate with the device

if the preset condition is not met.
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8. Data Sampling

This chapter explains how to set and use Data Sampling.

8.1.
8.2.
8.3.
8.4.
8.5.

OVBIVIBW ...ttt ee ettt e e e e ettt et e e e e e sttt e e e e e e s e anbe et eeeeeesesanssseeeeeeeeessannnrnenaeaeens 8-2
Data Sampling ManagemENt .......cciii i i e e e e e e e rer e e e e e e e e 8-2
Creating a New Data SampPling .......ueieiieiiiiicceeee ettt e e e et e e 8-2
Synchronizing cMT Viewer data and Saving to External Device.......cccoovveveeeieicnnneee. 8-15
Checking History Data of a Specific Date on cMT VIieWEr. ........cceeevivieeeeiiieee e, 8-15
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8.1. Overview

After defining how the data is sampled, by sampling time, address, or data length, the sampled
data can be saved to the designated location, such as HMI memory, SD card, or USB disk. Trend

Display and History Data Display objects can be used to display sampling records.

8.2. Data Sampling Management

Create a new Data Sampling object first by the following steps:
1. From the menu select [Data/History] and click [Data Sampling].

2. Click [New] to finish relevant settings.

No. | Description | Read address Sample mode | Trigger address | Control address | History file | Synchronous
Local HMI: LW-0 | Periodical Disable Local HMI: LWO | Disable

< LIRS »

[ New. ][ Deete | setings.. | [ EBpot. [ impot. |
[ Copy | Pate | Paste (Add Mode)

I

8.3. Creating a New Data Sampling

The following introduces how to set a new Data Sampling.
eMT, iE, XE, mTV, iP Series
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Comment :

Sampling mode

Read address

Data Sampling Object

| High priority (this may reduce refresh rate of screen components.) [C]Enable

@) Time-based 2 Trigger-based

Sampling tme interval : | 1 second(s) -

PLC name : [Local HMI -

Clear real-time data address

Hold address
[ Enable

PLC name : ILU@' HMI

-J[ Settings... |

History files

Address : |Lw x|0
Save to HMI memory

=1 prior to display or store the data log, you can use the conversion tag to check and [T save to USE disk

modify the data log.

Each fil ts of all ds of a d

=When the Data record is converted by the user-defined conversion tag, the RSSO e SR

GetCnvTagArraryIndex() function of [Read conversion] subroutine can get the relative *) Customized file handling

array index.
Data Record Folder name : Datalog

Max. data records (real-time mode) 1 1000 [F] Auto. stop File name example : | 20150727.dt
Data Format ... Datalength : 1word(s) Preservation limit 7 day(s)
ok || cancel

Sampling mode

High priority

Data sampling processes with this feature enabled will be
prioritized. Please note that too many priorities can slow
down update rate of other objects.

Time-based

Samples data in a fixed frequency. The [Sampling time
interval] can be set from “0.1 second(s) to 120 mins”.
Trigger-based

Triggers data sampling by the status of a designated bit
address.

Mode Conditions to trigger Data Sampling:

[OFF -> ON] Triggers sampling when the status of the
address changes from OFF to ON.

[ON -> OFF] Triggers sampling when the status of the
address changes from ON to OFF.

[OFF <-> ON] Triggers sampling when the status of the
address changes.

Set ON/OFF after triggered

If selected, after triggering Data Sampling, the system will
set the designated bit address back to ON/OFF state.

Read address

Specify an address to be the source of Data Sampling. To
convert a data record, please use a user-defined
conversion tag that allows [Read conversion]. For array
addresses, the GetCnvTagArraylndex function can get the

relative array index and then calculate.
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Data Record

(Real-time)

In Real-time Mode, when [Auto. stop] is not selected, the
max. number of data records can be saved on HMl is
86400. When the number of records exceeds 86400, the
earliest data will be deleted.

Data Format

Data of different formats in consecutive registers can be
sampled. For example, setting: LW-0 (16-bit Unsigned),
LW-1 (32-bit Float), and LW-3 (16-bit Unsigned). The

upper limit for the number of records is 1000.

Data Format

1. "16bit Unsigned" 16-bit Unsigned
2. "32bit Float” 32bit Foat
signed" signed

[

[ MNew... ][ Delete ][ Settings... ][ Import.. ][ Export... ]

*When the [Read address] uses an user-defined conversion tag, it is suggested that each
item of the Data Record selects the same data length even in different data types. ..
16-bit BCD, 16-bit Signed. 16-bit Unsigned)

Auto. stop
Data sampling will automatically stop when the number

of records reaches [Max. data records].

C?See “8.3.1 Demonstration of Auto. stop”.

Clear real-time

data address

Set when the bit address status changes from [OFF -> ON]
or [ON -> OFF], clear the sampled data in Trend Display

Real-time Mode. The number of data records returns zero
but the data records that are already saved as history files

will not be cleared.

Hold address

If the status of the designated address is set ON or OFF,
sampling will be paused until the status of the designated

address returns.

History files

Save to HMI memory

Saves Data Sampling to HMI every 10 seconds. Or, use
system register [LB-9034] to force storing data. See
details on the restrictions of using LB-9034 in the Note
below.

Save to SD card / USB disk

Saves Data Sampling to the specified external device.
Each file consists of all records of a day
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%4

The data sampling file will be saved on a daily basis into
the specified folder, and the file name will be
yyyymmdd.dtl, indicating the date of the file.

Folder name

Specify Data Sampling file name which must be all in
ASCII characters. The folder name will be written as:
[Storage Location] \ [Folder Name] \ [File Name]
Preservation limit

Determines the number of data sampling files to be
preserved. Please note that the current .dtl file is not
included in this limit. That is, if this limit is set to 2, apart

from the current file, two latest files will be preserved.

Customized file This feature can be used to customize naming and
handling management of data sampling files (*dtl).

C?See “8.3.2 Customized File Handling”.

Note

A Data Sampling may include more than one type of records. Data Sampling can retrieve
different types of records at the same time. For example, if define three types of data, 4
words in total, the system retrieves a 4-word data each time from the designated address to
be the content in one Data Sampling.
When using [Each file consists of all records of a day] and set [Preservation limit] to 2 files,
the data of yesterday and the day before yesterday will be kept. Data that is not built in this
period will be deleted to prevent the storage space from running out.
When using [Customized file handling] and set [Preservation limit] to 2 files, not only the
currently sampled file, another 2 newest files (3 files in total) will be kept. The rest of the
data will be deleted to prevent the storage space from running out.
When running simulation on PC, all data sampling will be saved to the datalog folder in
C:\EBPro\[Storage Location]\datalog. If you change the data format of data sampling, delete
the previous data records in the installation directory to prevent the system from reading
the old records.
When saving files to USB disk or SD card, the capacity of a FAT32 folder depends on the
length of the file names. Fewer files can be saved when the file names are longer.
When using LB-9034, the shortest interval between two successful executions is 2 seconds.
hat is, after LB-9034 is triggered, it can be effective again 2 seconds later.
Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
cMT, cMT X Series

The settings are almost similar to eMT, iE, XE, mTV, iP Series. The following highlights the

settings that are different.
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Data Sampling Object

Comment ;

Sampling mode

() Time-based

|| High prierity {this may reduce refresh rate of screen components.)

(@ Trigger-based

Mode @ | OFF->0N -

History file
Enable

@ All records in one file

[ 5et OFF after sampling finished (7 Customized file handling

Device : [Local HMI

File name : o000

e

Address : |LB
Data Record

Device :  Local HMI

Save to

() HMI memary (10000 limited) () HMI memory (until space full)

(@) USE disk 1 (7 USE disk 2
Data length : 1 word(s)
Sync. to database
Hold control
/| Enable
Database : |1, 192.168.1.0 -
Device : [Local HMI -G ]
Address @ |LB i} FEEEE
(@) USE disk 1 (7 Database
Control
V| Enabl
nabie [#] Preservation limit (1 ~65535 days) 7 day(s)
ice : ) —
Device : [Local HMI e ][ J Auto sync. periodically 30 minute(s)
Add = [i} 16-bit Unsigned
ress: | il Enable status address
*Control command : 1 [clear]
2 [sync] USB Sync. status : Lw-1
3 [sync. and dear] .
4 [dear and restore log index] USE Sync. error : Liv-2
5 [recover freeze state] Datzbase Sync. status : Lw-3
7 [deletz oldest data]
Database Sync. error : L4
Setting Description

Data Record

Data of different formats can be sampled. The upper limit for
the number of records is 1000. Click the [Settings...] button to
set the read addresses of different data types. For selected PLC
drivers, sampling addresses of different sections is possible. For
the drivers that can only sample contiguous addresses, simply
set the data types. The display format settings may be used by
Trend Displays and History Data Displays which are set to
display the sampled data.

Next contiguous address

With this option selected when adding a new item, simply set
the data type and it will be put into the same section as the
previous read address. The following setting aims to read
LW-0~LW-17 at a time.
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Data
Device : | Local HMI 5.0 ]
Section Description Read address Data type Size
1 16-bit Unsigned 16-bit Unsigned 1 word(s)
2 16-bit Signed 16-bit Signed 1 word(s)
31 32-bit Signed  LW-0 32-bitSigned 2 word(s)
4 32-bit Float 32-bit Float 2 word(s)
5 String String 11 word(s)

s
1

=

*When the [Read address] uses a user-defined conversion tag, it is suggested that each item have the same data
length. (Their data types can still be different, i.e. 16-bit BCD, 16-bit Signed, 16-bit Unsigned.)

Exit
When [Next contiguous address] option is not selected,
multiple addresses can be read at a time.
Data =S
Device : | Siemens 57-1200/57-1500 ']
Section Description Read address Data type Size

11 16-bit Signed INT-PLC.Blocks... 16-bit Signed 1 word(s)

22 16-bit Signed INT-PLC.Blocks... 16-bit Signed 1 word(s) E]

3 16-bit Signed 16-bit Signed 1 word(s) @

3 INT-PLC.Blocks...

4 16-bit Signed 16-bit Signed 1 word(s)

54 32-bit Float REAL-PLC.Bloc... 32-bit Float 2 word(s)

65 String STRING-PLC.BL... String 11 word(s)

*When the [Read address] uses a user-defined conversion tag, it is suggested that each item have the same data
length, [Their data types can still be different, i.e, 16-bit BCD, 16-bit Signed, 16-bit Unsigned.}

* As multi-read capability varies among devices, it is possible for different sections to be sampled at slightly different
times.

Click [New] and de-select [Next contiguous address] option.
The address setting shows, and a different address can be
selected.

[\& WEINTEK
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Channel

Description © 16-bit Signed

[C{Next contiguous address!
Address

Device : | Siemens 57-1200/57-1500

Tag: [PLC.B\om‘DaE_black_Z.a

v]INT

Data type [lﬁ-blt Signed

Display format : [ Leading zero

Right of decimal Pt.: 0

Save to default

Please note that when contiguous address setting is used for

a tag-based PLC driver, only one-dimensional arrays are

supported.
Control Entering a value in the control address sends the
address corresponding command.

Value | Command

1 Clear the sampled data in HMI.
2 Synchronize data to the external device / database.
3 Synchronize data to the external device / database

and then clear the sampled data in HMI.

4 Use the history data stored in USB disk / SD card /
database after changing HMI.

there’s free space.

5 As data sampling stops when HMI storage is full, this

command allows restarting of data sampling when

6 Free up memory space reserved for data logs (*.db).
This command can be used when historical data is

saved to HMI memory (until space full).

7 Delete the oldest data (*.db).
Status & Error When LW-n is used as the control address, the four
address consecutive addresses following LW-n (LW-n+1~LW-n+4) will

show status and error, please see the prompt in the settings

dialog box.
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Histaory file
Enable

Name: Datalog

|:| Sync, to SD card

Status: LW-10 + 1
Error: LW-10 + 2

Sync to database
Enable

Enable status address

[¥] sync. to USB disk

Display history from database

Database: [1,192.168.1.0

Status: LW-10 =3
Error: LW-10 = 4

Value | Status address: LW-n+1 and LW-n+3

0 Disconnected from external device or database

1 Connecting with external device or database

2 Connected with external device or database

3 Storing records into the archive. When this is done,
the value returns to 2.

Value | Error address: LW-n+2 and LW-n+4

0 None

1 Unknown error

2 Failed to connect with external device or database

3 Access denied

4 Wrong database name

5 Inconsistent data format

6 Failed to open table

7 Failed to create table

8 Failed to write table

9 Failed to open database

10 Database is corrupted

11 The Row ID from the external device is inconsistent
with the internal Row ID.

History files History data can be saved to HMI memory (10000 limited or

until space full), USB disk, SD card, and Database (by

synchronizing history data to database server.).

The rules of saving the data are:
® When [Save to HMI memory (10000 limited)] is selected
and the sampled data reaches 10000 records, the

system will delete the earliest 1000 records and keep on

saving data to HMI memory.
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® When [Save to HMI memory (until space full)] is
selected, the system will keep on saving data to HMI
memory, in this case, the data may not be synchronized
to database server. When the HMI memory storage is
full, the system will delete the earliest 1000 records and
keep on saving data to HMI memory.

® When USB disk or SD card is selected, and the number
of records reaches 10000, the system will automatically
save the sampled data to the external device and delete
the earliest 1000 records on HMI.

® To synchronize the data to database server, select a
database that has been configured before.

C?See synchronization rules in “8.4 Synchronizing cMT

Viewer data and Saving to External Device”.

&

See Database Server usage in “13.44 Database Server”.

Customized file
handling

This feature can be used to customize naming and

management of data sampling files (*db). The current *db

file is saved in HMI memory. Please note the following two

points when Sync. Destination is USB disk / SD card:

1. When *db file name changes, the *.db file with the
former name will be synchronized to USB disk / SD card.

2. If anew *db file is generated when there’s no existing
USB disk / SD card on HMI, the earlier *db file will be
deleted. For example, if 20161218.db is the current file,
when 20161219.db is generated and no external device is
inserted to HMI, and then 20161218.db will be deleted.
When [Customized file handling] is used, enabling [Sync.

to database] is not possible.

&

“8.3.2 Customized File Handling”.

Find Customized File Handling settings dialog box in

Auto sync.
periodically

Data will be automatically synchronized to the designated
external device in the specified time interval, regardless of
the rules explained above. Please note that the timer will
reset when a control address is used.

[:)?See “8.4 Synchronizing cMT Viewer data and Saving to

External Device or Database Server”.
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All record in

one file

When Sync. Destination is USB disk / SD card, the
preservation limit is 1 to 65535 days.

Customized file
handling

When Sync. Destination is USB disk / SD card, the
preservation limit is 1 to 65535 files.

When Sync. Destination is HMI memory, the preservation
limit is 1 to 1000 files.

History source

Data can be read from USB disk, SD card, or Database.

8.3.1. Demonstration of Auto. stop

This feature depends on the arrangement of different objects and modes. (Set [Max. data

records] to n.)

Object

[Auto. stop] not selected [Auto. stop] selected

Trend Display-
Real time

Deletes the earlier
records and displays the
latest number of records
(n) in Trend Display. See
the following figure.

Stops after reaching the
specified number of
data records (n).

Trend Display-
Historical

Keeps on sampling data Stops after reaching the

and displays all history
data in Trend Display.

specified number of
data records (n).

History Data
Display

Keeps on sampling data
and displays all history
data in History Data
Display.

Stops after reaching the
specified number of
data records (n).

Data Sampling

Keeps on sampling new

Stops after reaching the

data. specified number of
data records (n).

The figure illustrates how the data is sampled in Trend Display — Real Time mode when [Auto.

stop check] box is not selected. Set the number of data records to 10, when the 11t data is

generated, the earliest record is deleted and the newest record is added.

L—| WE!NTEK

EasyBuilder Pro V6.09.02

8-11



Data Sampling

Record Not selecting
Number Data [Auto. stop]
1 101 102
2 102 103
3 103 104
4 104 105
5 105 106
6 106 b 107
7 107 108
8 108 109
9 109 110
10 110 111

11 111

8.3.2, Customized File Handling

This feature can be used to customize naming and management of data sampling files (*.dtl,

*db).

I__| WE!NTEK

Customized Filename Handling

File creation
() Automatic mode {A new file will be created when the file name is changed.)
(@) Trigger mode (Use the trigger method to create a new file.)
Trigger method

Limit by number of data records
Max. data recordsina file : 1000

Register status
Mode : | OFF->0N » | [|Set OFF after triggered

Device : [Loml HMI v][ o ]

Address : |LB |1
File name

Dynamic format

Device : [Local HMI LG &
Address @ [Lw w1 10 word(s)

* Please configure the value of [Dynamic format] before any data sampling.
*Only ASCII is available. Unicode is not supported.

%Y Year (2000-2038)

By ‘Year, last two digits (00-99)

e Month as a dedmal number (01-12)
oed Day of the month (01-31)

W Week number (00-53)

S Weekday, 0is Sunday {(0-6)

eH Hour in 24h format (00-23)

%M Minute (00-53)

%S Second (00-59)

%% %

* A filename cannot contain any of the following characters: \/: *?< = |

Sort

Order : |File modification tme | This option may affect performance.

EasyBuilder Pro V6.09.02
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Setting

Description

File creation

Automatic mode

A new file will be created when the name of an existing
file is changed.

Trigger mode

A new file will be created according to the [Trigger
method] settings.

Trigger method

Limit by number of data records

A new file will be created when the number of data
sampling records reaches the specified "Max. data
records in a file"

Register status

A new file will be created when the status of a designated
bit address meets the specified condition. The condition
is specified in Mode field.

Set ON/OFF after triggered

If selected, after the new file is created, the system will
set the designated bit address back to ON/OFF state.
Following HMI reboot, generate and write to a new file
only after trigger condition has been met.

When the trigger condition has not been met following
HMI reboot and therefore no new file is generated, the
new data will be written to the last file generated before
HMI is rebooted. Downloading a new project to HMI is

the same as rebooting HMI.

File name

The file name can be an alphanumeric name, and certain
half-width symbols are allowed. The file name can also be
specified by a file name syntax.

Dynamic format

The file names can be set by a designated word address,
or by a file name syntax indicating the current system
time. The file name syntax can be specified by selecting
time buttons or entering the syntax in Format field. The
length limit is from 1 to 25.

The following half-width characters are not allowed:
\/:*¥?“<>|

Sort

This setting affects how the system determines the sort
order of historical files, which affects the file preservation
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and backup logic.

File name

Files are sorted by their filenames in descending order.
File modification time

Files are sorted by the actual timestamps of the contents.
(Because the system has to check the content of the files,
this option may affect performance negatively.)

Example:

Consider the case where files have been generated in this
order: filename_05--> filename_04--> filename_03-->
filename_02--> filename_01. The earliest file is
filename_05 and the latest file is filename_01.

With preservation limit set to 5 files, the two sorting
methods yield different results when the 6™ file is
generated:

Sorted by Filename: filename_05 is seen as the latest file;
therefore, filename_01 will be deleted.

Sorted by File Modification Time: filename_01 is seen as
the latest file; therefore, filename_05 will be deleted.
Note on naming convention:

When File Name is selected as the sorting method and
the filenames are: filename_1, filename_2, and
filename_10, filename_2 will be seen as the latest file,
followed by filename_10 and filename_1. To make
filename_10 the latest file, please zero-pad the numbers
and name the files to: filename_01, filename_02, and

filename_10.

0 Note

B |n Data Record settings, if the option [Next contiguous address] is not selected, the upper
limit for the number of sections is 8.

B [f both [Limit by number of data records] and [Dynamic format] check boxes are selected,
before startup HMI, please enter the name in the designated register for Dynamic Format,
otherwise, it is impossible the reach the “Max. data records in a file”, and the data sampling

file will not be generated.

B When a new file is generated, the system will first detect if the filename already exists. If the
file name does exist, the newly sampled data will be appended to the existing file.

i- Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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8.4. Synchronizing cMT Viewer data and Saving to External Device or Database

History data in external device Real-time data
ﬁ_&H\ /"/7— ——_‘_“‘H: //F_ﬁh\\ /'/r;—,w:‘_x‘:h‘
S . < S ™~
e ~ 7 A >
f//// \\\ 1 \\\ /,/ P ‘/_/ S \ N
;‘// \\\ \ \ Vi / \ .

For other series, when displaying the sampled data in Trend Display object, it is necessary to
select from Real-time mode or History mode and the two modes cannot simultaneously be

displayed in one object.

cMT / cMT X Series allows displaying history data and at the same time updates real-time data

in one Trend Display or History Data Display object. The data saved in the external device can

be updated.
The rule of synchronizing the data saved in the external device:

1. When the sampled data reaches 10000 records, HMI will automatically save data to the

external device and deletes the earliest 1000 records in HMI.

2. If the external device is removed from HMI and inserted back again at the time when the

sampled data is under 9000 records, the data generated during the time the external

device is removed is saved in HMI and is not cleared. If the data exceeds 9000 records

during the time the external device is removed, the earlier data is cleared and cannot be

synchronized even to insert the external device back to the HMI.
3. If there already exists sampled data in the external device, the new data is appended

without overwriting the original data each time in synchronization.
8.5. Checking History Data of a Specific Date / File on cMT Viewer.

To check the history data, see the following steps (Use Trend Display object as example).

1. Tapthe icon in the upper-right corner of the Trend Display object.
2. The following dialog box appears.
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Cancel Option

Begin Date

Ended Date

TREND DISPLAY SETTING

Channel Visibility
Y Scale

Reset to project default

3. Specify the date or the file.

Cancel Option

Begin Date
2016-12-19

Ended Date

2016-12-19

Done

Off

Done

@

@

Cancel

FILE SELECTION
(Current)
20161228_115444
20161219_151520
20161219_151504
20161219_151454
20161219_151444

Option

TREND DISPLAY SETTING

Channel Visibility
Y Scale

Cancel

FILE SELECTION
(Current)
20161228_115444
20161219_151520
20161219_151504
20161219_151454
20161219_151444

4. Tap [Done] button to finish setting.

I__| WE!NTEK
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Done

off

Done
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9. Object General Properties

This chapter explains the basic settings of an object.

9.1.
9.2.
9.3.
9.4.
9.5.
9.6.

OVBIVIBW ...ttt e e ettt e e e e ettt et e e e e e st ettt e e e e e s e anb et e eeeeeese s nsssbeeeeeeeessannnrnenaeaeens 9-2
Selecting PLC and Setting Read/Write AdAress ........ccouveeceeeecieeeciee e 9-2
Using Shape Library and Picture Library......cccccooocoiieeie e 9-3
SEttiNG Label TEXL.cooe i e e e e nna s 9-7
AdJUStING Profile SiZ€ .......eeeeieiieee e e 9-9
Overlapping Objects (CMT / CMT X SEIES) ..ccuireeireeeerieeeieeecree et eeree e e eeaaeeeeaeeeens 9-10
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9.1. Overview

The basic steps to create an object:

1.
2.
3.
4.

Selecting the PLC device and setting the read/write address.

Using Shape Library and Picture Library.

Setting label text.

Adjusting profile size.

This chapter explains the basic settings of an object.

9.2. Selecting PLC and Setting Read/Write Address

Most objects read data from PLC devices, so a properly configured PLC address is needed.

Select the PLC to control at [PLC name] which comes from [System Parameters Settings] »

[Device List].

Write address
PLC name : [Local HMI v] [ Setting... |
Address:’Lw ] IDX 0  [16-bit Unsigned
Address @
PLC name : [L0C3| HMI ']
Device type : [Lw ']
Address: 0 [ system tag
Address format : DDDDD [range : 0 ~ 10799]
5] [ ot
Setting Description
PLC name Select the PLC type.
Device type Different PLCs have different device types.
Address Set the read/write address.
System tag Address tags include [System Tag] and [User-defined Tag].

This option allows users to use [System Tag]. [System Tag]
consists of the preserved addresses by system for
particular purposes. The address tags include bit registers
or word registers (LB or LW).

After selecting [System tag], not only will the [Device type]
field display the chosen tag, but [Address] field will also
display the chosen register.
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Index register

Select this check box to use the [Index Register].

& For more information about System Tag, see “22 System Reserved Words and Bits”.

¢ Q@

9.3. Using Shape Library and Picture Library

For more information about Index Register, see “11 Index Register”.
For more information about Tag Library, see “16 Address Tag Library”.

In the settings dialog box of certain objects, “Shape” tab can be found. In this tab, Shape

Library and Picture Library can be used to add visual effects on objects. Select Shape tab to use

the libraries when creating an object.

9.3.1. Picture

New Bit Lamp/Toggle Switch Object

| General | Security | Shape | Label |

Picture : Flat Button
STYLING_SVG
106x106

More picture libraries...

Picture

[ Picture Library.. | [@]Uss picture
[V] Set to original dimensions

(— v ]

[ Duplicate these attributes to every state

Shape

( Shape Library... | [#]Use shape

T
.
e

Pattern type :

[¥] Tnner

[ Duplicate thess attributes to every state

Select [Use picture] and then click [Picture Library] button to open Picture Manager window

and select a picture from the window.
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EasyBuilder Pro V6.09.02



Object General Properties

Project | Library
[system Flat Button -] !'—“(3]
iSystem Flat Button J
0 1 -
flat Button (Z] Flat Button Z M«
Ftateszz Ftates:z
m' :0 ﬁﬂ m :0 {?i
— o
@) [flatbuton (Z] Flat Button Z)
= = ‘ Export... H Modify... J[— v]
Ftates 5 i Ftata: 2
= — STYLING SVG
fobjects : 0 # fobjects : 0 ) 0 ‘ 106x106 W
3817 bytes
i e T STYLING_SVG
Eteuum }/71 FatBut’con @ 1 . 106x106
) 3651 bytes
S : H —
G- aeaEr~
pes ) CET &
‘ , &
Flat Button 2] Flat Button (2] =
Background: [ | :I [ New | ‘ Delete ] ‘ Clean ‘
More picture libraries.. [ ok J[ cancel [ Hep |
Setting Description
Picture Click [Picture Library] button in Picture group box to open
Library Picture Manager window.
Set to ) ) ) ]
iinal When this checkbox is selected, EasyBuilder will return the
origina . . - . - .
. . picture to its original size to eliminate the redrawing step.
dimensions

Duplicate these
attributes to

every state

This button is available only when a system picture is used.
Clicking this button will duplicate the attributes of the

current picture to other states.

9.3.2, Shape

Select [Use shape] and then click [Shape Library] button to open Shape Manager window and

select a shape from the window.
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Project | Library

[System Frame

-] ([@)®)

iSyshem Frame

|

1 74

) T 2 O

-

faesiz
Fss )

. Inner,Frame

Clean

‘ Delete ] ‘

| ok

J [ concl

Hep |

Setting

Description

Inner

Select [Display] to show the inner color of the shape and

select a color as the inner color by clicking the drop-down

button.

] Default

|
|
(.
|

EEENE
[EENE
EEEN
OJOmnE
OCEEN
OOomnm
EEEN
NN
OOmm

Recent
I [

Custom...

Frame

Select [Display] to show the frame color of the shape and

select a color as the frame color by clicking the drop-down

button.

Pattern color

Click the drop-down button to select a color for the

interior pattern of the shape.

Pattern type

Click the drop-down button to select a pattern.
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|
=

9.3.3.

- IR
m | [
N\
— =l

=

Set to all
states

Duplicate the attributes of the current state to other

states.

In Picture Manager and Shape Manager windows, the currently selected picture / shape is

Shape manager

highlighted yellow as shown below.

Shape manager

Project | Library

[button2

IC:‘EBpro‘Iibrary button2.plb |

2

|5hapeo
States: 2
Objects : 0

Shape2

(Shapel

lShape3

-

—
!

Inner
[¥] Display

Frame

Display

9-6

— —_—
2 3
— :
_L -

States: 2 IStates 12
Objects : 0 @] [onjects 10 0 @
[shapes !Shapes 1 ..@
IStates 12 States: 2 —
® Objects : 0 ) @ [Objects: 0
e —
I i Bropes @ [ 1 Broper 2 -

Lo I

Cancel ] [ Help ]

The information about the selected picture / shape:

Directory  The directory from which EasyBuilder searches for the pictures / shapes.
Shape5 Name of the shape.

States: 2 Number of states of the shape.

Objects: 1 This shape is used by 0 object in the project.

Inner The state 0 and state 1 of this shape contain only “inner” but not “frame.”

C? For more information, see “14 Shape Library and Picture Library”.
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9.4. Setting Label Text

New Bit Lamp/Toggle Switch Object

]GemmllSecuxitylShape ILabe] ‘

Content

[V] Use label
e label library

[ AddtoLabelLibrary |[ LabelLibrary... |

see: e ) W) @@

[ Duplicate this label to every state

Attribute

Text ali

[V] Preview with actual font size

Color :

[7] Tracking

Font: Arial [Arial] [Droid Sans]

Size :

:

Italic [ Underline

Ol

Horizontal : | Centerx
Text area position

Horizontal : | Center
Duplicate these attributes to

II

-

Every state

o] o )

Setting

Description

Use label

Use a label for the object.

Add to Label Library

Add a new label containing the content for all states to the
Label Library.

Use label library

Use a label from the Label Library.

Label Library

View all the labels in the Label Library.
For more information, see “15 Label Tag Library and Multi

Language”.

Content

Set the content of the label. If [Use label library] is
selected, the content in the Label Library can be used.

Duplicate this
label to every
state

Copy the content of the current state to all states.

Tracking

With this option selected, changing the position of the

[\& WEINTEK
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9-8

text in one state will also change the text position in other

states.

Font Select a font from the list. EasyBuilder Pro supports
Windows True-type fonts.

Size Select a font size.

Color Select a font color.

Blink Specify the way the text blinks. Choose [None] to disable
this feature or set the blinking interval to [1 second] or
[0.5 seconds].

el Use Italic font. Ttalic Label

Underline

Underline Label

Use Underline font.

Text Alignment

Multiline text is aligned within the label outline.
Relow are the corresnonding shortcut kevs.

[Left] [Center] [Right]
111 111 111
222222 222222 222222

333333333 333333333 333333333

Text area
position

Multiline text is aligned within the object outline.

Below are the corresponding shortcut keys.

%vﬁy L1|_2L3L45Py L1 12 L3 141

|« Left Alignment Top Alignment

ad

#l¢ Center Alignment Center Alignment

L3
+
%

-#| Right Alignment Bottom Alignment

Horizontal Vertical

Duplicate these
attributes to
every state

Copy the attributes of the current state to all states.

More

Convert labels to bitmap images (Use bitmap font)
Convert the label text into bitmap format. This setting is
only available for non-cMT models.

ON = OFF (use state 0)

The content displayed will not change due to state.
Movement:

Direction

I__| WE!NTEK
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Set the direction of the marquee effect. The directions
include: [No movement], [Left], [Right], [Up], [Down].
Continuous

Specify how the marquee effect is displayed.

If this option is not selected, the next text appears only

when the previous text disappears completely.

If this option is selected, the text will be displayed

continuously.

Speed

Adjust the speed of the text movement.

@ Note

When Text/Comment object is used with Comment enabled, the text used as comment

will not appear on HMI.

When the texts of the fonts used in the editing window and on the HMI screen are not
properly aligned vertically, it is possible to correct it with the FontRules.xml file in
“%appdata%\Weintek\EasyBuilder” folder.

By adding the names of the fonts in question into the FontRules.xml file, their vertical

metrics can be adjusted in advance to avoid the misalignment problem.

=Yuml wverzion="1.0"7=
zFontRkulegs»
=Verzion data="1.1"/=
=Eule data="[‘w]*aleerian[.'w]*"/=

=Eule data="['w]*caztellar[ . \w]*" /=

<Rule data="*Wingding=}"/=

<Rule data="fix vertical metricz = “Gotham FPro Black}"/»

<Enle data="fix wertical metrice = *jotham Pro BoldE"/»

<Enle data="fix wertical metrice = *rotham Prok"/»
=/FontRulez=

9.5. Adjusting Profile Size

When an object is created and placed in the editing screen, double click it and select the

[Profile] tab to adjust the position and size of the object.
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Bit Lamp Object's Properties @
[ General [ Secusity | Shape | Label | Profile |
Position
; X217 = ¥oo208 =
Size
[C1Keep width/height ratio
Width: 50 s Height: 50 z
Width (%) : 100 £ Height (%) : 100 =

Setting Description

Position Pinned
When this check box is selected, the position and the size
of the object cannot be changed.
[X] and [Y]
The coordinates of the position of the object in the editing
screen.

Size Adjust the [width] and [height] of the object.

9.6. Overlapping Objects (cMT / cMT X Series)

The following explains the ways to find the overlapping objects and convert them into a single
Combo Button. After conversion, the general settings of the Combo Button will follow the
settings of the frontmost object.

9.6.1. Enable Touch Area

1. Open View tab and select [Touch Area].

File H ¥ « #» 3 Home Project Object Data/History DoT/Energy RIS

v] Common Window [v] Object Address v| Ruler Address Grid Web Wind

] Underlay Window [v] Object Label Tag v] Grid | Windows Tree Shape

| ObjectID v] Comment v| Snap  [v] Windows Preview [_] Picture

2. All the touchable objects in the proejct will be highlighted in yellow, the overlapping areas
will be highlighted in pink, and the objects that are not touchable will remain the same.

SB_0 (LB-0)
SB_1 (LB-0)
SB_2 (LB-0)
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9.6.2. Find Overlapping Objects

Open Tool tab and click [Find Overlapping Objects] to find all the touchable overlapping
objects in the project.

File H i « » : Home Project Object Data/History lloT/Energy  View I _
—n €= = =
: p B % O D
Find Overlapping Data/Event Log Address Easy Administrator [System Setting] Recipe Database
Objects Com Converter Viewer Watch Tools Editor Editor

Upgrade External

At the first time clicking [Find Overlapping Objects], the system will find the first group of
overlapping objects in the current window. To search for the next group, click this button
again. When all the overlapping objects in the current window are found, the system will
start searching for overlapping objects in the next window, and then open the window in
which overlapping objects are found.

SB_0 (LB-0}
[SB_1 (LB-0)
|SB_2 (LB-0)

0 Note

B All layers of a window must be editable before clicking [Find Overlapping Objects].

9.6.3. Convert to Combo Button

When the overlapping objects found are Set Bit, Toggle Switch, Set Word, Multi-State Switch and
Function Key, they can be converted to a single Combo Button by the following ways.
Way 1. Open Tool tab and click [Convert to Combo Button].

viswer

Fle: E S % + < Home Project Objsct Data/Mistory  lloT/E Comba Button Object's Properties

= +O g O. ;

] g = 010 x | General Security Shape Font  Profile
Find Overlapping | Convertto | Data/Eventlog Address  Easy  Administ e e 54

Objects Combo Buttan Converter Viewer Watch Tool:

Comment

Upgrade Lamp

Windows Tree v X q
-] 3:Monitor Mode ~ a
1 4: Common Window
-1 5: Device Response
1 6: HMI Connection

i~ 1 7 Password Restrict.

— [ 8: Storage Space In..

10 - WINDOW_010 X

) . ;i R HTA, ;. A Tn e

Mode: | None v

1 9: Backup

= [ 10: WINDOW_010
I BL_O (LB-0) (Back)
—BL1(LB-0)
- BL_2(LB-0)
=TS 0(8-0)
= TS_1(LB-0)
=TS 2(18-0)
— SB_O(LB-0)
—SBL1 (LB-1)
L sB_2(L8-2)

= 11

- .
%B_0 (LB-0)
[SB_10B-13

[®e_zB2;

e B M P

Down actions

Action Group 1 Action Group 2

SetBit Toggle, LB-2)
Set Bit (Toggle, LB-1) :|—» [+]
Set Bit (Toggle, LB-0)

[+]

Way 2. Select the overlapping objects together, click the right mouse button, and then select
[Conver to Combo Button].
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Cut

Copy

Muiti. Copy

Paste

Delste

Greup

Unaroup

Convertto Combo Button
Attribute

Security settings

Goto desti window

Jump ta selected shape/picture librariss
SB_D (LB-0) (Rack)
SW.O(LW-0)

FK_D (Front)

Ctl +G

Comba Button Object's Propertics

General Security Shape Font  Profile

Comment

Lamp
Mode:  Norne

Down actions

Action Group 1
Popup Window [70. Login & Log
Set Word (Write constant value : 0.
Set Bit (Set ON, LB-0)

[+)

Action Groug 2

o

9-12

After [Convert to Combo Button] is clicked, a review window shows for users to review the

actions that can be triggered by the Combo Button. Actions that are not highlighted can be

merged; actions that are highlighted in yellow will be automatically adjusted to meet merging

condition; and actions that are highlighted in red cannot be merged. The user can move the

mouse cursor to the yellow or red area to see explanations.

Review your merged actions

Down actions Up actions

(X8

Modify or delete invalid actions.

SW_0

FK_0

Action Group 1

Action Group 2

Unable to convert the objecttoa.. kg [+]

)

Set Word (Write constantvalue: 0., —# o

[+)

Change common window (30.Ke.. —# [+

)

oK

] [ Cancel

@ Note

B The Comment of the generated Combo Button will follow the setting of the frontmost

object that has a Comment.
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B The Security settings of the generated Combo Button will follow the settings of the
frontmost object. If the Security settings of the objects layers down are different from the
frontmost object, an alert is shown after conversion.

B The Sound settings of the generated Combo Button will follow the settings of the
frontmost object that has Sound settings. If the Sound settings of the objects layers down
are different from the frontmost object, an alert is shown after conversion.

B The Picture or Shape, and the Label settings of the generated Combo Button will follow
the settings of the frontmost object that has these settings. When there’s no object using
a picture or a shape, the Combo Button will follow the Label settings of the backmost
object that is mergeable.

B The generated Combo Button will have the Vibration setting enabled if any of the
overlapping objects has Vibration setting enabled.

B The generated Combo Button will follow the Operation Log settings of the overlapping
object that uses Operation Log. When Operation Log is used for multiple overlapping

objects, an alert is shown after conversion.
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10.User Password and Object

Security

This chapter discusses the protection for operations provided by setting up user passwords and

security classes.

10.1.
10.2.
10.3.
10.4.
10.5.
10.6.
10.7.
10.8.
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Enhanced Security Mode and Control Address..........ueeeeeeeeeccciiieeeee e ccccireeee e 10-6
Enhanced Security Mode USQBE .....cccceieiriiiiieee ettt e e e e e e 10-10
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Example of Object Security SEtHiNGS.....cccocvuiiiiiiiiiie e 10-30
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Bulk Changing of Security Settings of Multiple Objects .........ccccovivieeeeiieicciiieeee, 10-34
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10.1. Overview

This chapter discusses the protection for operations provided by setting up user passwords and
security classes. Authentication modes are:

® General Mode

® Enhanced Security Mode

In addition, cMT / cMT X series allows the use of LDAP protocols for user authentication.

To set up the protection system, please:
1. Set user password and operable classes.
2. Set object class for objects.

An object belongs only to one security class. Setting the object class to “None” means any user
can operate this object.

10.2. User Password and Operable Object Classes

The security parameters can be found in [System Parameter Settings] » [Security].

10.2.1. General Mode

Up to 12 sets of user and password are available. A password should be one non-negative
integer. There are six security classes: Ato F.
Once the password is entered, the objects that the user can operate are classified. As shown

below, “User 1” can only operate objects with class A or class C.

0 Note

B General Mode is not used for cMT / cMT X Series.

System Parameter Settings @
|| Cellular Dot Wetwork | 802.1X (WiF) | PrintexiBackup Server | Time Syme/DST [ eMeil | Recips Databose
| Dievice I Model I General I Systern I Eemate | Security Extended Memory

(@) General mode heanced seeurity mode LDAP Editahle

Select operable classes for each vser
Pazzword range ;0 ~ 4294957205

0. Ensble  Passwond
111111

222222

333333

]

1
]
]
]
]

m

H
1
2
3
4
5
6
7
i

IEEEEOEEE

IHEEEEEEE
ID000EEEOE
10000EEEE
100000000
10E0oEEEOE

[ [T ’
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&

4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
10.2.2. Enhanced Security Mode

Up to 11 users can be set here. In addition, [Administrator] setting is provided. Administrator
has all privileges and can operate all object classes. A username can contain Chinese characters,
letters, and numbers, and a password can only contain letters and numbers. Each user can

have up to 12 operable classes: Ato L. (Up to 127 users can be set in Administrator Tools.
Please see “10.4 Enhanced Security Mode Usage” for more details.)

Enhanced Security Mode provides a [Control address] for users to manage the accounts

directly on HMI. Please see “10.3 Enhanced Security Mode and Control Address” for more
details. Alternatively, use USB Security Key to log in automatically. Insert the USB disk in which
the key is saved to log in. Please see “10.4.3 Login / Logout Automatically with USB Security
Key” for more details. Login can also be achieved using fingerprint or RFID. Upon successful
fingerprint recognition or RFID card scanning, the linked account will be automatically logged in,

see “10.4.7 Login / Logout with Plugins” for more details.

System Parameter Settings @
Cellular Data Network ‘ Time Sync./DST | e-Mail | FTP ‘
Device | Model | Genenal | System | Remote | Security Extended Memory |
General mode ©) Enhanced security mode [ External Server... ‘ [ Editable... \
[ Use existing user accounts and administrator settings on HMI first Gf existed). Otherwise, use settings below.
Enable Secret user User name Password Class A ClassB Class *
1 @ dl userl o0 . e M vl |
2 M [ user2 000000 . ® ]
3 i} [ user3 ° . ® =
4 ) (. user4 ° . @ F |
5 B (= user5 ° . @ [ F @]
6 [ ] user6 L] . ® 0
74 [ user7 (1) . ® [
8 | user8 (1] . ® )|
« i )
[ Plugin... ] [ Class Comment... ]
Administrator
|| Secret user User name : |admin
Password : 000000 | E
Control
Device : [Local HMI -Gk
Address : [PLW ] 8950 16-bit Unsigned Usage...
Execute auto.loginflogout when insert an USB key into HMI
["]Enable Sefting i)
CMTP file password
[1Check password when opea CMTP file Setting
| ( Cancel | [ hep |
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@ Note

B In Enhanced Security Mode on a cMT / cMT X model, the Control Address can only be
assigned to a word register of Local HMI. Please note that security features will work only
on HMI when the control address is LW. Remote login on cMT Viewer will not be possible.

B EasyAccess 2.0’s HMI Viewer on a eMT/iE/XE/mTV model doesn’t support Enhance
Security Mode, please use VNC Viewer instead.

B Usernames that contain Chinese characters cannot be changed by using EasyWeb or HMI

system settings; they can only be edited in EasyBuilder Pro.

&

= Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
10.2.3. LDAP Mode

LDAP (Lightweight Directory Access Protocol) enables applications to access Directory server
providing database-like data structure, and here, the primary use of LDAP is to enable
centralized user account management. When using LDAP mode, user account management is
up to the Directory server, with HMI validating user login via the LDAP protocol. To have LDAP
set up on HMI, users only need to provide necessary information about the directory server
and set the operable classes for each group, without the need for managing

username/password for each user.
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LDAP ()
Enable
General Error
Host | 192 . 168 . 1 . 100 | [] use domain name

Port: 389 =
Base DM : DC=testDC=org
Users base DM : CMN=users, DC=test, DC=0rg

Groups base DN :  CN=builtin,DC=test, DC=0rg

Directory type

* LDAP is only supported on Active Directory

Group Mame ClassA ClassB ClassC ClassD ClassE ClassF Class G ClassH Class] (
1 Engineer " " "
2 Management v v v v v v v v v
’;ISales %
4| [l 3
’ New... ] ’ Delete ] [Import from Server
ok || cancel

10.2.4. Remote HMI Mode

In this mode, user accounts can be managed on a remote HMI, instead of the local HMI. The

accounts on a remote HMI can be used to log in the local HMI; therefore, managing the

accounts on the local HMI is not necessary.
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External server @

) Mone ) LDAP @ Remote HMI
General
Remote HMIIP: 132 . 168 . 2 . 158 |
Result address
Device : [Local HMI

Address : |pLW 0 16-hit Unsigned

Result address PLW-0
1: Succeeds

8: Account not exists
16: Password error

1024 : Remote HMI cannot be connected

10.3. Enhanced Security Mode and Control Address

The control address is used for login and account management, with 20 consecutive addresses
designated for parameter settings. When employing a cMT/cMT X Series model, LW and PLW
registers are available for selection. LW refers to local addresses on the HMI itself, while PLW
refers to addresses on the client side, such as cMT-iV5, cMT-iV6, iOS, and Android devices. As
each cMT/cMT X series can connect to multiple client devices, the system registers for login
and account management operate independently on each client device.

To log in using the control address, select either [user name] or [user index]. Ensure to set

[user name] and [password] in advance under [System Parameter Settings] » [Security] »
[Enhanced security mode].

10.3.1. Control Address Settings

When control address is set to LW/PLW-n, where n is an arbitrary number, the following
addresses will be designated:

Address Tag Name Description

LW/PLW-n (1 word) command Commands to be executed: Login, Logout,
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Add/Setting/Delete Accounts, etc.

LW/PLW-n + 1 (1 command Displays the result of command
word) execution execution.
result

LW/PLW-n + 2 (1 user index The index of accounts (used with Option
word) List Object).
LW/PLW-n + 3 (1 user Binary value. Level A = bit0, Level B =
word) privilege bitl, ...
LW/PLW-n + 4 (8 user name Account name (Case-sensitive and only
words) allows Chinese characters, letters and

numbers).
LW/PLW-n + 12 (8 password Account password (Case-sensitive and

words)

only allows letters, numbers, or special
characters).

After setting the [Control address], the relevant addresses can be found in [Address Tag Library]
» [User-defined tags].For example, setting [Control address] to LW/PLW-0: (UAC stands for User

Account Control)
LW/PLW-0 = [UAC command]

LW/PLW-1 - [UAC command execution result]
LW/PLW-2 - [UAC user index]

LW/PLW-3 - [UAC user privilege]

LW/PLW-4 ~ LW/PLW-11 - [UAC user name]
LW/PLW-12 ~ LW/PLW-20 - [UAC password]

0 Note

B In Enhanced Security Mode on a cMT / cMT X model, the Control Address can only be

assigned to a word register of Local HMI. Please note that security features will work only

on HMI when the control address is LW. Remote login on cMT Viewer will not be possible.

B EasyAccess 2.0’s HMI Viewer on a eMT/iE/XE/mTV model doesn’t support Enhance

Security Mode, please use VNC Viewer instead.

10.3.2. Commands

Setting different values in LW-n [command] enables different commands:

Set Value Command

Corresponding Address

1 Log in by user name

Set [user name] and [password] first. After
entering the user name and password, the
system will check if they are valid in
[System Parameter Settings] » [Security] »
[Enhanced security mode].

2 Log in by user index

Set [user index] and [password] first.
Please refer to 10.4.4 Enhanced Security
Mode with Option List Object.
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3 Log out

Change the password
of current logged-in

Set [user name] and [password] first.
Please fill in the original password in [user

user name] and new password in [password].
5 Add an account Set [user name], [password] and [user
privilege] first.
6 Add a temporary Set [user name], [password], [user

account (minutes)

privilege], and [user index] first. [user
index] is for specifying a time period (in
minutes), within this period the account is
valid. If O is specified, this account stays
valid until the HMI is powered off.

7 Delete an existing Set [user name] first.
account by user
name
8 Delete an existing Set [user index] first.
account by user index
9 Setting the privilege Set [user name] and [user privilege] first.

of an existing account
by user name

10 Setting the privilege
of an existing account
by user index

Set [user index] and [user privilege] first.

11 Setting the password
of an existing account
by user name

Set [user name] and [password] first.

12 Setting the password
of an existing account
by user index

Set [user index] and [password] first.

13 Read the privilege of
an existing account
by user name

Set [user name] first. If the command
succeeds, [user privilege] can be displayed.

14 Read the privilege of
an existing account
by user index

Set [user index] first. If the command
succeeds, [user privilege] can be displayed.

15 Add a temporary
account (days)

Set [user name], [password], [user
privilege], and [user index] first. [user
index] is for specifying a time period
(number of days), within this period the
account is valid. If O is specified, this
account stays valid until the HMI is
powered off.

16 Add an expiring
account (minutes)

Set [user name], [password], [user
privilege], and [user index] first. [user
index] is for specifying a time period (in
minutes), within this period the account is
valid. 0 is an invalid value for this setting.

17 Add an expiring

Set [user name], [password], [user
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account (days) privilege], and [user index] first. [user
index] is for specifying a time period
(number of days), within this period the
account is valid. O is an invalid value for this

setting.
18 Remaining minutes Set [user name] first. If succeeded, the
for user name remaining time (in minutes) will be
displayed in [user index].
19 Remaining minutes Set [user index] first. If succeeded, the
for user index remaining time (in minutes) will be
displayed in [user index].
20 Remaining days for Set [user name] first. If succeeded, the
user name remaining time (number of days) will be
displayed in [user index].
21 Remaining days for Set [user index] first. If succeeded, the
user index remaining time (number of days) will be

displayed in [user index].

0 Note

B Add atemporary account / expiring account: The difference between temporary accounts
and expiring accounts is that temporary accounts are not stored in the system and will be
invalid after HMI is turned off. Both temporary accounts and expiring accounts will be
automatically deleted when they are expired.

B Delete the existing account: The currently logged in account cannot be deleted.

B Offline/Online Simulation: Simulate using the account settings in the program. Any
modifications of the account during simulation will not be reserved for next simulation.

B admin: Default administrator account, cannot be deleted, has all privileges and cannot be
changed.

B System Register PLW-10754: Displays current user name. (Only available for cMT / cMT X
Series)

B The [user privilege] address does not display the privileges assigned to current user
account, please use system register LW-9222 to display the privileges.

B LDAP mode does not support login with [user index].

El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

10.3.3. Command Execution Results

After the command is executed, the system will store the result code to control address LW-n +

1. The listed result codes below are shown in hexadecimal format.

Result Codes Command execution result

(0x001) Succeeds
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(0x002) Invalid command

(0x004) Account exists (when adding a new account)

(0x008) Account not exists

(0x010) Password error

(0x020) Deny command

(0x040) Invalid name

(0x080) Invalid password character exists

(0x100) Invalid import data

(0x200) Out of validity range (when log in by USB Security Key).

The [Effective Time] can be set in Administrator Tools.

@ Note

B Users can add a new event in Event (Alarm) Log, and designate the [Read address] to LW-n

+ 1 [command execution result]. Open [Message] tab » [Text] » [Content] and specify the

message to be displayed in Event Display Object for showing command execution result.

10.4. Enhanced Security Mode Usage

10.4.1. Importing User Accounts

The user accounts can be set using other tools we provide, apart from the settings in [System

Parameter Settings] » [Security] tab. Administrator Tools can also be used to set user accounts.

Administrator Tools can be found in the installation directory. After the program starts, select

the [User Accounts] check box. Up to 127 accounts can be added.
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[ Administrator Tools @
Save Contents of the TSE data
» lE ntz
=} 3B Security Key
= e-Mail SMTP Server Sethngs
=} e-Madl Contacts
User Account Settings
Mo, Becret  User naime Paszwond Class & ClazB Class C Class D ClaE Class F Clas
1 [[]  oo1001 001001 =] ] ] [} L |
2 [[]  o0z002 002002 ] [} [} L I
3 [ 003003 003003 =] =] =] =] =] |
4 ] 004004 004004 [} =] ] ] |
(3] [C] 005005 005005 ] [l [l ] I
6 [[] 008006 006006 [l [l [ [l [l |
4 [ | +
Add l l Remove Import... l l Export... l
Effective Time
[ Restrict the using terms
2017 +8 251727~ = w2017 B 51T v ‘ Sawve to folder ‘v ‘
Help Topics

& For more information, see “36 Administrator Tools”.

The added accounts can be stored in USB disk or SD card and imported in HMI by a Function

Key Object. To do so, create a Function Key Object, and select [Import user accounts].

[\& WEINTEK

EasyBuilder Pro V6.09.02



User Password and Object Security 10-12

Mew Function Key Object &J
General | Security | Shape | Label |
Comument :
[ Activate after button is released

Function mode

@ Import user accounts

_ Use [USB Security Key] to Login
i Data position

) SD card @ USB disk

Account import mode

_ Dverwrite @ Append

[[] pelete file after importing user accounts

oK ] [ Cancel ]

|

@ Import vzer data/Uze [TEE Security Key]

When finished, insert the external device to HMI, and press Function Key to import accounts. If
[Overwrite] is selected, the existing accounts will be overwritten with new accounts and
automatically log out after importing. If select [Delete file after importing user accounts] check
box, the system will delete the account data saved in the external device after importing. If the
[Effective Time] in Administrator Tools is specified, the importing can only be done in the time
limit specified. The imported accounts will not be deleted by system when the effective time
ends.

10.4.2. Login with USB Security Key

Instead of entering user name and password to login, a key can be used to do so. In EasyBuilder
Pro installation directory, launch Administrator Tools, select [USB Security Key] check box. The

account information uses the predefined data in [System Parameter Settings] » [Security].
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3 Administrator Taols

e-Mail Contacts

USB Security Key

Effective Time

Restrict the using terms

2017 +8 251731

Help Topics

Have Contents of the TSE data
Taer Accounts
» TRE Security Key

e-Mail SMTP Server Settings

User name :

Password :

Confirm :

admin

2017 +8 25173

Save to folder ‘ - ‘

0 Note

B Please note that the user accounts used for USB Security Key must already exist in HMI.

C?For more information, see “36 Administrator Tools”.

USB Security Key can be stored in USB disk or SD card, and create a Function Key to log in by

USB Security Key as shown below:

L—| WE!NTEK
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Mew Function Key Object [é]
General | Security | Shepe | Label |
Comment :
[ Activate after button is releszed

Function mode

' Import user accounts

@ Use [USB Security Key] to Login

A Data position

) SD card @ USB disk
H
[ oK | I Cancel I
@) Import vser data/Ts= [TEE Security Kex] Sethngs...

When finished, insert the external device to HMI, and press Function Key to log in using USB
Security Key. If the [Effective Time] in Administrator Tools is specified, the login can only be

done in the time limit specified. The system will log out automatically when the key expires.
10.4.3. Login / Logout Automatically with USB Security Key

As shown below, in [System Parameter Settings] » [Security], select [Enable] check box for

[Execute auto. login/logout when insert an USB key into HMI].
Execute anto logindo gout when insert an TSE key into HMI

[¥] Enable
Statug addres:
ELC : [Locsl HMI v | Settings. .
Address : [Lw .] 1000

# Bitmulation does not support this fonction and LW-11165z display expiration time of USE kew.

This function allows automatic login / logout using an USB security key. Insert the USB disk in
which the key is saved to HMI to log in, and remove the USB disk to log out. The login / logout
status will be written into a designated address, the result codes of login / logout:

0x00: No Action

0x01: Login Succeeds

0x04: Login Fails

0x08: Login Succeeds

0x10: Logout Fails

& For more information about USB Security Key, see “36 Administrator Tools”.
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B When Auto Login / Logout is enabled, log in by [Function Key] object is not possible, but it
is still possible to log in / out with a designated control address.

B This function does not support On-line / Off-line simulation.

B Only the USB Security Key saved in USB disk is valid.

¥

= Click the icon to download the demo project that explains how to use USB Security Key to

log in / out. Please confirm your internet connection before downloading the demo project.

10.4.4.

Enhanced Security Mode with Option List Object

Enhanced Security Mode uses Control Address LW-n + 2 as account index. With Option List

Object, account names and privileges can be displayed. Users can select whether or not to

display the account privileges and secret users in Option List. Secret users are set to be hidden

in [System Parameter Settings] » [Security] » [Enhanced Security Mode]; their account names

will be hidden in Option List if [Secret user] check box is not selected. If the control address is

set to LW-0, the monitor address for index of Option List is designated to LW-2.

b

Mew Option List Object

Option list | Mapping I Becurity | Shape | Label |

-

=

Commeint ;
Attribte

Mode [Dmp-dnwn Lizt

]
~]

Diirection [ann

Background : |

|[+]

Selection ;||

| [+]

Sonrce of item data [T_Tser account

Sort
Lecending

Monitor addres:

[ Descending

Dizplaor
Frivilege

[7] Becret nzex

PLC . |Local HMI

v] Settings...

-

Lddres: [LW

10.4.5. LDAP Mode

LDAP (Lightweight Directory Access Protocol) enables applications to access Directory server

providing database-like data structure, and here, the primary use of LDAP is to enable

centralized user account management. When using LDAP mode, user account management is

up to the Directory server, with HMI validating user login via the LDAP protocol. To have LDAP

L—| WE!NTEK
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set up on HMI, users only need to provide necessary information about the directory server
and set the operable classes for each group, without the need for managing

username/password for each user.

‘ dc=net ‘ dc=com ‘ dc=org

. dc=example
ou=people ‘ ‘ ou=group
uid=userA ‘ ‘ uid=userB

The control addresses used by LDAP Mode are the same as the control addresses used by
Enhanced Security Mode. Please see chapter 10.3 in this user manual for more information on
the control address. Please note that obtaining LDAP user name using Option List object is not

possible; therefore, [Log in by user index] is not supported.

0 Note

B A user may be a member of multiple groups; in this case, the user has permission to
operate all classes assigned for all the groups the user is in. As shown in the following

figure, if a user is a member of both Engineer and Sales groups, the user can operate

classes A~F.
Group Mame ClassA ClassB ClassC ClassD ClassE ClassF
1 Engineer % % %
2| Sales v v v

B The credentials in the list in Enhanced Security Mode can also be managed and validated
in LDAP mode. Please note that when a username exists in the lists of both modes, the
system will only validate user using Enhanced Security Mode. As shown in the following
figure, in the case where username Angela exists in the user list in both LDAP server and

Enhanced Security Mode, the HMI will validate user under Enhanced Security Mode.

LDAP Server Enhanced Security Mode
Marne Type No. Enable  Secret user Tser name Pazsword
1 [l Angela 1
Angel U
% . nllge a User 5 0 P 5
= =& 3 A Helen 3
% Cindy User
& Dora User
& Elly User
% Fanny User
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Search for user in Enhanced Security Mode

\L Mot Found

Search for user in LDAP Server Found

Validate User

|

B LDAP Mode does not support login with [user index].

LDAP is only supported on Active Directory.
B HMI cannot change user’s password; therefore, when adding a new user in LDAP server,

please do not select [User must change password next logon].

Mew Object - User x

& Createin: = org/employee

Password: | |

Confirm password: | |

[ User must change password at next logon
[] User cannot change password

[] Password never expirss

[J Account is disabled

<Back |[ MNed> | | Cancel

10.4.5.1. General Tab

Set LDAP server and operable classes for each group.
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Enable

General SSL

LDAP (Lightweight Directary Access Protacal)

Error

Host |

152 168 1 100 | [[] use domain name

Port :
Base DM :
Users base DN :

Groups base DN :

Directory type

* LDAP is only supported on Active Directory

389 = # Default port of LDAP is 389
DC=test,DC=0rg
CMN=users, DC=test, DC=0rg

CMN=bulltin,DC=test,DC=0rg

Group Mame ClassA ClassB ClassC ClassD ClassE ClassF Class G ClassH Classl
IT‘Engineer v v
2 Management v o o v o " o "
3 Sales v
4| 1} 3
’ MNew. ] ’ Delete ] ’Importfrom Server
ok || cancel
Setting Description
Host Set the IP address of the host or use domain name.
Port By default the port number is:
LDAP: 389
LDAPS: 636
Base DN LDAP server’s domain name (DN).

User base DN

Organizational units (OU) that hold users.

Group base DN

Organizational units (OU) that hold groups.

New Add a new group.

Delete Delete a group.

Import from Log in LDAP server using user credentials to import all
Server allowable groups.

Group Name
and Class

Select the operable classes for each group. The group
name can be 64 words in maximum, case-sensitive, and

allows letters / numbers / symbols / Unicode.

[\& WEINTEK
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10.4.5.2. TLS/SSL Tab

Enable settings in this tab for LDAPS (LDAP over SSL) connection with the AD server.

LDAP (Lightweight Directory Access Protocol) @
[¥] Enable
[ General | TLS/SSL | Error
[¥] Enable
[] server verification
se certificate on HMI first (if existed). Otherwise, use imported files below
CA certificate : None
ok | cancel
Setting Description
Enable Enable TLS/SSL security for secured LDAP
communication.

Server When establishing connection, the HMI will verify

verification

whether the certificate supplied by the server matches

the one stored on HMI.

Use certificate
on HMI (if
existed)...

Use current certificate on HMI or import a new

certificate.

10.4.5.3. Error Tab

When LDAP server cannot be connected, an error code shows in the designated address.

I__| WE!NTEK
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LDAP (Lightweight Directary Access Protacal) @

Enable

General SSL Error

Error address

Device : [Lacal HMI

Address : [PLW 0 18-bit Unsigned

Error : PLW-0

(0:none, 1 or more : error)

oK ” Cancel

Setting Description

Error address The result of login is output to this address.

Value | Description

0 No error

1 Error on LDAP server or no password is

entered.

2 Unknown error

257 | Remote LDAP server cannot be connected.

258 | Wrong username or password.
259 | Verification failed
512 | Unknown TLS

513 | Domain name does not match CN.
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10.4.5.4. LDAP Settings (Import from Server)

Get group information from LDAP server.

LDAP

Username : administrator

Password: 00000000

Fetch all groups

Group Name
1 [V] Engineer

2 [¥] Management

3 [v] Sales
Checkall | [ Uncheckall |
[Add groups] [Replace allgroups] I Cancel

Setting Description
Username Log in LDAP Server using username.
Password Log in LDAP Server using password.
Fetch all Fetch all groups of the DN in LDAP server.
groups Error Message Description

Can’t contact LDAP server

LDAP server cannot be

connected.

Invalid Credentials

Wrong username or
password used for login
LDAP server.

Unknown

Error on LDAP server or no

password is entered.

@ Note

B The maximum number of groups allowable in LDAP mode is 128 groups. When importing
from LDAP server, the system will check the number of groups in LDAP server first,

exceeding 128 groups will result in unsuccessful import.
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B Importing duplicate group name will not clear the operable classes of that group.
10.4.6. Remote HMI Mode

In this mode, user accounts can be managed on a remote HMI, instead of the local HMI. The
accounts on a remote HMI can be used to log in the local HMI; therefore, managing the

accounts on the local HMI is not necessary.

External server @
) Mone ) LDAP @ Remote HMI
General
Remote HMIIP: 132 . 168 . 2 . 158 |
Result address
Device : [Local HMI
Address @ |pLW 0 16-bit Unsigned
Result address PLW-0
1: Succeeds

8: Account not exists
16: Password error

1024 : Remote HMI cannot be connected

Setting Description

Remote HMI IP The IP address of the remote HMI that holds the user
accounts.

Result address When an error occurs while trying to authenticate the

account or connect to the remote HMI, the

corresponding error code will be output to the

designated result address.

0 Note

B The accounts can be authenticated via both local and remote HMI. When the same
account exists on both local and remote HMI, the authentication is done via the local HMI,

instead of the remote HMI. As shown below, user Angela will be authenticated via local
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HMI.

Accounts on Remote HMI

Accounts on Local HMI

Enable Secretuser User name

1 ] Angela 111
2 1] Bella 222
3 B |cig 333

10.4.7. Login / Logout with Plugins

Password

10-23

Enable Secretuser User name

. 1 B
. 2 B |amy
. 3 [ |Allen

-

Angela

(¥

w

J/ Not Found

J/ Found

Password

Found

After enabling the plugin, users have the option to log in either through a fingerprint

recognition device for accounts linked to fingerprints or via a USB scanner for accounts linked

to RFID cards or barcodes.

Plugin

Fingerprint | USBScanner

sl

Plugin

Fingerprint | USBScanner

sl

Enable @
General
Enable auto lagin @
Control
Device : | Local HMT -

16-bit Unsigned

Usage...

Enable

General
Enable auto lagin @

Control
Device : | Local HMT -

16-bit Unsigned

Settings

Usage...

VID 16C0 PID 27DB 0 |

Scan USB Devices

When configuring the USB scanner, to prevent interference from other USB devices during

login, it's necessary to first set the VID and PID of the USB scanner. After clicking [Scan USB

Devices], the system will prompt a message "Please insert your USB Device". Once the USB

scanner is inserted into the PC, the system will obtain a unique VID and PID for the USB scanner.

Click [Save], and the system will automatically incorporate this VID and PID into the settings.

[Enable auto login]: Select the [Enable auto login] option to keep the fingerprint/USB scanner

in a state where it is always ready for login, without the need to activate the scanner through a
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command. To revert to the default state where the scanner is activated via command, use

command 7 (Pause auto login) or command 8 (Resume auto login) to pause/resume the auto

login status.

Control Address Settings

When control address is set to PLW-n, where n is an arbitrary number, the following addresses

will be designated:

Address Tag Name Description

PLW-n (1 word) Command Commands to be executed: Login, Add
Fingerprint / RFID Card, Remove
Fingerprint / RFID Card, etc.

PLW-n + 1 (1 word) Result Displays the result of command
execution.

PLW-n + 2 (1 word) Status The initialization status of the plugin
server.

PLW-n + 3 (1word) Error The error code from the device server.

Commands

Setting different values in PLW-n [command] enables different commands:

Set Value Command Corresponding Address
1 Log in by fingerprint /
RFID / barcode
2 Add fingerprint / RFID Set [user name] first.
/ barcode by user
name
3 Add fingerprint / RFID Set [user index] first. Please refer to 10.4.4
/ barcode by user Enhanced Security Mode with Option List
index Object.
4 Remove fingerprint / Set [user name] first.
RFID / barcode by
user name
5 Remove fingerprint / Set [user index] first.
RFID / barcode by
user index
6 Remove all
fingerprints / RFID /
barcodes
7 Pause auto login
8 Resume auto login

Command Execution Results

After the command is executed, the system will store the result code at control address PLW-n
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Result Codes

Command execution result

0

Succeeds

1

Unknown error

6

Canceled

101

Account not linked

115

Authentication failed

Others

System error

Error Codes

When the plugin server initializes, the system will store the result code at control address

PLW-n + 3.

Error Codes

Command execution result

0

Initialization succeeds

1

Unknown error

2 or more

System error

10.5. Object Security Settings

Settings in the Security tab allow users to configure conditions so that the object is operable

when the condition is met. The sound emitted when operating the object can be selected.

cMT, cMT X Series

eMT, iE, XE, mTV Series

New Combo Button
[ Generel | Secusity [Shape | Font
Safety control
Min. press time
[7] Display confirmation request

Enable/Disable
V! Use register status/value

Mode : Bit s

%) | | New setword
[ General | Security |Shape. | Label
Safety control
Min. press time
Display confirmation request

Enable/Disable
|| Use register status/value

Mode : (Bit )

Device : [Local HMI

Enableif bitis: [ON _~]

V] Use control token @

Device : [Loal HMI
Address : [LB v 0

Enable if bitis: |ON v

Enable if token 1s : |Acquured )

Control token : | 1z Control Token - Local Only ~ Token Library...

Action : \Do nothing when disabled

User restriction

Action : | Do nothing when disabled

User restriction

|| Disable protection permanently after initial activation
| Display warning message if access denied

|| Make invisible while protected
Feedback
Sound

Object class : [Class : A ML

Coc J( o J[ v ]

2 Objectclass : [Class:A *] @

Disable protection permanently after initial activation
Display warning message if access denied
Make tnvisible while protected

Feedback

"] Sound

e s et

[\& WEINTEK
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10.5.1. Security Tab

Setting Description

Min. press Press and hold the object for longer than the [Min. press
time (sec) time] set here to activate the object.

Display After pressing the object, a dialog appears for operation

confirmation

request

confirmation. If the response to this dialog comes later
than the set [Max. waiting time (sec)], this dialog
disappears automatically and the operation will be
canceled.

FPlease confirm the operation

0K Cancel

10.5.2. Enable/Disable

When [Use register status/value] or [Use control token] is selected, whether the object is

operable is determined by the status of the designated address or acquisition the control token,

respectively. As shown in the following figure, only when LB-0 is in OFF state and “2: Control
Token” is acquired will this object be operable.

Enable/Disable
Use register statusivalue

Enable if bitis :

Use control token @

User restriction

Mode : [Bit 2

Devlce:[LocalHMI '][ |

Control token : [1: Control Token - Local Only '] Token Library. .,

Enable if token 15 : [Acqulred ']

Hide when disabled
Grayed label wihen ds

The following table describes the action this object will take when it’s token is not acquired.

Setting Description

Do nothing When the control token is not acquired, the object is
when disabled displayed.

Hide when When the control token is not acquired, the object is
disabled hidden.

Grayed label
when disabled

When the control token is not acquired, the label of the
object turns gray.
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[ ]

10.5.2.1. Use Register Status/Value

When selected, the status of the designated bit/word address determines whether the object

is operable.

Mode

Description

Bit

The object is operable when the designated bit is in
On/Off state.

Word

When [Use Register Status/Value] and [Word] are both
selected, the status of a designated word address
determines whether the object is operable.

Enable if value is: >, <, ==, <>, >= <=

When the value in the word address reaches the
condition specified here, the object is operable.
Tolerance: This setting is available for <> and ==.

<>: The object will be operable when:

value in address > [value in address + tolerance]

or

value in address < [value in address - tolerance]

==: The object will be operable when:

value in address is between [value in address + tolerance]
and [value in address - tolerance] (including value in
address * tolerance)

For example:

Enable/Disable
Use register statnsfvalue

Meode : [WoId -

Device : [Local HMI o &)
Address : |LW -0 16-bit Unsigned

Enable if value 15 : E} 10 Tolerance : 1

When the value in the designated word address is
between 9~11, the object is operable.

Please note that [Word] option is only available for Set
Word and Numeric objects.

Condition
object

When [Use Register Status/Value] and [Condition object]
are both selected, whether the object is operable is
determined by the On/Off state output by the specified
Condition object.
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@ Note

B Word objects supported on cMT/cMT X Series include: Set Word, Numeric, ASCII, Combo

Button.

Word objects supported on iE/XE/eMT/mTV Series include: Set Word, Numeric.

10.5.2.2. Control Token

Contrl Token

cMT
viewer

cMT
viewer

One cMT / cMT X HMI can be simultaneously controlled by multiple cMT Viewer clients. To

ensure system safety by preventing an object to be controlled by multiple clients

simultaneously, a control token can be set. Only one cMT Viewer client can acquire the control

token at a time, and only the cMT Viewer client that acquires control token can operate the

object. The rest of the clients can acquire the token one by one when the token is not

occupied.

The applicable objects include: Combo Button, Numeric, ASCII, Direct Window, and Indirect

Window.

Setting

Description

Control Token

Select a control token for the object.

Token Library...

Add/delete control token.
For more information, please see “Chapter 34 Control

Token” in this user manual.

Enable if Token is

When [acquired] is selected, only the device that
obtains the control token can operate the object.
When [unacquired] is selected, only the devices that
do not obtain the control token can operate the

object.
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10.5.3. User Restriction

Set the security class of the object to be operated by an authorized user.
Tzer restriction
Cibject clags : [Cla;ss ., n

[ Disable protection permanently after initis] activation

[7] Displacs wamning mesage if access dented
[ Make invisible while protected

Setting

Description

Object class

“None” means any user can operate this object. Only
account “admin” can operate “Administrator” object

class.

Disable
protection

permanently

Once the permitted class of the user matches that of the
object, the system will stop checking the security class

permanently, that means, any user can operate this

after initial object freely after it is unlocked.

activation

Display When an unauthorized user attempts to operate the
warning object, a warning dialog (Window no. 7) appears. The
message if content of the message in the dialog can be modified.

access denied

Make invisible
while

protected

When the user's privilege does not match the object

class, the object will be hidden.
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10.6. Example of Object Security Settings
The following shows an example of setting object security class:

1. Create a project, go to [System Parameter Settings] » [Security] » [General] to enable 3
users:

User 1 = Operable class: A

User 2 = Operable class: A, B

User 3 = Operable class: A, B, C
2. Design Window no. 10 as shown:

User name : r‘E#?##;*# | L8218
Password : rEi#lf#i‘if |1W922f?

bit 75 bit?
Currentstatus : A1 1111111111111 | cwszzz

" Logout 169950

SB_0

Class A Button |
SB_1

‘Class B Buiton

8B 2
‘Class C Button |

Create two [Numeric Input] objects:

[LW-9219] User no. (1~12), Length = 1word

[LW-9220] For entering user password. Length = 2 words

Create a [Numeric Display] object:

[LW-9222] Displays the operable object class of current user. (16-bit Binary)
Create a [Set Bit] object

[LB-9050] logout

Create three [Set Bit] objects:

Each set to different classes but all select [Made invisible while protected].

3. After setting, please save and compile the project and execute off-line simulation. The
below shows how it works when simulating.
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Username : | 1 | Lwszis
Password : | 0 | Lwezzg

bit15 bitd

Current status : | 0000000000000000 I Lwazzz

Logout 159050

User name : | 1 ILW9279
Password : ‘ 111 |1W922”

bit 15 bitd

0000000000000001 | Lwgzzz

L ogou{ LBS050
Class A Button

Current status :

Username : | 3 |1W9275"
Password : | 333 |W9m

bit15 b0
Current status - | 0000000000000111 | tmezzz

Logout (59050

|

Class A Bution

Class B Button

L

Class C Button

Username: | 3 | Lwezig

Password : | 333 | twez0

bit15 bitd

Current status - | 0000000000000000 | Lwszzz

Logout LB205D

L

I__| WE!NTEK

Before entering the password, it displays
“0000000000000000”, which means that
the user operable object class is “None”.
[Class A Button] ~ [Class C Button] objects
are classified from “A” to “C” and selected
[Made invisible while protected]; therefore

they are hidden at this moment.

Enter User 1 password “111”.

Since User 1 is only allowed to operate class
A objects, [Class A Button] object appears for
operating. [LW-9222] bit O turns to “1”

means that user can operate class A objects.

Enter User 3 password “333”.

Since User 3 is allowed to operate class A, B,
C objects, [LW-9222] bit 0 ~ bit 2 turns to “1”,
means that user can operate classA~ C

objects.

Click [Logout] button to log out, the
system will return to the initial state, and
current user can only operate class “None”

objects.

EasyBuilder Pro V6.09.02

10-31



User Password and Object Security 10-32

@ Note

B Password input: If the password is incorrect, [LB-9060] will be ON; if the password is
correct, [LB-9060] will be OFF. All user passwords (User 1 to User 12) can be obtained
from system registers [LW-9500] ~ [LW-9522], 24 words in total.

B Changing password directly on HMI: When [LB-9061] is set ON, the system will read data
in [LW-9500] ~ [LW-9522] to update user password. The new password will be used in
future operations. Please note that the user operable object classes will not be changed

due to the change of password.
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10.7.

Protecting Password Settings from Unauthorized Editing

Before sending the project to others who may edit the project afterwards, it is recommended

to click [Editable] button in Security settings tab to open read-only mode. This mode can

protect password settings from unauthorized editing.

System Parameter Settings

B

Cellular Data Network | Printer/Backup Server | Time Sync/DST | e-Mail

l Recipes

Device | Model | Geneal | SysemgSeting | Security | Non-ASCIIFonts | Extended Memory

Select operable classes for each vser
[ Use existing user accounts on HMI first (if existed). Otherwise, use settings below.

() General mode @ Enhanced security mode Editable...

>

m

o
XDDDIQBZ

* Simulation does not support this function and L W-11165s display expiration time of USE key.

No. Enable  Secretuser User name Password Class 4
1 & = userl 1 ¥
2 [#] ] user2 2 ¥
3 ] ] uzer3 3 ®
4 ] ] userd 4 @
5 ] [ uzerS 5 ®
6 &l A vserf 6 wl
7
~| Read-only Settings
Class
Class & [¥]Enable read-only
ClasB
ClasC
= Password : 111111 (1 ~ 4294967295)
Administeator
[7] Secret usd [¥] Mask password
Control addre
LAl [ OK ] [ Cancel J
Address: [pLw 8950
Project password
7] Enable
Execute auto logindogout when insert an USE key into HMI
[¥] Enable
Status address
PLC: Local HMI ~ [ Settings...
Address : [LW - ] 0 [16-bit Tnsigned

[ OK ]f Cancel ]

Help

When [Enable read-only] is selected, a password will be required for changing security settings

in the project.
When [Mask password] is selected, passwords will be masked by asterisks (*).

@ Note

B The protected projects cannot be decrypted since they are encrypted by users, therefore,

please remember your password.
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10.8. Bulk Changing of Security Settings of Multiple Objects

Selecting multiple objects in a group and then selecting [Security settings] in the right-click

menu can open an Objects’ Security Properties window that allows users to change the

security settings of all the selected objects at a time.

@ Note

B When the selected objects have different security settings pages, Objects’ Security
Properties will automatically adjust and show the settings that users are allowed to

change. The rest of the settings will be hidden or greyed out. The following is a window

Objects' Security Properties
Security ‘

Safety control
[V] Display confirmation request Max. waiting time (sec) : 10

Enable/Disable
[V] Use register statusivalue
@ Bit ) Word

Device : (Local HMI v [ Settings...
Address: (LB v 0

Ensble if bitis :
[7] Use control token
* For environment of using multiple clients (cM T Viewers).

m

Action : [Do nothing when disabled

User restriction
Objectclass: |Class: &

[ Disable protection permanently after initial activation

[ Display waming message if access dended

[ Make invisible while protectsd
*If the user tries to operate on an object without authorization, LB-12056 will be set to ON.
Sound
[¥] Enable  |Sound Library...| Beep

Play

[ ok ][ cancel [ o |

that shows when selecting a Bit Lamp and a Numeric object.
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Objects' Security Properties IE'

Security
Enable/Disable
ze repgister statushvalue
@ Bit Wioxd

Device:[LgcalHMI v][ Settings. . ]

Addresz: |LE -| 0
Enable if bitds :

Action : [Hide when dissbled

ser restriction
Object class : fClass: &
[E] Make invisible while protectsd
#If the nzer tries fo operate on an object without authorization, LB-12056 will be st o ON.
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11.Index Register

This chapter explains how to use Index Register.
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11.3. Examples of Using Tag-Based PLC and Index RegISters .......ccccecvereeecrieeececveeeeeeenenn. 11-5
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11.1. Overview

EasyBuilder Pro provides Index Registers for changing addresses flexibly. With Index Registers,
user can change the object’s read/write address directly on HMI without changing its settings.
There are 32 Index Registers, divided into 16-bit and 32-bit. cMT / cMT X models offer 32
Private Index Registers, also divided into 16-bit and 32-bit.

Address @
PLC name : [LOCE| HMI v]
Device type : | LW-3002 (32bit-float) : input high limit b

Address & ||\ 5501 (16bit) : address index 1

LWw-9202 (16hit) : address index 2
LW-3203 (16bit) : address index 3
LW-3204 (16bit) : address index 4

Address format :

LW-3205 (16bit) : address index 5
LW-9206 (16bit) : address index &
LW-9207 (16bit) : address index 7
LW-3208 (16bit) : address index 8
LW-3209 (16bit) : address index 9
LW-3210 (16bit) : address index 10
LW-9211 (16bit) : address index 11
Tag Library... Lw-5212 (16hit) : address index 12
LW-3213 (16bit) : address index 13

m

L}

LW-3214 (16hit) : address index 14

LW-3215 (16bit) : address index 15

LW-3219 (16bit) : user no. {1~12)

LW-9220 (32bit) : password

LW-3222 (16bit) : classes can be operated for current user (bit 0:A, bit 1:B,bit
LW-3230 (32bit) : address index 16

LW-3232 (32bit) : address index 17

LW-3234 (32bit) : address index 138

LW-9236 (32hit) : address index 19

LW-9238 (32bit) : address index 20

LW-3240 (32bit) : address index 21

LW-3242 (32bit) : address index 22

LW-3244 (32bit) : address index 23

LW-5246 (32bit) : address index 24

LW-9248 (32bit) : address index 25

LW-3250 (32bit) : address index 26 52

The corresponding address of 16-bit Index Register 0 to 15: LW-9200 (16bit) to LW-9215 (16bit)
The maximum offset range is 65536 words.

The corresponding address of 32-bit Index Register 16 to 31: LW-9230 (32bit) to LW-9260
(32bit)

The maximum offset range is 4294967296 words.

The corresponding address of 16-bit Private Index Register 0 to 15: PLW-9200 (16bit) to
PLW-9215 (16bit)

The maximum offset range is 65536 words.

The corresponding address of 32-bit Private Index Register 16 to 31: PLW-9230 (32bit) to
PLW-9260 (32bit)

The maximum offset range is 4294967296 words.

When using [Index register], the address is designated by the following equation:
The constant set in [Address] + the value in the chosen Index Register.

The way to use Private Index Registers is the same as that of Index Registers. The difference is
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that Private Index Registers work for objects in cMT Viewer app, which runs independently on
each client device; therefore, operations in this app will not make the HMI show the same
screen.

0 Note

B Index Registers work for the Word registers. For Bit registers, adding 1 to the value in the
Index Register, the offset is 16 bits.
B Index Registers do not work for PLB and PLW registers.

11.2. Examples of Index Register
The following explains the way to designate the register while Index Register is used.

If not selecting [Index register] check box and set address to [LW-10]. The system will directly
read / write LW-10.

Address @
PLC name : [LN-E' HMI ']
Device type : [LW v]
Address: 10 [ system tag

Address format : DDDDD [range : 0 ~ 10799]

[T Index register

o) [ s

If select [Index register] check box and set [Index] to [INDEX 0 (16-bit)], the system will read /
write [LW(10 + value in Index Register 0)].
If the data in [LW-9200] is “5”, the designated address is [LW(10+5)] = [LW-15].

Address @
PLC name : [LN-E' HMI ']
Device type : [LW v]
Address: 10 [ system tag

Address format : DDDDD [range : 0 ~ 10799]

Index : |INDEX 0 (16-bit) - Index register

o) [ s

Here’s a demo project shown as an example:
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Demo Project - Index Register

Index Function of Word

Example 1
The following shows an example of using a Word register and select [Index register]. If the
value in [LW-0] is O, in [LW-10] is 3, and in [LW-20] is 6, the result is:

Index Function of Word

[ ] (oo ]

Index O (LW-9200) LW-0 + Index O (LW-9200)

Index Function of Word

(o]

Index O (LW-9200) LW-0 + Index O (LW-9200)

If the value in Index 0 (LW-9200) is 10, then [LWO + Index 0] = read [LW-10] = 3.

Example 2

The following shows an example of using a Bit register and select [Index register].
If the state of [LB-16] is ON, and the state of [LB-32] is OFF.

Since 1 Word equals to 16 Bit, a